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Revision History

11/30/2016: Released with Vivado® Design Suite 2016.4 without changes from the previous version.

Date Version Revision

10/28/2016 2016.3 Updated the figures in the following chapters:
+ Chapter 2, High-Level Synthesis Introduction
» Chapter 3, C Validation

» Chapter 4, Interface Synthesis

» Chapter 5, Arbitrary Precision Types

» Chapter 6, Design Analysis

04/06/2016 2016.1 Updated the steps in the Lab 2: Viewing Trace Files in Vivado section.
Updated the figures in the following chapters:

» Chapter 2, High-Level Synthesis Introduction

* Chapter 3, C Validation

» Chapter 4, Interface Synthesis

» Chapter 5, Arbitrary Precision Types

» Chapter 6, Design Analysis

» Chapter 7, Design Optimization

» Chapter 8, RTL Verification

» Chapter 9, Using HLS IP in IP Integrator

* Chapter 10, Using HLS IP in a Zynq AP SoC Design
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Chapter 1

Tutorial Description

Overview

This Vivado® tutorial is a collection of smaller tutorials that explain and demonstrate all
steps in the process of transforming C, C++ and SystemC code to an RTL implementation
using High-Level Synthesis. The tutorial shows how you create an initial RTL implementation
and then you transform it into both a low-area and high-throughput implementation by
using optimization directives without changing the C code.

High-Level Synthesis Introduction

This tutorial introduces Vivado High-Level Synthesis (HLS). You can learn the primary tasks
for performing High-Level Synthesis using both the Graphical User Interface (GUI) and Tcl
environments.

C Validation

This tutorial reviews the aspects of a good C test bench and demonstrates the basic
operations of the Vivado High-Level Synthesis C debug environment. The tutorial also
shows how to debug arbitrary precision data types.

Interface Synthesis

The interface synthesis tutorial reviews all aspect of creating ports for the RTL design. You
can learn how to control block-level I/O port protocols and port I/O protocols, how arrays
in the C function can be implemented as multiple ports and types of interface protocol
(RAM, FIFO, AXI4-Stream), and how AXI4 bus interfaces are implemented.

The tutorial completes with a design example in which the I/O accesses and the logic are
optimized together to create an optimal implementation of the design.

Arbitrary Precision Types

The lab exercises in this tutorial contrast a C design written in native C types with the same
design written with Vivado High-Level Synthesis arbitrary precision types, showing how the
latter improves the quality of the hardware results without sacrificing accuracy.
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Design Analysis

This tutorial uses a DCT function to explain the features of the interactive design analysis
features in Vivado High-Level Synthesis. The initial design takes you through a number of
analysis and optimization stages that highlight all the features of the analysis perspective
and provide the basis for a design optimization methodology.

Design Optimization

Using a matrix multiplier example, this tutorial reviews two-design optimization techniques.
The Design Optimization lab explains how a design can be pipelined, contrasting the
approach of pipelining the loops versus pipelining the functions.

The tutorial shows you how to use the insights learned from analyzing to update the initial
C code and create a more optimal implementation of the design.

RTL Verification

This tutorial shows how you can use the RTL cosimulation feature to automatically verify the
RTL created by synthesis. The tutorial demonstrates the importance of the C test bench and
shows you how to use the output from RTL verification to view the waveform diagrams in
the Vivado and Mentor Graphics ModelSim simulators.

Using HLS IP in IP Integrator

This tutorial shows how RTL designs created by High-Level Synthesis are packaged as IP,
added to the Vivado IP Catalog, and used inside the Vivado Design Suite.

Using HLS IP in a Zyng AP SoC Design

In addition to using an HLS IP block in a Zynq®-7000 APSoC design, this tutorial shows how
the C driver files created by High-Level Synthesis are incorporated into the software on the
Zynq Processing System (PS).

Using HLS IP in System Generator for DSP

This tutorial shows how RTL designs created by High-Level Synthesis can be packaged as IP
and used inside System Generator for DSP.

Software Requirements

This tutorial requires that the Vivado Design Suite 2016.1 release or later is installed.
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Hardware Requirements

Xilinx recommends a minimum of 2 GB of RAM when using the Vivado tools.

Locating the Tutorial Design Files

As shown in Figure 1-1, designs for the tutorial exercises are available as a zipped archive
on the Xilinx Website, tutorial documentation page.

f IMPORTANT: All the tutorial examples for Vivado High-Level Synthesis are available at: Reference
Design Files

| - " : 3
| M silinoccom tior 2 = B G X | £ vivado Design Suit

Figure 1-1: High-Level Synthesis Tutorial Design Files

Preparing the Tutorial Design Files

Extract the zip file contents into any write-accessible location.

This tutorial assumes that you have placed the unzipped design files in the location
C:\Vivado_HLS Tutori al .

ﬁ IMPORTANT: If the Vivado_HLS Tutorial directory is unzipped to a different location, or if it resides on
Linux, adjust the pathnames to the location at which you have placed the Vivado HLS_Tutorial

directory.
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Chapter 2

High-Level Synthesis Introduction

Overview

This tutorial introduces Vivado® High-Level Synthesis (HLS). You can learn the primary
tasks for performing High-Level Synthesis using both the Graphical User Interface (GUI) and
Tcl environments.

The tutorial shows how use of optimization directives transforms an initial RTL
implementation into both a low-area and high-throughput implementation.

Lab 1 Description

Explains how to set up a High-Level Synthesis (HLS) project and perform all the major steps
in the HLS design flow:

Validate the C code.
Create and synthesize a solution.

Verify the RTL and package the IP.

Lab 2 Description

Demonstrates how to use the Tcl interface.

Lab 3 Description

Shows you how to optimize the design using optimization directives. This lab creates
multiple versions of the RTL implementation and compares the different solutions.

Tutorial Design Description

To obtain the tutorial design file, see Locating the Tutorial Design Files.

High-Level Synthesis B Send Feedback 9
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=9

i: XI LINX Chapter 2: High-Level Synthesis Introduction

ALL PROGRAMMABLE

This tutorial uses the design files in the tutorial directory.
Vivado_HLS Tutorial\lntroduction.

The sample design used in this tutorial is a FIR filter. The hardware goal for this FIR design
project is:

« Create a version of this design with the highest throughput.

The final design must process data supplied with an input valid signal and produce output
data accompanied by an output valid signal. The filter coefficients are to be stored
externally to the FIR design, in a single port RAM.

Lab 1: Creating a High-Level Synthesis Project

Introduction

This lab shows how to create a High-Level Synthesis project, validate the C code, synthesize
the design to RTL, and verify the RTL.

i? IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vi vado_HLS Tutori al files are unzipped and placed in the location C: \ Vi vado_HLS Tutori al .

Step 1: Creating a New Project

1. Open the Vivado® HLS Graphical User Interface (GUI):

- On Windows systems, open Vivado HLS by double-clicking the Vivado HLS 2016.3
desktop icon.

Vivado HLS

Figure 2-1: The Vivado HLS Desktop Icon

o On Linux systems, type vi vado_hl s at the command prompt.

TIP: You can also open Vivado HLS using the Windows menu Start > All Programs > Xilinx Design
Tools > Vivado 2016.3 > Vivado HLS > Vivado HLS 2016.3.

Vivado HLS opens with the Welcome Screen as shown below. If any projects were previously
opened, they are shown in the Recent Project pane, otherwise this window is not shown in
the Welcome screen.
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+ Vivado HiS e
File Edit Project Solution Windew  Heip
= | ¢ |Werado HLS Welcome Page .
*| VIVADO'
Quick Start Recent Projects
By _dct
ChVrendo_HLS Wy _Fired_Prosectpnng dot
e B
.\' L __l:
Craate New Progent Cipan Project Oipan Evample Project
Documentation
Tunponais Liser Guida Raleasa Naotes Guigs

Figure 2-2: The Vivado HLS Welcome Page
2. In the Welcome Page, select Create New Project to open the Project wizard.

3. As shown in Figure 2-3:
Enter the project name fir _prj.

a
b. Click Browse to navigate to the location of the | ab1 (Introduction) directory.

o

Select the | ab1 directory and click OK.
Click Next.

Q
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+ | New Vivado HLS Project = | B e
Project Configuration AE
Create Vivado HLS project of selected type r"ll_-r'

Project name:  fir_pej|

Location:  ChVivado_HLS TutonahIntroductionilabl Browse...

Mext = I Cancel

Figure 2-3: Project Configuration

This information defines the name and location of the Vivado HLS project directory. In
this case, the project directory is fir_prj and it resides in the | abl folder.

4. Enter the following information to specify the C design files:
a. Specify fir asthe top-level function.
b. Click Add Files.
c. Selectfir.c and click Open.

d. Click Next.
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¢ New Vivado HLS Project

Add/Remove Files

Add/remove C-based source files (design specification)

Top Function: fir

Design Files
MName CFLAGS
[l fir.c
< Back “ Next = Finish

=0 RO =%
c}?_

Add Files...

Edit CFLAGS...

nemaove

Cancel

Figure 2-4: Project Design Files

ﬁ IMPORTANT: In this lab there is only one C design file. When there are multiple C files to be
synthesized, you must add all of them to the project at this stage. Any header files that exist in the local
directory | abl are automatically included in the project. If the header resides in a different location,
use the Edit CFLAGS button to add the standard gcc/g++ search path information (for example,
-l <path_to_header _file_dir>).

Figure 2-5 shows the input window for specifying the test bench files. The test bench and
all files used by the test bench (except header files) must be included. You can add files one
at a time, or select multiple files to add using the Ctrl and Shift keys.

High-Level Synthesis
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i | New Vivado HLS Project
Add/Remove Files
Add/remove C-based testbench files (design test)
TestBench Files
MNarme CFLAGS
fr_testc
oulgold.dat
= Back Mext =

=R EoE =5
+9

L?/

Add Files...

Mew File—

Add Falder—

Cancel

Figure 2-5: Test Bench Files

5. Click the Add Files button to include both test bench files: fir _test.c and

out . gol d. dat.
6. Click Next.

Both C simulation (and RTL cosimulation) execute in subdirectories of the solution.

If you do not include all the files used by the test bench (for example, data files read by the
test bench, such as out . gol d. dat ), C and RTL simulation might fail due to an inability to

find the data files.

The Solution Configuration window (shown in Figure 2-6) specifies the technical

specifications of the first solution.

A project can have multiple solutions, each using a different target technology, package,

constraints, and/or synthesis directives.

High-Level Synthesis
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s New Vivado HLS Praject = [ ]

Solution Configuration

& Part must be specified.

Solution Name: solutionl

Clock
Period: 10 Uncertainty:

Part Selection

Part: [Please select part] D

Figure 2-6: Solution Configuration

7. Accept the default solution name (solutionl), clock period (10 ns), and clock
uncertainty (defaults to 12.5% of the clock period, when left blank/undefined).

8. Click the part selection button to open the part selection window.

9. Select Device xc7k160tfbg484-2 from the list of available devices. Select the following
from the drop-down filters to help refine the parts list:

a.
b.
C.
d.

e.

f.

Product Category: General Purpose
Family: Kintex®-7

Sub-Family: Kintex-7

Package: fbg484

Speed Grade: -2

Temp Grade: All

10. Select xc7k160tfbg484-2.
11. Click OK.
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In the Solution Configuration dialog box (shown in Figure 2-6, above), the selected part
name now appears under the Part Selection heading.

12. Click Finish to open the Vivado HLS project, as shown in Figure 2-7.

s Vivado HLS - fird_pr (C\Vivado_HLS_TutorialIntreductiont b1\ fir_pej) [fa =
File Edit Project Solution Window Help
i REShREae - 1 &g % Debug 7| Symhesis | Anatysis
{5 Explarer : ) 0 |/ Outline 3 Directive
4 1 fir2_prj
i Inchudes An cutling is not available.
Laource
il Test Bench
= solutiond
& Console @ Errors| & Warnings bl 2| M E~A -
Vivada HLS Console
firZ_prj

Figure 2-7: Vivado HLS Project
« The project name appears on the top line of the Explorer window.
« A Vivado HLS project arranges information in a hierarchical form.
« The project holds information on the design source, test bench, and solutions.
« The solution holds information on the target technology, design directives, and results.

« There can be multiple solutions within a project, and each solution is an
implementation of the same source code.

TIP: At any time, you can change project or solution settings using the corresponding Project Settings
O and/or Solution Settings buttons in the toolbar.
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Understanding the Graphical User Interface (GUI)

Chapter 2: High-Level Synthesis Introduction

Before proceeding, review the regions in the Graphical User Interface (GUI) and their
functions. Figure 2-8 shows an overview of the regions, and describes each below.

Explorer Pane

+ Nrvado HLS = fir po (C\Wivado_ HLS_Tutonadintrodectiontiabdyfr_peg)
File Edit Froject Solution Window  Help
l N o B GEC e 0« I__,I
- Expiloies ‘r‘
« i fir_pq
& Includes
Source Toolbar Buttons
s Test Bench -
# 7+ solutionl
« & conttrants
d Qrellives i
& sorptich -
Information
Pane
Project
Explorer
Pane
B Contole @ Errors, & Wamnings
COT Build Console [ _pr]
Console
Pane
| i selected

y——
= Oulline (18 IOy T‘.l'.-r

An

Perspectives

Auxiliary
Pane

Figure 2-8: Vivado HLS Graphical User Interface

Shows the project hierarchy. As you proceed through the validation, synthesis, verification,
and IP packaging steps, sub-folders with the results of each step are created automatically
inside the solution directory (named csi m syn, si m and i npl respectively).

When you create new solutions, they appear inside the project hierarchy alongside

solutionl.

Information Pane

Shows the contents of any files opened from the Explorer pane. When operations complete,
the report file opens automatically in this pane.

High-Level Synthesis
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Auxiliary Pane

Cross-links with the Information pane. The information shown in this pane dynamically
adjusts, depending on the file open in the Information pane.

Console Pane

Shows the messages produced when Vivado HLS runs. Errors and warnings appear in
Console pane tabs.

Toolbar Buttons
You can perform the most common operations using the Toolbar buttons.

When you hold the cursor over the button, a popup tool tip opens, explaining the function.
Each button also has an associated menu item available from the pull-down menus.

Perspectives

The perspectives provide convenient ways to adjust the windows within the Vivado HLS
GUL

+ Synthesis Perspective

The default perspective allows you to synthesize designs, run simulations, and package the
IP.

+ Debug Perspective

Includes panes associated with debugging the C code. You can open the Debug Perspective
after the C code compiles (unless you use the Optimizing Compile mode as this disables
debug information).

« Analysis Perspective

Windows in this perspective are configured to support analysis of synthesis results. You can
use the Analysis Perspective only after synthesis completes.

Step 2: Validate the C Source Code

The first step in an HLS project is to confirm that the C code is correct. This process is called
C Validation or C Simulation.

In this project, the test bench compares the output data from the fi r function with known
good values.

1. Expand the Test Bench folder in the Explorer pane.

2. Double-click the file fir_test.c toview itin the Information pane.
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High-Level Synthesis

3. In the Auxiliary pane, select mai n() in the Outline tab to jump directly to the mai n()
function.

Figure 2-9 shows the result of these actions

+  Wivado HLS - fir_pej (CAVrvado_HLS_TutorialIntreduetionJab1\fir_pr) = e
File Edit Propect Solution Wwndow Help
E adheas .- )~ 57| 60 |

sl
% Debug |+ | Symthesis [+ Analysis

== : S o= Quthine & Directive
& fir_pej int 2O0 () { P AW Wl e % ||
G Irechuges const int  SAMPLES=608; w ason
Sairce 2 FILE “fp; S
’ : o firk
s Test Bench 1 data_t signal, output; fir}
2 ¥ . — -
-t coef_t taps[N] = {8,-18,-9,323,56,63,56,23,-5,-18,8,}; = maind: in
out.gold.dat 4
£ solrtont int i, ramp_up;
& constraints signal = @;

i directives.bo rasp_up = 1;

7 seriptac - - m_u
fp=Ffopan{ "out . dat " H

r H
for (ied; icnSAPLES ive) {
if (ramp_up == 1)
signal = signal + 1;
wlse
signal = signal 1;

fir(&output,taps,signal);

if ((ramp_up == 1) &% (signal »= 75))

Fame e w

Figure 2-9: Reviewing the Test Bench Code

The test bench file, fi r _t est. c, contains the top-level C function mai n(), which in turn
calls the function to be synthesized (f i r). A useful characteristic of this test bench is that it
is self-checking:

« The test bench saves the output from the fi r function into the output file, out . dat .
« The output file is compared with the golden results, stored in file out . gol d. dat .

« If the output matches the golden data, a message confirms that the results are correct,
and the return value of the test bench mai n() function is set to 0.

« If the output is different from the golden results, a message indicates this, and the
return value of mai n() is setto 1.

The Vivado HLS tool can reuse the C test bench to perform verification of the RTL.

If the test bench has the previously described self-checking characteristics, the RTL results
are automatically checked during RTL verification. Vivado HLS re-uses the test bench during
RTL verification and confirms the successful verification of the RTL if the test bench returns
a value of 0. If any other value is returned by mai n( ), including no return value, it indicates
that the RTL verification failed. There is no requirement to create an RTL test bench. This
provides a robust and productive verification methodology.
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4. Click the Run C Simulation button, or use menu Project > Run C Simulation, to
compile and execute the C design.

5. In the C Simulation dialog box, click OK.

The Console pane (Figure 2-10) confirms the simulation executed successfully.

|'s Vs HLS - fie_pay (CANado S5, TrtorahImoductionat Iy p) =l
Fow Eon Progert Sonmion Wesow  Halp
X a s R ES e =B ] © Doty '"-_.;r;-:‘? Anatian
et miog ) ) ) 1 Chattine I Dhrécive
Compilinglapcc) . f..0. .0 .. fFir_test.c In debug mode An putlee 3 nof avstable

IRFD: [HLS 8- 18] Bweeing “c1fEi]insVivado HLS/ 3818 1/bin/ umerapes
IRFD: LS 309 18] For wier "duncans’ on hodt 17 [imdos
TNFD: [15 208-10] In directory ') /Wivedo_WLS_Tutorfal/Tntrodt o
Enrg: [APCC J0X-3] Tep diréectory is spcc_db
INFO: [APCC J9Z-1] APCE i done
Conpllinglapcc) .. /.. 0. f . filr.c in debug sode
eeing ‘o /011 ineVivade HLS/2016. 1 /blnfumerapps

" g Jddun

wier ‘duncans’ on host “asjduncanmll® [Wirdcs
Ifo: (% 309-18] Im directory “C:/Vivedo LS Tutorial/Intredectice
InFD: [APCC 392-3] Tep directory 13 apcc_db
INFD: |APCC J82-1] ARCC Is done
Generating o8 im,. oxe

IED: [SIM 1] C5im dome with @ errors

4

B Comale i Eerom. & Warengn & Man Page
Wivado 1615 Comole
INF0: [APCC 382-3] Ten directory iz apcc_db
IFO: [AFCC 93-1) BPLL i done

Guererat ing 1 im,e0e

Comparing sgainit output data

the polden output!
.......................... R
IWFD: [SIM ¥11-1] C5im done with § errori

Finished € simalation

Figure 2-10: Results of C Simulation

TIP: If the C simulation ever fails, select the Launch Debugger option in the C Simulation dialog box,
O compile the design, and automatically switch to the Debug perspective. There you can use a C
debugger to fix any problems.

The C Validation tutorial module provides more details on using the Debug environment.

The design is now ready for synthesis.

Step 3: High-Level Synthesis

In this step, you synthesize the C design into an RTL design and review the synthesis report
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1. Click the Run C Synthesis toolbar button or use the menu Solution > Run C Synthesis
> Active Solution.

When synthesis completes, the report file opens automatically. Because the synthesis
report is open in the Information pane, the Outline tab in the Auxiliary pane automatically
updates to reflect the report information.

2. Click Performance Estimates in the Outline tab (Figure 2-11).

3. In the Detail section of the Performance Estimates, expand the Loop view.

= fir_csimlog |2 Synthesis(solution1) 2 = B
Performance Estimates i
- Timing (ns)
= Summary

Clock  Target Estimated Uncertainty
ap_clk 10.00 843 125

m

- Latency (clock cycles)
= Summary
Latency Interval
min  max min  max Type
78 78 79 79 none

= Detail
# Instance
- Loop
Latency Initiation Interval
Loop Name min  max Iteration Latency  achieved target TripCount  Pipelined
- Shift_Accum_Loop 77 77 7 - - 11 no

Figure 2-11: Performance Estimates

In the Performance Estimates pane, shown in Figure 2-11, you can see that the clock period
is set to 10 ns. Vivado HLS targets a clock period of Clock Target minus Clock Uncertainty
(10.00-1.25 = 8.75 ns in this example).

The clock uncertainty ensures there is some timing margin available for the (at this stage)
unknown net delays due to place and routing.

The estimated clock period (worst-case delay) is 8.43 ns, which meets the 8.75 ns timing
requirement.

In the Summary section, you can see:

« The design has a latency of 78-clock cycles: it takes 78 clocks to output the results.
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« Theinterval is 79 clock cycles: the next set of inputs is read after 79 clocks. This is one
cycle after the final output is written. This indicates the design is not pipelined. The
next execution of this function (or next transaction) can only start when the current
transaction completes.

The Detail section shows:

There are no sub-blocks in this design. Expanding the Instance section shows no
submodules in the hierarchy.

« All the latency delay is due to the RTL logic synthesized from the loop named
Shi ft _Accum_Loop. This logic executes 11 times (Trip Count). Each execution
requires 7 clock cycles (Iteration Latency), for a total of 77 clock cycles, to execute all
iterations of the logic synthesized from this loop (Latency).

« The total latency is one clock cycle greater than the loop latency. It requires one clock
cycle to enter and exit the loop (in this case, the design finishes when the loop finishes,
so there is no exit cycle).

4. In the Outline tab, click Utilization Estimates (Figure 2-12).

- The design uses a single memory implemented as LUTRAM (since it contains less
than 1024 elements), 4 DSP48s, and approximately 200 flip-flops and LUTs. At this
stage, the device resource numbers are estimates.

- The resource utilization numbers are estimates because RTL synthesis might be able
to perform additional optimizations, and these figures might change after RTL
synthesis.
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=l Synthesis(solutionl) 2 = g

Utilization Estimates

- Summary
Name BRAM_18K  DSP48E FF LUT
DSP - - - -
Expression - - 0 39
FIFO - - - -
Instance - 4 0 i}
Memary 0 - 64 5]
Multiplexer - - - 114
Register - - 179 - :
Total 0 4 243 159
Available 650 600 202800 101400
Utilization (%) 0 ~0 ~0 ~0
- Detail
-l Instance
Instance Maodule BRAM_18K DSP48E FF LUT
fir_mul_32s_32s 32 3 U0  fir_mul_32s_32s 32 3 0 4 0 0
Total 1 0 4 0 0 i
4 B 1] F

Figure 2-12: Utilization Estimates
5. In the Detail section of the Utilization Estimates, expand the Instance view.

o The number of DSP48s seems larger than expected for a FIR filter. This is because
the data is a C integer type, which is 32-bit. It requires more than one DSP48 to
multiply 32-bit data values.

- The multiplier instance shown in the Instance view accounts for all the DSP48s.

o The multiplier is a pipelined multiplier. It appears in the Instance section indicating
it is a sub-block. Standard combinational multipliers have no hierarchy and are
listed in the Expressions section (indicating a component at this level of hierarchy).

In: Lab 3: Using Solutions for Design Optimization, you optimize this design.

6. In the Outline tab, click Interface (Figure 2-13).

High-Level Synthesis N send Feedback 23
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=23

i: XI LINX Chapter 2: High-Level Synthesis Introduction

ALL PROGRAMMABLE

=| fir_csim.log =l Synthesis(solution1) &3 = O
Interface oy
- Summary
RTL Ports Dir  Bits Protocol Source Object C Type
ap_clk in 1 ap_ctrl_hs fir  return value
ap_rst in 1 ap_ctrl_hs fir  return value
ap_start in 1 ap_ctrl_hs fir  return value
ap_done out 1 ap_ctrl_hs fir  return value
ap_idle out 1 ap_ctrl_hs fir  return value
ap_ready out 1 ap_ctrl_hs fir  return value
v out 32 ap_vid v pointer
y_ap_vid out 1 ap_vid ¥ painter
c_addressO  out 4 ap_memary C array
c_cel out 1 ap_memory C array =
c_g0 in 32 ap_memory C array
X in 32 ap_none X scalar
4 il 3

Figure 2-13: Interface Report

The Interface section shows the ports and I/O protocols created by interface synthesis:

« The design has a clock and reset port (ap_cl k and ap_r eset ). These are associated
with the Source Object fi r: the design itself.

« There are additional ports associated with the design as indicated by Source Object fir.
Synthesis has automatically added some block level control ports: ap_start,
ap_done, ap_i dl e, and ap_r eady.

« The Interface Synthesis tutorial provides more information about these ports.

« The function output y is now a 32-bit data port with an associated output valid signal
indicatory_ap_vl d.

« Function input argument c (an array) has been implemented as a block RAM interface
with a 4-bit output address port, an output CE port and a 32-bit input data port.

« Finally, scalar input argument x is implemented as a data port with no I/O protocol
(ap_none).

Later in this tutorial: Lab 3: Using Solutions for Design Optimization explains how to
optimize the I/O protocol for port x.

Step 4: RTL Verification

High-Level Synthesis can re-use the C test bench to verify the RTL using simulation.
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1. Click the Run C/RTL Cosimulation toolbar button or use the menu Solution > Run
C/RTL Cosimulation.

2. Click OK in the C/RTL Co-simulation dialog box to execute the RTL simulation.

The default option for RTL co-simulation is to perform the simulation using the Vivado
simulator and Verilog RTL. To perform the verification using a different simulator, VHDL, or
SystemC RTL use the options in the C/RTL Co-simulation dialog box.

When RTL co-simulation completes, the report opens automatically in the Information
pane, and the Console displays the message shown in Figure 2-14. This is the same
message produced at the end of C simulation.

« The C test bench generates input vectors for the RTL design.
« The RTL design is simulated.

« The output vectors from the RTL are applied back into the C test bench and the
results-checking in the test bench verify whether or not the results are correct.

« The Vivado HLS indicates that simulation passes if the test bench returns a value of 0. It
is the value of the return variable in the test bench, and this alone, which indicates if
the simulation was successful. It is important that the test bench returns a value of 0
only if the results are correct.

B Console % . @] Errors| & Wamings %= By g =0
Vivado HLS Console
INFO: [COSIM 212-316] Starting C post checking ... -

Comparing against output data
AR R R R R R R R R R R R R R R R R R R R R R

PASS: The output matches the golden output!

3 R R R R R R R R R R O O R R R R R R R R R R R R R

INFO: [COSIM 212-1088] *** C/RTL co-simulation finished: PASS ***
Finished C/RTL cosimulation.

4 [m

] 11 3

Figure 2-14: RTL Verification Results

The Chapter 8, RTL Verification tutorial provides additional information.

Step 5: IP Creation

The final step in the High-Level Synthesis flow is to package the design as an IP block for
use with other tools in the Vivado Design Suite.

1. Click the Export RTL toolbar button or use the menu Solution > Export RTL.
2. Ensure the Format Selection drop-down menu shows IP Catalog.

3. Click OK.
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The IP packager creates a package for the Vivado IP Catalog. (Other options available from
the drop-down menu allow you to create IP packages for System Generator for DSP, a
Synthesized Checkpoint format for Vivado, or a Pcore for Xilinx Platform Studio.)

4. Expand Solutionl in the Explorer.
5. Expand the i npl folder created by the Export RTL command.

6. Expand the i p folder and find the IP packaged as a zip file, ready for adding to the
Vivado IP Catalog (Figure 2-15).

o Explorer &3 = 8
4 = impl o
4 = ip

=l autoimpl.log
=l auxiliary.xml
=l componentxml
pack.bat
W run_ippack.tcl
vivado.jou
=l vivado.log
xilinx_com_hls_fir_1_0.zip
= bd
» % constraints
» = doc
» = example
> = hdl
» = misc
= subcore
» = xgui
4 = verilog
%W extraction.tcl
redd fir_mul_32s_32s_32_3.w
fir_shift_reg_ram.dat
st fir_shift_reg.v
rit firv

111

firxdc
impl.bat
projectxpr
W run_vivado.tcl
@ settings.tcl

L L mrmioct Aata

Figure 2-15: RTL Verification Results

Note: In Figure 2-15, if you expand the Verilog or VHDL folders inside the impl folder, there is a
Vivado project ready for opening in the Vivado Design Suite.

O RECOMMENDED: This Vivado project is provided only as a convenient way to analyze the design inside
the Vivado IDE. This project should not be used to implement your design: there are no top-level 10
buffers in this project. The recommended methodology for using the output of Vivado HLS in your own
design is to incorporate the IP package, or one of the other output formats, into your own Vivado
project. Additional tutorials in this guide demonstrate how to use the Vivado HLS output as IP in your
project.
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Note: There is no project file created for devices synthesized by ISE (6 series or earlier devices).

At this stage, leave the Vivado HLS GUI open. You will return to this in the next lab exercise.

Lab 2: Using the Tcl Command Interface

Introduction

This lab exercise shows how to create a Tcl command file based on an existing Vivado HLS
project and use the Tcl interface.

Step 1: Create a Tcl file
1. Open the Vivado HLS Command Prompt.

o On Windows, use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 2-16).

o On Linux, open a new shell.
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@A Vivado HLS 2016.3 Command Prompt = || B 3

Uivado HLS Command Prompt
Available commands:
vivado_hls,apcc,gcc,gt+, make

Microsoft Windows [Uersion 6.1.7601]
Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Xilinx\Vivado_HL3$\2016.3>

Figure 2-16: The Vivado HLS Command Prompt

When you create a Vivado HLS project, Tcl files are automatically saved in the project
hierarchy. In the GUI still open from Lab 1, a review of the project shows two Tcl files in
the project hierarchy (Figure 2-17).

2. In the GU], still open from Lab 1, expand the Constraints folder in solutionl and
double-click the file scri pt.tcl toview it in the Information pane.
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5 Explorer 2
4 = fir_prj
> mit Includes
4 3 Source
[ fir.c
: = Test Bench
a = solution1
4 % constraints
4 directives.tcl
& script.tel
» & csim
» = impl
> =5 sim
s = syn

g = 8

Figure 2-17:

e« Thefilescript.tcl

Chapter 2: High-Level Synthesis Introduction

= fir_csim.log £l Synthesis(solutionl) =l Simulation(solutio

© WO 0o o~ O P L RO

SHHHHHHHHHHHHH A A
## This file is generated automatically by Vi
## Please DO NOT edit it.

## Copyright (C) 2815 Xilinx Inc. All rights
SHHHHHHHHHHHHH A A
open_project fir_prj

set_top fir

add_files fir.c

add_files -tb fir_test.c

add_files -tb out.gold.dat

open_solution "solutionl”

set part {xc7kle@tfbgd84-2}

create_clock -period 18 -name default

#source "./fir_prj/solutionl/directives.tcl”
csim_design

csynth_design

cosim_design

export_design -format ip catalog

4

The Vivado HLS Project Tcl Files

contains the Tcl commands to create a project with the files

specified during the project setup and run synthesis.

« Thefiledirectives.tcl

contains any optimizations applied to the design. No

optimization directives were used in Lab 1 so this file is empty.

In this lab exercise, you use the scri pt. tcl from Lab 1 to create a Tcl file for the Lab 2

project.

3. Close the Vivado HLS GUI from Lab 1. This is project no longer needed.

4. In the Vivado HLS Command Prompt, use the following commands (also shown in
Figure 2-18) to create a new Tcl file for Lab 2.

a. Change directory to the Introduction tutorial directory
C:\Vivado_HLS Tutorial\lntroduction.

b. Use the commandcp | abl\fir_prj\solutionl\script.tcl
 ab2\run_hl s. t cl to copy the existing Tcl file to Lab 2. (The Windows command
prompt supports auto-completion using the Tab key: press the tab key repeatedly to

see new selections).

c. Use the command cd | ab2 to change into the lab2 directory.
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“red Uivado HLS _Tutoriali\Introductieon

livade_HLS_TuterialhIntroduction>cp lablvfir_prjvselutioniiscript.tel lab2\ruf
n_hls. tel

C:\Wivado_HLS Tutorial‘Introductionrcd lab2

C:wUivado_HLS _TutorialhIntroduction’lab2}

Figure 2-18: Copying the Lab 1 Tcl file to Lab 2

5. Using any text editor, perform the following edits to the filerun_hl s. tcl inthel ab2
directory. The final edits are shown in Figure 2-19.

a.

High-Level Synthesis

Add a -reset option to the open_pr oj ect command. Because you typically run
Tcl files repeatedly on the same project, it is best to overwrite any existing project
information.

Add a -reset option to the open_sol uti on command. This removes any existing
solution information when the Tcl file is re-run on the same solution.

Leave the source command commented. If the previous project contains any
directives you wish to re-use, you can copy the directives directly into this file.

Add the exit command.

Save and exit.
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@ run_hlstd x

-] o N o L D

o oo

############################################################
## This file is generated automatically by Vivado HLS.

## Please DO NOT edit it.

## Copyright (C) 2015 Xilinx Inc. A1l rights reserved.

FHEF AR AR R R R R R R A R R R R R R R R R R

# Reset the project with the -rset option
open project -reset fir prj

set top fir

add files fir.c

add files -tb fir test.c

add files -tb out.gold.dat

# Reset the project with the -rset option
open solution -reset "solutionl"”

set part {xcTkleOtfbgd84-2}

create clock -period 10 -name default

# Leave the previous directives commented out
#source "./fir prj/solutionl/directives.tcl"

csim design

csynth design

cosim design

export design -format ip catalog

# Exit vivado HLS
exit

Figure 2-19: Updated run_hls.tcl file for Lab 2

You can run the Vivado HLS in batch mode using this Tcl file.

6. In the Vivado HLS Command Prompt window, type vivado _hls -f run hls.tcl.

Vivado HLS executes all the steps covered in labl. When finished, the results are available
inside the project directory fir_prj.

« The synthesis report is available in fir_prj\sol uti onl\syn\report.
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« The simulation results are available infir_prj\solution\simreport.
« The output package is available infir_prj\sol utionl\inpl\ip.

« The final output RTL is available in fir_prj\sol uti onl\i npl and then Veril og or
VHDL.

& CAUTION! When copying the RTL results from a Vivado HLS project, you must use the RTL from the
i mpl directory. For designs using floating-point operators or AXI4 interfaces, the RTL files are the only
output from synthesis. Additional processing is performed by Vivado HLS during export _desi gn
before you can use this RTL in other design tools.

Lab 3: Using Solutions for Design Optimization

Introduction

This lab exercise uses the design from Lab 1 and optimizes it.

Step 1: Creating a New Project
1. Open the Vivado HLS Command Prompt.

- On Windows, use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt.

o On Linux, open a new shell.

2. Change to the Lab 3 directory: cd
C:\Vivado_HLS Tutorial\lntroduction\l ab3.

3. In the command prompt window, type: vivado hls -f run hls.tcl
This sets up the project.

4. In the command prompt window, type vivado _hls -p fir prj to open the project
in the Vivado HLS GUL

Vivado HLS opens, as shown in Figure 2-20, with the synthesis for solutionl already
complete.
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Chapter 2: High-Level Synthesis Introduction

Figure 2-20:

As stated earlier, the design goals for this design are:

« Create a version of this design with the highest throughput.

Introduction Lab 3 Initial Solution

« The final design should be able to process data supplied with an input valid signal.

* Produce output data accompanied by an output valid signal.

« The filter coefficients are to be stored externally to the FIR design, in a single port

RAM.

Step 2: Optimize the 1/0 Interfaces

Because the design specification includes I/O protocols, the first optimization you perform
creates the correct I/O protocol and ports. The type of I/O protocol you select might affect
what design optimizations are possible. If there is an I/O protocol requirement, you should

set the I/O protocol as early as possible in the design cycle.

You reviewed the I/O protocol for this design in Lab 1 (Figure 2-13), and you can review the
synthesis report again by navigating to the report folder inside the sol uti on1\ syn folder.

The I/0 requirements are:
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« Port C must have a single port RAM access.
« Port X must have an input data valid signal.

« Port Y must have an output data valid signal.

Port C already is a single-port RAM access. However, if you do not explicitly specify the RAM
access type, High-Level Synthesis might use a dual-port interface. HLS takes this action if
doing so creates a design with a higher throughput. If a single-port is required, you should
explicitly add to the design the I/O protocol requirement to use a single-port RAM.

Input Port X is by default a simple 32-bit data port. You can implement it as an input data
port with an associated data valid signal by specifying the I/O protocol ap_vl d.

Output Port Y already has an associated output valid signal. This is the default for pointer
arguments. You do not have to specify an explicit port protocol for this port, because the
default implementation is what is required, but if it is a requirement, it is a good practice to
specify it.

To preserve the existing results, create a new solution, sol uti on2.

1. Click the New Solution toolbar button to create a new solution.

2. Leave the default solution name as sol uti on2. Do not change any of the technology
or clock settings.

3. Click Finish.

This creates sol uti on2 and sets it as the default solution. To confirm you can verify that
the current active solution2 is highlighted in bold in the Explorer pane.

To add optimization directives to define the desired I/O interfaces to the solution, perform
the following steps.

4. In the Explorer pane, expand the Source container (as shown in Figure 2-21).
5. Double-click fir.c to open the file in the Information pane.

6. Activate the Directive tab in the Auxiliary pane and select the top-level function fir to
jump to the top of the fir function in the source code view.
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Figure 2-21: Opening the Directives Tab

The Directives tab, shown on the right side of Figure 2-21, lists all of the objects in the
design that can be optimized. In the Directive tab, you can add optimization directives to
the design. You can view the Directives tab only when the source code is open in the
Information pane.

Apply the optimization directives to the design.

7. In the Directive tab, select the c argument/port (green dot).

8. Right-click and select Insert Directive.

9. Implement the single-port RAM interface by performing the following:
a. Select RESOURCE from the Directive drop-down menu.
b. Click the core box.
c. Select RAM_1P_BRAM, as shown in Figure 2-22. Then select OK.

The steps above specify that array c be implemented using a single-port block RAM
resource. Because array c is in the function argument list, and hence is outside the function,
a set of data ports are automatically created to access a single-port block RAM outside the
RTL implementation.

Because 1/0O protocols are unlikely to change, you can add these optimization directives to
the source code as pragmas to ensure that the correct I/O protocols are embedded in the
design.

10. In the Destination section of the Directive Editor, select Source File.
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11. To apply the directive, click OK.

.

+' | Vivado HLS Directive Editor "5z | | |+ |vivado HLS core selectio.. = [-E-|[mEdm]
ClEme HMul_maxdsp [functional_unit] -
RESOURCE 'l HMul_nodsp [functional_unit]
Destination HSqrt [fun_ctional_timit]
@ Source File Mul [functlonal-_unlt] -
©) Directive File Mul_LUT [functional_unit]
MulnS [functional_unit]
Options MuxnS [functional_unit]
variable (required): ¢ RAM_1P [storage]

RAM_1P_BRAM [storage]
e RAM_1P_LUTRAM [storage]
RAM_2P [storage]
RAM_2P_BRAM [storage]
RAM_2P_LUTRAM [storage]
RAM_S2P_BRAM [storage]
RAM_S2P_LUTRAM [storage]
RAM_T2P_BRAM [storage]
ROM_1P [storage] -

111

latency (optional):

Help l [ Cancel l [ 0K 0K l [ Cancel

Figure 2-22: Adding a Resource Directive

TIP: If you wish to change the destination of any directive, double-click on the directive In the Directive
O tab and modify the destination.

12. Next, specify port x to have an associated valid signal/port.
a. In the Directive tab, select input port x (green dot).
b. Right-click and select Insert Directive.
c. Select Interface from the Directive drop-down menu.
d. Select Source File from the Destination section of the dialog box.
e. Select ap_vld as the mode.
f. Click OK to apply the directive.
13. Finally, explicitly specify port y to have an associated valid signal/port.
a. In the Directive tab, select input port y (green dot).

b. Right-click and select Insert Directive.
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c. Select Source File from the Destination section of the dialog box
d. Select Interface from the Directive drop-down menu.
e. Select ap_vld for the mode.

f. Click OK to apply the directive

When complete, verify that the source code and the Directive tab are correct as shown in
Figure 2-23. Right-click on any incorrect directive to modify it.

Lel Mirg s = 0O &= Oulling | 2 Directive = =0
46 #include "fir k" = o fir
S =11 shift_re
48veld Fir ( _ fireg
data t *y, .y
58 coef_t c[N], # HLS INTERFACE ap_vid port=y
data_t x 4 C
2 ) A # HL5 RESOURCE variable=c core=RAM_LP_BRAM
Sidpragma HLS INTERFACE ap_wld port-y "
Si #pragma HLS INTERFACE ap_vld port=x # HLS INTERFACE ap. vid port=x

55 #pragma HLS RESOURCE wariahle=c core=RAM 1P BRAM 7 Shift_Accum_Loop

static data_t shift_reg[N]; =
acc t acc;
59 imt i

acc-9;
Shift_Accum_Loop: for (i=N-1:i»=@;1i--) {
‘ il 3

Figure 2-23: 1/0 Directives for solution2
14. Click the Run C Synthesis toolbar button to synthesize the design.

15. When prompted, click Yes to save the contents of the C source file. Adding the
directives as pragmas modified the source code.

When synthesis completes, the report file opens automatically.

16. Click the Outline tab to view the Interface results, or simply scroll down to the bottom
of the report file.

Figure 2-24 shows that the ports now have the correct I/O protocols.
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Figure 2-24:

Step 3: Analyze the Results

Chapter 2: High-Level Synthesis Introduction

Source Object

fir
fir
fir
fir
fir
fir

I, = [ a L T

C Type
return value
return valuwe
return value
return value
return valuwe
return value

pointer
pomier
array
array
array
scalar

scalar

I1/0 Protocols for solution2

Before optimizing the design, it is important to understand the current design. It was shown
in Lab 1 how the synthesis report can be used to understand the implementation. However,
the Analysis perspective provides greater detail in an inter-active manner.

While still in sol uti on2, and as shown in Figure 2-25:

1. Click the Analysis perspective button.

2. Click the Shift_ Accum_Loop in the Performance window to expand it.

« The red-dotted line in Figure 2-25 is used shortly in an explanation; it is not part of the

view.

» The Chapter 6, Design Analysis tutorial provides a more complete understanding of the
Analysis perspective, but the following explains what is required to create the smallest

and fastest RTL design from this source code.

« The left column of the Performance pane view shows the operations in this module of
the RTL hierarchy.

« The top row lists the control states in the design. Control states are the internal states

High-Level Synthesis uses to schedule operations into clock cycles. There is a close

correlation between the control states and the final states in the RTL Finite State
Machine (FSM), but there is no one-to-one mapping.
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Figure 2-25: Solution2 Analysis Perspective: Performance

The explanation presented here follows the path of the dotted red line in Figure 2-25. Some
of the objects here correlate directly with the C source code. Right-click the object to
cross-reference with the C code.

The design starts in the first state with a read operation on port x.

In the next state, it starts to execute the logic created by the for-loop

Shi ft _Accum_Loop. Loops are shown in yellow, and you can expand or collapse
them. Holding the cursor over the yellow loop body in this view shows the loop details:
7 cycles, 11 iterations for a total latency of 77.

In the first state, the loop iteration counter is checked: addition, comparison, and a
potential loop exit.

There is a two-cycle memory read operation on the block RAM synthesized from array
data (one cycle to generate the address, one cycle to read the data).

There is a memory read on the c port.
The multiplication operation takes 3 cycles to complete.
The for-loop is executed 11 times.

At the end of the final iteration, the loop exits in state c1 and the write to port y occurs.

You can also use the Analysis perspective to analyze the resources used in the design.

3. Click the Resource view, as shown in Figure 2-26.

4. Expand all the resource groups.
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16 acc 1 fu 179 +

Performance |Resource

Figure 2-26: Solution2 Analysis Perspective: Resource

Figure 2-26 shows:

« Thereis aread on port x and a write to porty. Port c is reported in the memory section
because this is also a memory access (the memory is outside the design).

« There is a single pipelined multiplier used in this design.

« One of the adders is being shared: there are two instance of the adder on one row.
With the insight gained through analysis, you can proceed to optimize the design.

Before concluding the analysis, it is worth commenting on the multicycle multiplication
operations, which require multiple DSP48s to implement. The source code uses an int
data-type. This is a 32-bit data-type that results in large multipliers. A DSP48 multiplier is
18-bit and it requires multiple DSP48s to implement a multiplication for data widths greater
than 18-bit.

The Arbitrary Precision Types tutorial shows how you can create designs with more suitable
data types for hardware. Use of arbitrary precision types allows you to define data types of
any arbitrary bit size (more than the standard C/C++ 8-, 16-, 32- or 64-bit types).

Step 4: Optimize for the Highest Throughput (Lowest Interval)

The two issues that limit the throughput in this design are:
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« The for loop. By default loops are kept rolled: one copy of the loop body is
synthesized and re-used for each iteration. This ensures each iteration of the loop is

executed sequentially. You can unroll the f or loop to allow all operations to occur in

parallel.

« The block RAM used for shi ft _r eg. Because the variable shi ft _reg is an array in
the C source code, it is implemented as a block RAM by default. However, this prevents
its implementation as a shift-register. You should therefore partition this block RAM
into individual registers.

Begin by creating a new solution.

v A W

previous solutions.

Click the Synthesis perspective button.
Click the New Solution button.
Leave the solution name as sol uti on3.

Click Finish to create the new solution.

The following steps, summarized in Figure 2-27 explain how to unroll the loop.

& firc

coef_t c[N],
data_t x
IR

static data_t
acc_t acc;
data_t data;
int i;

acc=g;
Shift Accum Lod

Vivado HLS Directive Editor
Type
Diirgsctiee: | UINROLL

Deestination
Source File

2 Dwrective File

Options

N skip exil check

Tactor (eptonall

Tegion:

Figure 2-27. Unroll

1|22 Outtine | 4 Directive

A 4 o fir

*y

O HLS INTERFALCE ap_wid port=y

4

B HLS RESOURCE variable=c core=RAM_1P_BRAM
4w

Bh HLS INTERFACE ap_vid port=x

| shibt_reg

4" Shift_Accum_Loop

ing FOR Loop

6. Click inthe fir. c file, then in the Directive tab, select loop Shift_Accum_Loop.

In the Project menu, select Close Inactive Solution Tabs to close any existing tabs from

f IMPORTANT: Reminder: the source code must be open in the Information pane to see any code objects
in the Directive tab.

7. Right-click and select Insert Directive.

8. From the Directive drop-down menu, select Unroll.
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Leave the Destination as the Directive File.

When optimizing a design, you must often perform multiple iterations of optimizations to
determine what the final optimization should be. By adding the optimizations to the
directive file, you can ensure they are not automatically carried forward to the next solution.
Storing the optimizations in the solution directive file allows different solutions to have
different optimizations. Had you added the optimizations as pragmas in the code, they
would be automatically carried forward to new solutions, and you would have to modify the
code to go back and re-run a previous solution.

Leave the other options in the Directives window unchecked and blank to ensure that the
loop is fully unrolled.

9. Click OK to apply the directive.

10. Apply the directive to partition the array into individual elements.
a. In the Directive tab, select array shift_reg.
b. Right-click and select Insert Directive.
c. Select Array_Partition from the Directive drop-down menu.
d. Specify the type as complete.
e. Select OK to apply the directive.

With the directives embedded in the code from sol uti on2 and the two new directives just
added, the directive pane for sol uti on3 appears as shown in Figure 2-28.

&% Outline | 3 Directive i
@ fir

=11 shafl_reg

%% HLS ARRAY_PARTITION variable=shift_req complete dim=1
ay

# HLS INTERFACE ap_vid register porl=y

4

# HLS RESOUHRCE vanable=c core=RAM_1P_BEAM
o

# HLS INTERFACE ap_vid port=x

7 Shift_Accum_Loop

%% HLS UNROLL

Figure 2-28: Solution3 Directives

In Figure 2-28, notice the directives applied in sol uti on2 as pragmas have a different
annotation (#HLS) than those just applied and saved to the directive file (%HLS). You can
view the newly added directives in the Tcl file, as shown next.

11. In the Explorer pane, expand the Constraint folder in Sol uti on3 as shown in
Figure 2-29.
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12. Double-click the sol uti on3 directives.tcl filetoopenitinthe Information pane.

[y Explarer &2 = O 8 firc i directives.tel
= fir n.ri lTﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ
i Includes 2 @ This £ is generated automatically by Vivado HLS.
' B8 Please DO MOT edit it
o hource . - . Pl men s - ATy
4 #fF Copyripgnt () 2613 Xilinx Inc. A ripghts reserved.

ke fire rgnjrjrgriegrpeiafenj e g g apenf el g g ep e af el g o ap e ef e njefch e ef g e ef e rp g ep g e epegaj g
= Test Bench v set_directive uwnroll "fir/Shift_Accum_Loop”
3 solutionl 7 set directive array partition -type complete -dim 1 "fir" shift reg
o salution?

7= solutlond
# constraints
S directives.tcl
W senplicl

o

Figure 2-29: Solution3 Directives.tcl File
13. Click the Synthesis toolbar button to synthesize the design.

When synthesis completes, the synthesis report automatically opens.

14. Compare the results of the different solutions. Click the Compare Reports toolbar
button.

Alternatively, use Project > Compare Reports.

15. Add sol utionl, sol uti on2, and sol uti on3 to the comparison.
16. Click OK.
Figure 2-30 shows the comparison of the reports. sol uti on3 has the smallest initiation

interval and can process data much faster. As the interval is only 16, it starts to process a
new set of inputs every 16 clock cycles.
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SOIUTION.: XC/KLoUTTDQa84-2
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Performance Estimates
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=l Timing (ns)
Clock solutionl  solution2  solution3
ap_clk Target 10.00 10.00 10.00
Estimated 8.43 8.43 8.43
-I Latency (clock cycles)
solutionl  solution2  solution3
Latency min 78 78 15
max 78 78 15
Interval min 79 79 16
max 79 79 16
Utilization Estimates
solutionl  solution?  solution3
BRAM_18K O ] ]
DSP48E 4 4 44
FF 243 276 977
LUT 158 194 254
Figure 2-30: Comparison of Lab3 Solutions

It is possible to perform additional optimizations on this design. For example, you could use
pipelining to further improve the throughput and lower the interval. The Chapter 7, Design
Optimization tutorial provides details on using pipelining to improve the interval.

As mentioned earlier, you could modify the code itself to use arbitrary precision types. For
example, if the data types are not required to be 32-bit int types, you could use bit accurate
types (for example, 6-bit, 14-bit, or 22-bit types), provided that they satisfy the required
accuracy. For more details on using arbitrary precision type see the Chapter 5, Arbitrary

Precision Types tutorial.
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Conclusion

In this tutorial, you learned how to:

« Create a Vivado High-Level Synthesis project in the GUI and Tcl environments.
« Execute the major steps in the HLS design flow.
« Create and use a Tcl file to run Vivado HLS.

« Create new solutions, add optimization directives, and compare the results of different
solutions.
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Chapter 3

C Validation

Overview

Validation of the C algorithm is an important part of the High-Level Synthesis (HLS) process.
The time spent ensuring the C algorithm is performing the correct operation and creating
a C test bench, which confirms the results are correct, reduces the time spent analyzing
designs that are incorrect “by design” and ensures the RTL verification can be performed
automatically.

This tutorial consists of three lab exercises.

Lab 1 Description

Reviews the aspects of a good C test bench, the basic operations for C validation and the C
debugger.

Lab 2 Description

Validates and debugs a C design using arbitrary precision C types.

Lab 3 Description

Validates and debugs a design using arbitrary precision C++ types.

Tutorial Design Description

You can download the tutorial design file from the Xilinx website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vi vado_HLS Tutorial\C_Validation.

The sample design used in this tutorial is a Hamming Window FIR. There are three versions
of this design:
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« Using native C data types.
« Using ANSI C arbitrary precision data types.

« Using C++ arbitrary precision data types.

This tutorial explains the operation and methodology for C validation using High-Level
Synthesis. There are no design goals for this tutorial.

Lab 1: C Validation and Debug

Overview

This exercise reviews the aspects of a good C test bench and explains the basic operations
of the High-Level Synthesis C debug environment.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 3-1).

o On Linux, open a new shell.

High-Level Synthesis B Send Feedback 47
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=47

g: X”_INX Chapter 3: C Validation

ALL PROGRAMMABLE

Vivado 2016.3
.ff Add Design Tools or Devices 2016.3
'___ Manage Xilinx Licenses
§- Uninstall 2016.3
Bl Vivado 2016.3 Tcl Shell
¢ Vivado 2016.3
System Generator
Vivado HLS
Bl Vivado HLS 2016.3 Command Promp
[ ] vivado HLS 2016.3 ~

m

1 Back

| 2

Figure 3-1: Vivado HLS Command Prompt

2. Using the command prompt window (Figure 3-2), change the directory to the C
Validation tutorial, labl.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vi vado_hl s
-f run hls.tcl as shown in Figure 3-2.

C:yUivado_HLS _Tutoriallecd C_lalidation

C:\Uivado_HLS _Tuterialh\C_lalidation>ed labi

C:\Uivado HLS Tuterial\C_Ualidationylabl vivade_hls -f run_hls. tel

Figure 3-2: Setup the Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p hamming window prj as shown in Figure 3-3.
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@I [APCC-3] Tmp directory is apecc_db

BI [APCC-1] RPCC is deone.

I [LIC-181] Ch ed in feature [HLS]
Generating ceim.exe

Running DUT...dene.

Testing DUT results

AI [SIM-1] CSim done with 8 errors.
BI [LIC-181] Checked in feature [HLS]

C:S\Uivade HLS TuterialdC_Ualidatioen'labl:uvivado_hls -p hamming_window_prij
Figure 3-3: Initial Project for C Validation Lab 1

Step 2: Review Test Bench and Run C Simulation

1. Open the C test bench for review by double-clicking hamm ng_wi ndow_t est . c in the
Test Bench folder (Figure 3-4).

= Explarer B L hamming_window_test.c &0
4 =5 hamming_window_prj I ’ returned by DUT agair swpected va
=l Includes | fp=fopen("result.dat™,"w");
S printf("Testing DUT results™);
4 ikm Test Bench for (1 = @; 1 « WINDOW_LEN; 1++) {

fprintf(fp, "¥d ¥ \n", hw result[i],sw result[i]);

hamming_window_test.
D MAMM NG WInAoW_SaeLe if (hw_result[i] |- sw_result[i]) {

2 = solutiond

err_cntes;
4 constraints . check_dots - @;
A directives.to printf("\n!!! ERROR at 1 = ¥4d expected: ¥1aditg
o script.te ; i, sw result[i], hw result[i]);
+ & csim } else { indicate progr r
build 1 if {Lf.n:r_k_-:.liul‘_: = @)
report printf("\n");

printf(".");
if (++check_dots == B4)
check dots = 8;

i
)
fclose(fp);
printf("\n");

if (err_cnt) {

printf("! 1] TEST FAILED - % errors detected ! 1%n",
; ulse

printf("*** Test Passed *+*¥yn");

return err_cnt;

Figure 3-4: C Test Bench for C Validation Lab 1

A review of the test bench source code shows the following good practices:
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« The test bench:
- Creates a set of expected results that confirm the function is correct.
o Stores the results in array sw_resul t.

« The Design Under Test (DUT) is called to generate results, which are stored in array
hw_r esul t. Because the synthesized functions use the hw_r esul t array, it is this
array that holds the RTL-generated results later in the design flow.

« The actual and expected results are compared. If the comparison fails, the value of
variable err _cnt is set to a non-zero value.

« The test bench issues a message to the console if the comparison failed, but more
importantly returns the results of the comparison. If the return value is zero the test
bench validates the results are good.

This process of checking the results and returning a value of zero if they are correct
automates RTL verification.

You can execute the C code and test bench to confirm that the code is working as expected.

2. Click the Run C Simulation toolbar button to open the C Simulation Dialog box, shown
in Figure 3-5.

¢ € Simulation Dialog H.H

C Simulation

Options
Launch Debugger

Build Only
Clean Build

Optimizing Compile

Input Arguments

Do not show this dialog box again

[ ok | canel

Figure 3-5:  Run C Simulation Dialog Box
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3. Select OK to run the C simulation.
As shown in Figure 3-6, the following actions occur when C simulation executes:

« The simulation output is shown in the Console window.

« Any print statements in the C code are echoed in the Console window. This example
shows the simulation passed correctly.

« The C simulation executes in the solution subdirectory csi m You can find any output
from the C simulation in the build folder, which is the location at which you can see the
output file resul t. dat written by the f pri ntf command highlighted in Figure 3-6.

Because the C simulation is not executed in the project directory, you must add any data
files to the project as C test bench files (so they can be copied to the csi m bui | d
directory when the simulation runs). Such files would include, for example, input data read
by the test bench.

‘o Explorer &2 i = 00 @ hamming_window_test.c =0
& hamming_window,_prj fprintf{fp, "%d Xd \n", hw_result[i],sw_result[i]);*
i Includes if (hw result[i] !s sw result[i]) {
Source 79 err_cnt++;
il Test Bench b check_dots = 8
|:| . indl i1 printf{"\n!!! FRROR at i = ¥4d - expected: ¥lad\
- & SRR i teste B2 i, sw_result[i], hw_result[i]);
& solution? L } else { // indicate progress on console
B constramts a4 if (check dots == @)
o directivestcl 85 printf("\n");
¥ scripticl printf(".");
s esim & if {++check dots == 64)
= build - } ChECk_dﬂtS ﬂj,
| apcclog an }
b esimexe a1 felosa(fp);
b csim.mk 92 printf{"\n");
Makefile.rules 3
result.dat 4 // Print final status message -
& run simicl if {err rnt} { ) .
o pat printf(" 11l TEST FAILED - %d errors detected [ll'n
sarmbuat ) else
= apcc_db printf{"*** Test Passed ***yn"); -
& obj ' n .
= report

E Console &3 o %) Errors| & Warnings
«lerminated > hamming_ window_pr.Debug S0+« Application] CiVivado HLS Tutonah
Testing DUT results

¥5% Taot Pasced ***

rl

Figure 3-6: C Simulation Results

Step 3: Run the C Debugger

A C debugger is included as part of High-Level Synthesis.
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1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.

2. Select the Launch Debugger option as shown in Figure 3-7.

3. Click OK to run the simulation.

¢ € Simulation Dialog H.H

C Simulation

Options
| Launch Debugger

Build Only
Clean Build

Optimizing Compile

Input Arguments

Do not show this dialog box again

[ ok | canel

Figure 3-7: C Simulation Dialog Box

The Launch Debugger option compiles the C code and then opens the Debug environment,
as shown in Figure 3-8. Before proceeding, note the following:

« Highlighted at the top-right in Figure 3-8, you can see that the perspective has
changed from Synthesis to Debug. Click the perspective buttons to return to the
synthesis environment at any time.

« By default, the code compiles in debug mode. The Launch Debugger option
automatically opens the debug perspective at time 0, ready for debug to begin. To
compile the code without debug information, select the Optimizing Compile option in
the C Simulation dialog box.

High-Level Synthesis
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¢ Wivado HLS - hamming_window_prj (C\Vivado_HLS._TutoriahC_VaSdatson\labT\hamming_window_pq) RS ECS
File Edit Project | Solution Run Window Help
I BHALT R ED Bidt PRiQiEIE B &R 1 Debug |« | Symthesis & Analysic
1 Debug = . s Exploser (6|8 7 = O i Variables 1T . % Breakpoints (il Registers &
» [E] hamming_window_pej Debug [CAC+ + Application] % B -]
2 B csimoene [£456] Mams Type Valus -
4 @ Thread [1] 0 (Suspended ; Braakpaind b 3 int 1 E
= man() 2l hameming_window_testeS4 (o0l 30d * g char ** (hea54480
o gdb & et data n_chata i [156] (&0
2 b_reslt out_data 256 (20 .
1& hamening_window_teste 1 hamning_window_csimlog 0 [ Outline 1 =)
##Vendor: Xilinx [] - PELREY R <
45 #include <stdio.h» B U sk
: o ) 9 hamming windowh
! winclode “hasming wincow.h & mainfint char'[])

9= int main(int argc, char ®argv[])

in_data_t test_data[WINDOW_LEN];
out_data_t w_result[WINDOW_LEN], sw_result[WINDOW_LEN];

5 int i;
# 50 unsigned err_cnt = 0, check dots = @;
55 ETIE e -

q

O Cansole 11 - ¥ Tasks (£ Protlems O Executables| (] Memory
harniming window,po Debug 00+ + Apphcation] Chmese

Figure 3-8: The HLS Debug Perspective

You can use the Step Into button (Figure 3-9) to step through the code line-by-line.

e IN.-..D =210 i,

Figure 3-9: The Debug Step Into Button
4. Expand the Variables window to see the sw_r esul t s array.
5. Expand the sw_r esul t s array to the view shown in Figure 3-10.

6. Click the Step Into button (or key F5) repeatedly until you see the values being updated
in the Variables window.
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45 Debug ¥ 5 Explorer i ¥ = O ||t=Variables & . % Breakpoints !ii! Registers| ¢ Expressions| 2 Modules =0
4 [t] hamming_window_prj.Debug [C/C++ Application] A=) e~
4 % csim.exe [3808] Name Type Value b
4 ¥ Thread [1] 0 (Suspended : Step) - (% hw_result out_data_t [256] 0x2890c E
= main() at hamming_window_test.c:57 0x4014a9 4 (& gy result out_data_t [256] 0x28f50c
w gdb 4 [B[0.99) out_data_t [100] 0x28150¢
(9= sw_result[0] out_data_t 42923460
(9= sw_result[1] out_data_t -37643710
(9= sw_result[2] out_data_t -32413106
(9= sw_result[3] out_data_t 302692880 L
{ b
[¢ hamming_window_testc & .5/ hamming_window_csim.log = 8 ||5= Outline =
. PERRE X~
for (i =0; i < WINDOW_LEN; i++) { U stdioh

/[ Generate a test pattern for input to DUT
test data[i] = (in_date _t)((32767.0 * (double)((i % 16) - 8) / 8.0) + 0.5);
[/ Calculate the coefficient value for this index
in_data t coeff val = (in_data t)(WIN COEFF_SCALE * (@.54 -
0.46 * cos(2.0 * M PI * i / (double)(WINDOW_LEN - 1))));
// Generate array of expected values -- n.b. explicit casts to avoid
// integer promotion issues M

111

& hamming_window.h
® main(int, char*[]) : int

Figure 3-10:  Analysis of C Variables

In this manner, you can analyze the C code and debug it if the behavior is incorrect.

For more detailed analysis, to the right of the Step Into button are the Step Over (F6), Step
Return (F7) and the Resume (F8) buttons.

7. Scroll to line 69 in the hanm ng_wi ndow_t est . c file.

8. Place the cursor in the left-hand margin on line 69, right-click with the mouse button
and select Toggle Breakpoint. A breakpoint (blue dot) is indicated in the margin, as
shown in Figure 3-11.

9. Activate the Breakpoints tab, also shown in Figure 3-11, to confirm there is a breakpoint
set at line 69.

10. Click the Resume button (highlighted in Figure 3-11) or the F8 key to execute up to the
breakpoint.
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B BNz 00 a LigiRiE D ; % Depug || Synthesis 6 Analysis
45 Debug 8 . It Explorer tw v= "*'Varianle il Registers 4 Expressions| ®\ Modules =i
4 [¢] hamming_window_prj.Debug [C/C++ Application] XEIWBES ¥

4 ¥ csim.exe [3808] Vv hamming_window test. [line; 69]
4 P Thread [1] 0 (Suspended : Step)
= main() at hamming_window_test.c57 Ox4014a9

" gdb
¢} hamming_window_testc &2 hamming_window_csim.log = B |3 Outline 2 =50
sw_result[i] = (out_data_t)test_data[i] * (out_data_t)coeff_val; » PEER Y o % T
} 9 stdioh

0/ N 4 hamming_window.h
_;;_:nllut;--:- r\\ ) £ o main(int, char*(]) : int
u | printf("Running DUT...");

e hamming_window(hw_result, test data);

1 printf("done.\n");

/] Check the results returned by DUT apainst expected values

Figure 3-11: Using Breakpoints

11. Click the Step Into button (or key F5) multiple times to step into the hanm ng_wi ndow
function.

12. Click the Step Return button (or key F7) to return to the main function.

13. Click the red Terminate button to end the debug session.

You can use the Run C simulation button to restart the debug session from within the
Debug perspective.

14. Exit the Vivado HLS GUI and return to the command prompt.

Lab 2: C Validation with ANSI C Arbitrary Precision
Types

Introduction

This exercise uses a design with arbitrary precision C types. You will review and debug the
design in the GUL
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Step 1. Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the | ab2 directory, as
shown in Figure 3-12.

2. To create a new Vivado HLS project, type vivado _hls -f run hls.tcl.

C:\Vivado_HLS_Tutorial\C_Ualidation\labi>cd ..

C:\Uivado_HLS_Tutorial:C_Ualidation>cd lab2

C:\Uivado_HLS_Tutorial:C_Ualidation\lab2>vivado_hls -f run_hls.tcl

Figure 3-12: Setup for Interface Synthesis Lab 2
3. To open the Vivado HLS GUI project, type vivado_hls -p hamming window prj.

4. Open the Source folder in the Explorer pane and double-click hamm ng_wi ndow. ¢ to
open the code, as shown in Figure 3-13.

L0 Explorer - [ & harmmng_window.c
a 125 hamming_window_pr 15 #include "hamming_window.h" Iroy ide f [INDOW_LEN if no =
wt Includes
* 8 Source 1% static void haming_ram_init{5_r-._.'.|.-.-'_.-.-_'l_. rom_array[]);
5 hammmg_window.c
&a Test Bench i : :
4 solutiond void hamming_window{oul data_t outdata[WINDOW _LEM], in_data_t in
= @ constramts EX
¥ directivestel static in_data_t window_coett[WINDOW_LEN];

¥ seriottcl unsigned 1;

Cxm

Figure 3-13: C Code for C Validation Lab 2

5. Hold down the Ctrl key and click hamm ng_wi ndow. h on line 45 to open this header
file.

6. Scroll down to view the type definitions (Figure 3-14).
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& hamming_window.c h hamrming_window.h
scaled integer, which may be interpreted as a signed fixed po”
with WIN_COEFF_FRACBITS bits after the binmary poir
1/ /typedef intle_t in_data_t;
2/ ftypedef 1nt3d2_t out_data_t;
7i#include "ap cint.h"
74 typedef intle in_data_t;
typedef 1nti? out_data_t;

:.void hamming_window(out_data_t owtdatal], in_data_t indatal]);
7o #endif // HAMMING WINDOW H not defined
§ 1L k
Figure 3-14: Type Definitions for C Validation Lab 2

In this lab, the design is the same as Lab 1, however, the types have been updated from the
standard C data types (intl6_t and int32_t) to the arbitrary precision types provided by
Vivado High-Level Synthesis and defined in header file ap_ci nt . h.

More details for using arbitrary precision types are discussed in the Chapter 5, Arbitrary
Precision Types tutorial. An example of using arbitrary precision types would be to change
this file to use 12-bit input data types: standard C types only support data widths on 8-bit
boundaries.

This exercise demonstrates how such types can be debugged.

Step 2: Run the C Debugger

1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.
2. Select the Launch Debugger option.

3. Click OK to run the simulation.
The warning and error message shown in Figure 3-15 appears.

The message in the console pane and log file indicate you cannot debug the arbitrary
precision types used for ANSI C designs in the debug environment.

ﬁ IMPORTANT: When working with arbitrary precision types you can use the Vivado HLS debug
environment only with C++ or SystemC. When using arbitrary precision types with ANSI C,the debug
environment cannot be used. With ANSI C, you must instead use printf or fprintf statements for
debugging.
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& Wivano HLS - Rarmming windos pe (03 Viveto ML Tiforat T Vasdasim a2 hamming. wirndew g = 1 T
Fhe Een Progeel Soudwes Wesow e
IRER O RSES r=E @ OB &R & Dby |- | Symihees | & Anatysn
i ermie "7 T || & hamming window. || hamuning witdomo b, TE " 0| Uk Gutine . L2 Directien i
i hamming windew ) Compiling ../../.. /.  fhassing window test. = | Anoutiine i not svslable
B Includés I§E [SIM-34] C:/Xiline/Vivado HLS/201%, 3/ inclu
+ I Souwte .a_ﬁ [5IM-1] C€5im #ile generation failed: cospl
& hasmming mandowc
Es Tetd Bench
a Ts solwsond
+ @ combrains
& mrectiveLsn mm
W scriptic
B caim Wepada HLS C Simuiation could not compiete
o bl Pl check The eror and wirmng messsger
= report There are 2 emon
i o i
= ip Doy oyt helrey T ik Do mpain
L venieg
a g= w@m : —T—
Lo B - —— - C =
i gt 2 Comrie T Eron & Wanengs 4 han Page - Ll e R i
b Wreado HLS Comole
. whils emecuting -
iy T © /W ivado_ WS Tutorial /O Validavion/ Lebd meseing winded grd/solution]focim. tol®
i wrane
e "hls::malin Co/ LS _Tutorial /T Validation/lsbd/keeming window prifeolutionl/csim. tel™
* k= Aym [“uplevel”™ Body Lime 1)
v rept drwpied from withir
o EYEIETE “uplevel 1 ki
B veriog Filurs
U i L . o
hls g L
#1 [LIC-181] Checked im feature [HLS]
" '

Figure 3-15: C Simulation Dialog Box
Select the Explorer pane.
Expand the Test Bench folder in the Explorer pane.

Double-click the file hamm ng_wi ndow_t est . c.

N o v b

Scroll to line 78 and remove the comments in front of the pri nt f statement (as shown
in Figure 3-16).

s Explocts B S5 hameming wendowe |, shamening window ese L
=} hamening_window_pi B -
& Inciudes Check the results returned by DUT against expected value
Laure 1 fp=fopan(“result. dat™ “w");

printf (" Testing DUT results”™);

fl hamming wandow for (i « 0; i ¢ MINDOW_LEN; Qes) |

& Test Bench fprintf{fp, “%d % \n", e result[i],se_result[i]);
& hamming wandov DEeLy m Priat#("0UT results: Somples%d, DUT=%d, Expected=Xe\n™, L, hw_resultfi],sw_result[i]);
7 salutiont 3 if (hw_result[i] 1= sw_result[i]) {

i err_cnfed;
check dots = @;
priatf(“\nil] ERROA at 1 » Bid - enpected: NiBd\tgpot: Xi1ad™,

& consrnls.
o direcinesizi

:_mlpnb i, s result[i], i_result[i]);
o 1 } nlsa { //f indicete progres n consale

& build K i¥ {check_dots == @)

&= report ¢ peint# (™"},

printf("."); -

Figure 3-16: Enable Printing of the Results
8. Save the file.
9. Select the Synthesis button.
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10. Click the Run C Simulation toolbar button or the menu Project > Run C Simulation to
open the C Simulation Dialog box.

11. Ensure the Launch Debugger option is not selected.

12. Click OK to run the simulation.

The results appear in the console window (Figure 3-17).

Cl Consale &3 - & Errars| & Wamings X5 o L
<terminated > hamming_window_prj.Debug [CAC++ Application] Ch\Wivado_HL5_TutorialC_Validation\lab2hamming _win
OUT results: Sample=252, DUT=21887184, Expected=21887184 -

DUT results: Sample=253, DUT=27811881, Expected=27811881
LDUT results: Sample-254, DUT-32266975, [Expected-32266975
JUT results: Sample=25%%, DUT=379%96818, Fxpected=375%9618

*EE Test Passed *+*

Figure 3-17: C Validation Lab 2 Results
13. Exit the Vivado HLS GUI and return to the command prompt.

Lab 3: C Validation with C++ Arbitrary Precision
Types

Overview

This exercise uses a design with arbitrary precision C++ types. You will review and debug
the design in the GUL

Step 1: Create and Open the Project
From the Vivado HLS command prompt used in Lab 2, change to the | ab3 directory.
Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.

Open the Vivado HLS GUI project by typing vivado hls -p hamming window prj.

> W

Open the Source folder in the Explorer pane and double-click hamm ng_wi ndow. cpp
to open the code, as shown in Figure 3-18.
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. Explorer & & 7 B g hamming_window.cpp & |
4 1= hamming_window_prj 45 #include "hamming_window.h" ff Provides default WINDOW LEN i 1=
# Includes ,-‘ /1 Translation module function prototypes:
4 0 Source i el it LLL prolotypes:

4% static void hamming_rom_init{in data t rom array[]);

Ag

£l hamming_window.cpp

= Test Bench 8/ Function definitions:
4 = solutiond %l void hamming_window(out data t outdata[WTHDOW LEM], in data t -
4 | # constraints 521

static in data t window coeff[WINDOW LEN]; =
unsigned i;

W directives tel

o scriptacl
) 55
» CElmM " " T . s .
- ff In arder to ensure that 'window coeff' is inferred and m
57 ff initialized as a ROM, it is recommended that the arrya ir_
ik . i |} it i b N I ! 3 F A B S 7 L
‘ iig b

Figure 3-18: C++ Code for C Validation Lab 3

5. Hold down the Ctrl key down and click hamm ng_wi ndow. h on line 45 to open this
header file.

6. Scroll down to view the type definitions (Figure 3-19).

& hamming_window.cpp T hamming_window.h =0
M/ This function applies an Hamming window function to the "inc=
717/ returning the windowed data in 'outdata'. The coefficients
727/ scaled integer, which may be interpreted as a signed fixed
F3 /7 with WIN_COEFF_FRACBITS bits after the binary point.

75/ /typedet intlé_t in_data_t;

6/ ftypedef intid2_t out_data_t;

77 #include "ap int.h"

78 typedef ap_int<l6x> in_data_t;

/i typedef ap_int<32 out_data_t;

a8

flwveid hamming_window(cut_data_t outdata[], in_data_t indata[]); =
B2 "
T ndig L) LBMTOC LTMRGLLLL cob deliood :

Figure 3-19: Type Definitions for C Validation Lab 3

Note: In this lab, the design is the same as in Lab 1 and Lab 2, with one exception. The design is now
C++ and the types have been updated to use the C++ arbitrary precision types, ap_int<#N>,
provided by Vivado HLS and defined in header file ap_int.h.

Step 2: Run the C Debugger

1. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.
2. Select the Launch Debugger option.

3. Click OK.

The debug environment opens.

4. Select the hammi ng_wi ndow. cpp code tab.
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5. Set a breakpoint at line 61 in the hamm ng_wi ndow. cpp file as shown in Figure 3-20.

6. Click the Resume button (or key F8) to execute the code up to the breakpoint.

{F Debug 1 ™. [0y Explorer i | 7 T O e Variables % Breakpoin ¥ . i Registers| &7 Expressio |mh Modules = O
4 [T] hamming_window_prj.Debug [C/C++ Application] XEFAWEESR T
a & rsim.eve [3740] W | & hammang window.cpp [line: 61

a o Thread [1] 0 (Suspended : Breakpoint]
= main(} at hamming_window_test.cppes0 (ed013a2

wl gdb
& hamming_ window.epp £ . [ hamming_windowh | [£ hamming_window_testcpp = 0 ||E Outline =
ff In order to ensure that ‘wi eft' is inferred and properly e vERRAY v % T
{ initialized as a RN, 4 hamming_windowh
} f 2? dane ll_'i u.i- 5'.:|:'l-:1l.l":‘-'.'.i';f Sha['fll'ﬂ:']g_I'I:Im_.ﬂi'l':il'l_da'-ﬂ_[!]" v
- ramming_rom_init(window_coeff); ® hammng window(out data t],
ERG1 for (i = 0; i « WINDOW_LEN; i++) { . ¢ hamming ram kg data il
o2 #pragma AP pipeline
outdata[i] = {out data tiwindow coeff[i] * (out data t)indata[i];
i
] -
q ] L} L

Figure 3-20: Debug Environment for C Validation Lab 3
7. Click the Step Into button (or press the F5 key) twice to see the view in Figure 3-21.

The variables in the design are now C++ arbitrary precision types. These types are defined
in header file ap_i nt . h. When the debugger encounters these types, it follows the
definition into the header file.

As you continue stepping through the code, you have the opportunity to observe in greater
detail how the results for arbitrary precision types are calculated.

& hamming_window.cpp  |T hamming_wandow.h h ap_nth D
58 INLINE ap_int(const wolatile ap_inbt<_AP_W2» Bop):Base((const ap_privaled A =
&1
52 template<int _AP W2» =

= ‘-?I THLINE ap_int(const ap int<_AP MW2> Rop):Base((const ap private<_AP_W2,true

54

33 templatecint _AP_W2»

56 THLINE ap_int({const ap uint<_AP_W2> Rop):Base((const ap private<_AP_W2,fal
57

a8 templatecint _AP_W2»
59 THLINE ap_int{const wolatile ap uint<_AP_W2> Rop):Base((const ap private<_

n!
o
Gl template<int _AP_W2, bool _AP_52%

G2 INLINE ap_int(const ap_range_ref<_AP_W2, _AP_32>& ret):Base(ref) {} -

4 i 2

Figure 3-21: Arbitrary Precision Header File

A more productive methodology is to exit the ap_i nt . h header file and return to view the
results.
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8. Click the Step Return button (or the F7 key) to return to the calling function.
9. Select the Variables tab.

10. Expand the out dat a variable, as shown in Figure 3-22 to see the value of the variable
shown in the VAL parameter.

% Debug ¥ Ik Explorer| 5 &f o 00 B M| 35 8 i+ 7 U0 e Wariables 22 e Breakpoints| # Registers | Bk Modules
(] harmming_winchaw_prp Debug [CfC« « Application) ol B L™
¥ C\Vivado_HLS_TutorialC_Validationhlab3Yhamming_window_privsolutic | Name Type Value -
M Thread [1] 0 (Suspended : Step) 4 % putdata out_data_t* 208
= hamming_window() at hamming_window.cppob3 (ed0l 7ia 4 1% ap privale <32, tn ap_private«32, rue. tue. ]
= main{) at hamming_window_test.cppbd Ondd1587 o Ak const winta t
# gelb B+ not_mask const wints4_t
e gipn_bul_rmask  const winbbd_t
ok VAL ap_private<32, true, true.. -42923460
* indata in_data_t * (w2Elcds =
L) (L]} k
i 1l K }
By B[22 Outline & R o %70

& hamming_ window cpp = - & ap_inth ™ ap_privateh o harmrming_window_Test.

- Y hamrming sondow.h
=* hamming_rom_init(in_data_t[])
& hamrming_wingow{oul_data_t]], in_c

] far (i = @) 1 <« WINDOW_LEN; i++#) { % hamrming_rorm_init{in_data_t[]} : v

! be done in a sub-function with global (wrt this source file) scope

hamming rom_init{window coeff);

I #pragma AP pipeline
# outdata[i] = (out_data_t)window_coeff[i] * (out_data_t)indata[i];
. } i
Y
‘ T ¥ ] 1 ¥

Figure 3-22:  Arbitrary Precision Variables

Arbitrary precision types are a powerful means to create high-performance, bit accurate
hardware designs. However, in a debug environment, your productivity can be reduced by
stepping through the header file definitions. Use breakpoints and the step return feature to
skip over the low-level calculations and view the value of variables in the Variables tab.

Conclusion

In this tutorial, you learned:

« The importance of the C test bench in the simulation process.
+ How to use the C debug environment, set breakpoints and step through the code.

+ How to debug C and C++ arbitrary precision types.
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Chapter 4

Interface Synthesis

Overview

Interface synthesis is the process of adding RTL ports to the C design. In addition to adding
the physical ports to the RTL design, interface synthesis includes an associated I/0O protocol,
allowing the data transfer through the port to be synchronized automatically and optimally
with the internal logic.

This tutorial consists of four lab exercises that cover the primary features and capabilities of
interface synthesis.

Lab 1 Description

Review the function return and block-level protocols.

Lab 2 Description

Understand the default I/O protocol for ports and learn how to select an I/O protocol.

Lab 3 Description

Review how array ports are implemented and can be partitioned.

Lab 4 Description

Create an optimized implementation of the design and add AXI4 interfaces.

Tutorial Design Description

Download tutorial design file from the Xilinx website. See Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado_HLS Tutorial\lnterface_Synthesis.
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About the Labs

» The sample design used in the first two labs in this tutorial is a simple one, which helps
the focus to remain on the interfaces.

» The final two lab exercises use a multichannel accumulator.

« This tutorial explains how to implement I/O ports and protocols using High-Level
Synthesis.

« In Lab 4, you create an optimal implementation of the design used in Lab3.

Lab 1: Block-Level I/0 Protocols

Overview

This lab explains what block-level I/O protocols are and how to control them.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 4-1).

Vivado 20163
L Add Design Tools or Devices 2016.3
e Manage Xilinx Licenses
$5 uninstan 20163
B Vivado 20163 Tel Shell
d - Wivado 20063
Systemn Generator
Vivado HLS
B Vivado HLS 20163 Command Promp

« | Vivado HLS 20163 -

4  Back

Figure 4-1. Vivado HLS Command Prompt

o In Linux, open a new shell.
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2. Using the command prompt window (Figure 4-2), change directory to the Interface
Synthesis tutorial, lab1l.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vi vado_hl s
-f run hls.tcl, as shown in Figure 4-2.

C:\Uivado_HLS_Tutorialrcd Interface_Synthesis

A

C:\Uivado_HLS_Tutoriali\Interface_Sunthesisicd labt

C:\Uiuada HLS Tuterial\Interface Synthesiz\labl>vivado_hls -f run_hlse.tcl

Figure 4-2. Setup the Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p adders prj, as shown in Figure 4-3.

BI [LIC-181] Checked inm feature [HLS]
Generating csim.exe
B+30=60

30+40+50:120
49+50+60:150
50+60+70=180

BI [$IM-1] CSim done with 8 errors.
BI [LIC-181] Checked inm feature [HLS]

C:\Uivado HLS TutorialdInterface_Sunthesishlabilruivade_hls -p adders_prj T

Figure 4-3: Initial Project for Interface Synthesis Lab 1

Step 2: Create and Review the Default Block-Level 1/0 Protocol

1. Double-click adder s. ¢ in the Source folder to open the source code for review
(Figure 4-4).

This example uses a simple design to focus on the I/O implementation (and not the logic in
the design). The important points to take from this code are:

« Directives in the form of pragmas have been added to the source code to prevent any
I/O protocol being synthesized for any of the data ports (inA, inB and inC). I/O port
protocols are reviewed in the next lab exercise.

« This function returns a value and this is the only output from the function. As seen in
later exercises, not all functions return a value. The port created for the function return
is discussed in this lab exercise.
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[y Explarer &2 0 L) addarsc £
=5 adders_prj 1% int adders{int inl, int inZ, int in3) { -
ail' Includes |
. bumr:: 51/ Prevent I0 protocols on all input ports
) AOTETEL 52 #pragma HLS INTERFACE ap_none port-in3
ks Test Bench 54 #pragma HLS INTERFACE ap_none port=in2
= selutiont 54 #pragma HLS TNTERFACE ap none port=inl

& constraints 55

4 directives.tcl

# senpticl | int sum;
= csim N . . .
. bl sum = 1nl + 1n2 + 1n3;

= build .

& report ] return sum; =
i3}
._' -

‘ 11l ]

Figure 4-4: C Code for Interface Synthesis Lab 1

2. Execute the Run C Synthesis command using the dedicated toolbar button or the
Solution menu.

When synthesis completes, the synthesis report opens automatically.

3. Toreview the RTL interfaces scroll to the Interface summary at the end of the synthesis
report.

The Interface summary and Outline tab are shown in Figure 4-5.

Interface

- Summary
RTL Pons Gir g frotocol Source Dbjact C Type
ap_clk ini 1 ap_ctrl_none adders  rrtum value
ap_rst n 1  ap_ctrl_none adders  return value
ap_retrm ot 32 ap_ctrl_none adders  retum value
iml in a2 ap_noene nl sEalar
in2 n 3z ap_none nz scalar
ind ] 1d Ap_none e scalar

Figure 4-5: Interface Summary

There are four types of ports to review:

« The design takes more than one clock cycle to complete, so a clock and reset have been
added to the design: ap_cl k and ap_r st . Both are single-bit inputs.

« A block-level I/O protocol has been added to control the RTL design: ports ap_start,
ap_done, ap_i dl e and ap_r eady. These ports will be discussed shortly.

« The design has four data ports.

o Input ports I nl, 1 n2, and I n3 are 32-bit inputs and have the I/O protocol
ap_none (as specified by the directives in Figure 4-5).
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o The design also has a 32-bit output port for the function return, ap_r et urn.

The block-level I/O protocol allows the RTL design to be controlled by additional ports
independently of the data I/O ports. This I/O protocol is associated with the function itself,
not with any of the data ports. The default block-level I/O protocol is called ap_ctr| _hs.
Figure 4-6 shows this protocol is associated with the function return value (this is true even
if the function has no return value specified in the code).

Table 4-1 summarizes the behavior of the signals for block-level I/O protocol ap_ctr | _hs.

Note: The explanation here uses the term “transaction”. In the context of high-level synthesis, a
transaction is equivalent to one execution of the C function (or the equivalent operation in the
synthesized RTL design).

Table 4-1: Block Level I/0 protocol ap_ctrl_hs

Signals

Description

ap_start

This signal controls the block execution and must be
asserted to logic 1 for the design to begin operation.

It should be held at logic 1 until the associated output
handshake ap _ready is asserted. When ap_ready goes
high, the decision can be made on whether to keep
ap_start asserted and perform another transaction or
set ap_start to logic 0 and allow the design to halt at
the end of the current transaction.

If ap_start is asserted low before ap_ready is high,
the design might not have read all input ports and might
stall operation on the next input read.

ap_ready

This output signal indicates when the design is ready for
new inputs.

The ap_ready signal is set to logic 1 when the design is
ready to accept new inputs, indicating that all input reads
for this transaction have been completed.

If the design has no pipelined operations, new reads are
not performed until the next transaction starts.

This signal is used to make a decision on when to apply
new values to the inputs ports and whether to start a new
transaction should using the ap_start input signal.

If the ap_start signal is not asserted high, this signal
goes low when the design completes all operations in the
current transaction.
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Table 4-1: Block Level 1/0 protocol ap_ctrl_hs

Signals Description

ap_done This signal indicates when the design has completed all
operations in the current transaction.

A logic 1 on this output indicates the design has
completed all operations in this transaction. Because this
is the end of the transaction, a logic 1 on this signal also
indicates the data on the ap_return port is valid.

Not all functions have a function return argument and
hence not all RTL designs have an ap_return port.

ap_idle This signal indicates if the design is operating or idle (no
operation).

The idle state is indicated by logic 1 on this output port.
This signal is asserted low once the design starts
operating.

This signal is asserted high when the design completes
operation and no further operations are performed.

You can observe the behavior of these signals by viewing the trace file produced by RTL
cosimulation. This is discussed in Chapter 8, RTL Verification tutorial, but Figure 4-6 shows
the waveforms for the current synthesis results.

Figure 4-6: RTL Waveforms for Block Protocol Signals

The waveforms in Figure 4-6 show the behavior of the block-level I/O signals.

+ The design does not start operation until ap_st art is set to logic 1.

High-Level Synthesis B Send Feedback 68
UG871 (v2016.4) November 30, 2016 www.xilinx.com L\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=68

i: X”_INX Chapter 4: Interface Synthesis

ALL PROGRAMMABLE

The design indicates it is no longer idle by setting port ap_i dl e low.

Five transactions are shown. The first three input values (10, 20, and 30) are applied to
input ports In1, In2, and In3 respectively.

Output signal ap_r eady goes high to indicate the design is ready for new inputs on
the next clock.

Output signal ap_done indicates when the design is finished and that the value on
output port ap_r et ur n is valid (the first output value, 60, is the sum of all three
inputs).

Because ap_st art is held high, the next transaction starts on the next clock cycle.

Note: In RTL cosimulation, all design and port input control signals are always enabled. For example,
in Figure 4-6 signal ap_start is always high.

In the 2nd transaction, notice on port ap_return, the first output has the value 70. The result
on this port is not valid until the ap_done signal is asserted high.

Step 3: Modify the Block-Level 1/0 protocol

The default block-level I/O protocol is the ap_ctrl _hs protocol (the Control Handshake
protocol). In this step, you create a new solution and modify this protocol.

1.
2.

High-Level Synthesis

Select New Solution from the toolbar or Project menu to create a new solution.
Leave all settings in the new solution dialog box at their default setting and click Finish.

Select the C source code tab (adders.c) in the Information pane (or re-open the C source
code if it was closed).

Activate the Directives tab and select the top-level function adder s, as shown in
Figure 4-7.
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1| adders.c i B[ EE Outline |14 Directive £ =
46 #include "adders_h" - 4@ adders

Pazint M gg{int inl, int in2, int in3) { ¢t
o * * # HLS INTERFACE ap_none port=inl
; 4 in2
i1 // Prevent T0 protocols on all input ports # HLS INTERFACE ap_none port=ind
S2®pragma HLS INTERFACE ap_none port-in3 2 in3
Sigpragma HLS INTERFACE ap_none port=in2 # HLS INTERFACE ap_none port=in3

G4 #pragma HLS INTERFACE ap none poart=inl

CC
int sum;
sum = Inl + in2 + in3;

return sum;

o 1 2

Figure 4-7: Top-Level Function Selected

Because the block-level I/O protocols are associated with the function, you must specify
them by selecting the top-level function.

5. In the Directive tab, mouse over the top-level function adder s, right-click, and select
Insert Directive.

The Directives Editor dialog box opens. Select the INTERFACE option from the Directive
pull-down list.

Figure 4-8 shows this dialog box with the drop-down menu for the interface mode
activated.
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+ | Vivado HLS Directive Editor [

Directive

INTERFACE v

Destination
(") Source File

(@) Directive File

Options

mode (optional):
O

register (optional):

depth (optional):

num_read_outstanding (optional):
num_write_outstanding (optional):
mayx_read_burst_length (optional):

max_write_burst_length (optional):

Help ] l Cancel ] l OK

Figure 4-8: Directive Dialog Box for ap_ctrl_none

The drop-down menu shows there are four options for the block-level interface protocol:

« ap_ctrl_none: No block-level I/O control protocol.
« ap_ctrl _hs: The block-level I/O control handshake protocol we have reviewed.

« ap_ctrl _chai n: The block-level I/O protocol for control chaining. This I/O protocol is
primarily used for chaining pipelined blocks together.
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« s_axilite:May be applied in addition to ap_ctrl _hs orap_ctrl _chai n to
implement the block-level I/O protocol as an AXI Slave Lite interface in place of
separate discrete I/O ports.

The block-level I/O protocol ap_ctr| _chai n is not covered in this tutorial. This protocol
is similar to ap_ctrl _hs protocol but with an additional input signal, ap_cont i nue,
which must be high when ap_done is asserted for the next transaction to proceed. This
allows downstream blocks to apply back-pressure on the system and halt further processing
when they are unable to continue accepting new data.

6. In the Destination section of the Directives Editor dialog box, select Source File.

By default, directives are placed in the di recti ves. tcl file.In this example, the directive
is placed in the source file with the existing I/O directives.

7. From the node options, select ap_ctrl_none from the drop-down menu.

8. Click OK.

The source file now has a new directive, highlighted in both the source code and directives
tab in Figure 4-9.

The new directive shows the associated function argument/port called r et ur n. All
interface directives are attached to a function argument. For block-level I/O protocols, the
ret urn argument is used to specify the block-level interface. This is true even if the
function has no r et ur n argument in the source code.

[ *addersc = O/ Outline |24 lirective &
16 #include "adders h™ A 4 @ adders

g # HLS INTERFACE ap_ctr - retu
19 int adders(int inl, int in2, int ind) { 26 FT.None por=revm

3 inl ) :
-0 # HL5 INTERFACE ap_none part=inl
51 # in2

2/ Prevent 10 protocols on all input ports # HLS INTERFALE ap_none port=in2
i #pragma HLS TINTERFACE ap none port=in3 2 in3

| #pragma HLS INTERFACE ap_none port-in2 # HLS INTERFACE ap_none port-ind

5 #pragma HLS INTERFACE ap_nong port=inl

18 int Sum;
sum = 1nl + in2 + 1n3;

return sum;

L 1] L3

Figure 4-9: Block-Level Interface Directive ap_ctrl_none

9. Click the Run C Synthesis toolbar button or use the menu Solution > Run C Synthesis
to synthesize the design.
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Adding the directive to the source file modified the source file. Figure 4-9 shows the source
file name as *adder s. c. The asterisk indicates that the file is modified but not saved.

10. Click Yes to accept the changes to the source file.

When the report opens, the Interface summary appears, as shown in Figure 4-10.

|| aciders_csynth.rpt
Interface
= Summary

RTL Ports L Bits Protocol Sowrce Obpect C Type
ap_clk in 1 ap_ctrl_none adders  return value
ap_rat in 1 ap_ctrl_none adders  return value
ap_return owl 32 ap_chrl_none adders  return valwe
inl in 32 ap_none inl scalar
ind in iz Ap_nane ind sealar
ind m 32 ap_none ind sCalar

Figure 4-10: Interface Summary for ap_ctrl_none

When the interface protocol ap_ctrl _none is used, no block-level I/O protocols are
added to the design. The only ports are those for the clock, reset and the data ports.

Note that without the ap_done signal, the consumer block that accepts data from the
ap_return port now has no indication when the data is valid.

In addition, the RTL cosimulation feature requires a block-level I/O protocol to sequence the
test bench and RTL design for cosimulation automatically. Any attempt to use RTL
cosimulation results in the following error message and RTL cosimulation with halt:

@E [SIM-345] Cosim only supports the following 'ap ctrl none' designs: (1)
combinational designs; (2) pipelined design with task interval of 1; (3) designs with
array streaming or hls stream ports.

@E [SIM-4] *** C/RTL co-simulation finished: FAIL ***

Exit the Vivado HLS GUI and return to the command prompt.

Lab 2: Port I/0 Protocols

Overview

This exercise explains how to specify port I/O protocols.
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Step 1. Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the | ab2 directory as
shown in Figure 4-11.

2. Typevivado_hls -f run hls.tcl to create a new Vivado HLS project.

C:hWivado_HLS_TutorialhInterface_Sunthesis\labl»cd

C:Z\Uivado HLS _TutorialhInterface_Synthesis>cd labz

C:\Uivado HLS Tutorial\Interface_ Synthesis\lab2ruivado_hls -f run_hls.tel

Figure 4-11: Setup for Interface Synthesis Lab 2
3. Typevivado_hls -p adders_io prj to open the Vivado HLS GUI project.

4. Open the source code as shown in Figure 4-12.

Explorer < adders_io.c
s 1 adders_io_pr i
Inchudes 16 #include “adders io.h"
Source - . .
. tiwvoid adders_io(int inl, int in2?, int ®in_outl) {
o adders_io.
& Test Bench

o solutiond

=in_outl inl + ind + ®in_outl;

& constraints
¥ directives.te
¥ scriplic
k oaum
buikd
report

Figure 4-12: C Code for Interface Sythesis Lab 2

The source code for this exercise is similar to the simple code used in Lab 1. For similar
reasons, it helps focus on the interface behavior and not the core logic.

This time, the code does not have a function return, but instead passes the output of the
function through the pointer argument *i n_out 1. This also provides the opportunity to
explore the interface options for bidirectional (input and output) ports.

The types of I/O protocol that you can add to C function arguments by interface synthesis
depends on the argument type. These options are fully described in the Vivado Design Suite
User Guide: High-Level Synthesis (UG902) [Ref 2].

The pointer argument in this example is both an input and output to the function. In the RTL
design, this argument is implemented as separate input and output ports.
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For the code shown in Figure 4-12, the possible options for each function argument are

described in Table 4-2.

Table 4-2:

Chapter 4: Interface Synthesis

Port Level 1/0 Protocol Options for Lab 2

Function Argument

1/0 Protocol Options

Inl and In2

These are pass-by-value arguments that can be
implemented with the following I/O protocols:

« ap_none: No I/O protocol. This is the default for inputs.

 ap_stable: No I/O protocol.

« ap_ack: Implemented with an associated output
acknowledge port.

+ ap_vld: Implemented with an associated input valid
port.

« ap_hs: Implemented with both input valid and output
acknowledge ports.

in_outl

This is a pass-by-reference output that can be
implemented with the following I/O protocols:

« ap_none: No I/O protocol. This is the default for inputs.

« ap_stable: No I/O protocol.

+ ap_ack: Implemented with an associated input
acknowledge port.

+ ap_vld: Implemented with an associated output valid
port. This is the default for outputs.

» ap_ovld: Implemented with an associated output valid
port (no valid port for the input part of any inout
ports).

+ ap_hs: Implemented with both input valid port and
output acknowledge ports

« ap_fifo: A FIFO interface with associated output write
and input FIFO full ports.

« ap_bus: A Vivado HLS bus interface protocol.

Note: The port directives applied in Lab 1 were not actually necessary because ap_none is the
default I/O protocol for these C arguments. The directives were provided to avoid addressing any I/O
port protocol behavior in that exercise, default behavior or not.

In this exercise, you implement a selection of I/O protocols.

Step 2: Specify the 1/0 Protocol for Ports

1. Ensure that you can see the C source code in the Information pane.

2. Activate the Directives tab and select input in1, as shown in Figure 4-13.

High-Level Synthesis
UG871 (v2016.4) November 30, 2016

. Send Feedback
www.Xilinx.com l—\/—]

75


http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=75

i: X”_INX Chapter 4: Interface Synthesis

ALL PROGRAMMABLE-

£ achders o | B B2 Ounline (1] Directive &3

............................................................................... -~ 4 & adders io

1 “adders io.h"
#include “adders_io 2 inl

1Evoid adders_io(fTRLdl, int in2, int ®in_outl) { ? Ing
1 # in_outl

Tin_outl = inl + in2 + "in_outl;

Figure 4-13: Adding Port I/0 Protocols
3. Right-click and select Insert Directive.
4. When the Directives Editor opens leave the Directive drop-down menu as INTERFACE.

a. Leave the destination at the default value. This time, the directives are stored in the
directives.tcl file.

b. Select ap_vld from the mode drop-down menu
c. Click OK.
5. Select argumenti n2 and add an interface directive to specify the I/O protocol ap_ack.

6. Select argument i n_out 1 and add an interface directive to specify the I/O protocol
ap_hs.

7. In the Explorer pane, expand the Constraints folder and double-click the
directives.tcl fileto open it as shown in Figure 4-14.

& Explorer ! = 0| [£ adders_io.c o directives.tel
1= adders_io_prj 1AL AL AL AL AL AL AL
8 Tnchudes 3 file is generated automatically by Vivado HLS.
Source Please DO N . dit :!..
) C) 2814 Xilinx
£ Aders_Io A0 AL AL AL AL AL A
s Test Bench set directive interface -mode ap vld "adders io™ inl
o solution] set directive interface -mode ap ack "adders io™ in2
@ constrainis aet directive interface -mode ap hs "adders 10" in_outl

7 directives.tcl
o scripticl
& cum
=+ Build
& report

Figure 4-14: Directives for Lab 2
8. Synthesize the design.

9. Review the Interface summary when the report file opens (Figure 4-15).
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&« adders_io.c & directives. tel |l adders_io_csynth.rpt -

Interface
= Summary
Dir Bits Protocol  Source Object CType

ap_clk in 1 ap_ctr_hs adders_io  return value
ap_rst n 1 ap_ctri_hs adders_ 10 return value
ap_start in 1 ap_ctrl_hs adders_io  return value
ap_done out 1 ap_ctr_hs adders_io  return value
ap_idle oul 1 ap_ctri_hs adders_ 10 return value
ap_ready out 1 ap_ctrl_hs adders_io  return value
inl in 3z ap_vid inl scalar
inl_ap_vid n 1 ap_vid nl scalar
in2 inm 32 ap_ack in2 scalar
in?_ap_ack out 1 ap_ack in? scalar
in_outl g n 32 ap_hs in_outl poanter
in_outl_i_ap_vid in 1 ap_hs in_outl pointer
in_out]_i_ap_ack out 1 ap_hs in_out] painter =
in_outl o oul 32 ap_hs in_outl poanter
inoutl c_apvid  out 1 ap_hs in_outl pointer
in_out]_o_ap_ack in 1 ap_hs in_out] painter

Figure 4-15: Interface Summary for Lab 2
« The design has a clock and reset.
« The default block-level I/O protocol signals are present.
« Portinlis implemented with a data port and an associated input valid signal.
« The data on port inl is only read when port inl_ap_vld is active-High.
+ Portin2isimplemented with a data port and an associated output acknowledge signal.
« Portin2_ap_ack will be active-High when data port in2 is read.

« Theinout _i identifies the input part of argument inoutl. This has associated input
valid porti nout 1_i _ap_vl d and output acknowledge porti nout1_i _ap_ack.

« The output part of argument inoutl is identified as inout_o. This has associated output
valid porti nout 1_o_ap_vl d and input acknowledge port inoutl_o_ap_ack.

10. Exit the Vivado HLS GUI and return to the command prompt.

Lab 3: Implementing Arrays as RTL Interfaces

Introduction

This exercise shows how array arguments on the top-level function interface can be
implemented as a number of different types of RTL port.
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Step 1. Create and Open the Project

1. From the Vivado HLS command prompt window used in the previous lab, change to the
| ab3 directory.

2. Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.
3. Open the Vivado HLS GUI project by typing vivado hls -p array_ io prj.

4. Open the source code as shown in Figure 4-16.

This design has an input array and an output array. The comments in the C source explain
how the data in the input array is ordered as channels and how the channels are
accumulated. To understand the design, you can also review the test bench and the input
and output data in file resul t. gol den. dat .

Explorer 3 T Le] anray o |
=5 array_io_pi i\ #include “array_io.h" -
i Inchsdes :
Source
& array_iou
ia Test Bench
s salutent
@ constrainis
A directives.ic
o seripticl
o e veid array_io (dout_t d_a[M], din_t d_i[n]) {

build int i, rem;

reporn
statie dacc_t acc[CHANMELS];
For_Loop: for (i=@;i<Njis+) {

remsiBCHANNELS )

acc[rem] = acc[rem] + d_i[i];
d_o[i] = acc[rem];

Figure 4-16: C Code for Interface Synthesis Lab 3

Step 2: Synthesize Array Function Arguments to RAM Ports
In this step, you review how array ports are synthesized to RAM ports.

1. Synthesize the design and review the Interface summary when the report opens
(Figure 4-17).

The interface summary shows how array arguments in the C source are by default
synthesized into RTL RAM ports.

« The design has a clock, reset, and the default block-level I/O protocol ap_ctrl _hs
(noted on the clock in the report).

« The d_o argument has been synthesized to a RAM port (I/O protocol ap_mnenory).
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+ A data port (d_o_dO).
« An address port (d_o_addr ess0).
« Control ports for a chip-enable (d_o_ce0) and a write-enable port (do_we0).

« Thed_i argument has been synthesized to a similar RAM interface, but has an input
data port (d_i _q0) and no write-enable port because this interface only reads data.

In both cases, the data port is the width of the data values in the C source (16-bit integers
in this case) and the width of the address port has been automatically sized to match the
number of addresses that must be accessed (5-bit for 32 addresses).

1 array_io_csyntiupt &

Interface i
Summary
Dir  Bits Pratocal Source Chject C Type

ap_clk mn 1 ap_clrl_hs amay_1o  relurn value
ap_rst in 1 ap_ctrl_hs array_io  retumn value
ap_start in 1 ap_ctri_hs array_io  return value
ap_done oul 1 ap_clrl_hs amay_1o  relurn value
ap_idle out 1 ap_ctrl_hs array_io  retumn value
ap_ready out 1 ap_ctrl_hs array_ic  retumn value
d_o_addressD  out 5 ap_memaory d_o Array
d_o_cel oul 1  ap_memory d_o array
d_o_wel out 1 ap_memory d_o array
d_o_d0 out 16 ap_memary d_o Array
d_1_address) oul 3 ap_memory d.i array
d_i_ced out 1 ap_memory d_i array
d_i_q0 in 16 ap_memary d_i Array

o 1 ]

Figure 4-17: Interface Summary for Initial Lab 3 Design

Synthesizing array arguments to RAM ports is the default. You can control how these ports
are implemented using a number of other options. The remaining steps in Lab 3
demonstrate these options:

¢ Using a single-port or dual-port RAM interface.
« Using FIFO interfaces.

« Partitioning into discrete ports.

Step 3: Using Dual-Port RAM and FIFO Interfaces

High-Level Synthesis allows you to specify a RAM interface as a single-port or dual-port. If
you do not make such a selection, Vivado HLS automatically analyzes the design and selects
the number of ports to maximize the data rate.
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Step 2 used a single-port RAM interface because the for-loop in the source code is by
default left rolled: each iteration of the loop is executed in turn:

* Read the input port.

« Read the accumulated result from the internal RAM.

« Sum the accumulated and new data and write into the internal RAM.
»  Write the result to the output port.

« Repeat for the next iteration of the loop.

This ensures only a single input read and output write is ever required. Even if multiple input
and outputs are made available, the internal logic cannot take advantage of any additional
ports.

Note: If you specify a dual-port RAM and Vivado HLS can determine only a single port is required,
it uses a single-port and over-ride the dual-port specification.

In this design, if you want to implement an array argument using multiple RTL ports, the
first thing you must do is unroll the for-loop and allow all internal operations to happen in
parallel, otherwise there is no benefit in multiple ports: the rolled for-loop ensure only one
data sample can be read (or written) at a time.

Select New Solution from the toolbar or Project menu to create a new solution.
Accept the defaults, and click Finish.

Ensure the C source code is visible in the Information pane.

W N

In the Directive tab select For_Loop, and right-click to open the Directives Editor
dialog box.

a. Inthe Directives Editor dialog box activate the Directive drop-down menu at the top
and select UNROLL.

b. With the Directives Editor as shown in Figure 4-18, click OK.
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Vivado HLS Directive Editor
Directive
[UNROLL -

Destinaticn
Source File

2 Directive File

Options
skip_exit_check {optional):

factor (optional):

reqion (optional):

Hexlp Cancel l D ]

Figure 4-18: Directives Editor to Unroll For_Loop

5. Next, specify a dual-port RAM for input reads. The Resource directive indicates the type
of RAM connected to an interface.

a. In the Directive tab, select port d_i and right-click to open the Directives Editor
dialog box.

b. In the Directives Editor activate the Directive drop-down menu at the top and select
RESOURCE.

c. Click the core options box and select RAM_2P_BRAM.

d. Verify that the settings in the Directives Editor dialog box are as shown in
Figure 4-19 and click OK.
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i |Vivado HLS Directive Editor ==
Directive
|REsOURCE -
Destination

Source File

2 Directive File

Options
variable (required): di
care [optional) RAMA_2F_BRAM

latency [optional):

mitadata (optional):

Figure 4-19: Directives Editor for Specifying a Dual-port RAM
6. Implement the output port using a FIFO interface.

a. In the Directive tab, select port d_o and right-click to open the Directives Editor
dialog box.

b. In the Directives Editor, ensure the directive is Interface.
¢. From the Mode drop-down menu, select ap_fifo.

d. Click OK.

The Directive tab shows the directives now applied to the design (Figure 4-20).
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22 Outline

Figure 4-20:

(14 Directive &1

4|2 array_io

@ d_o

%% HLS INTERFACE ap_fifo part=d_o

# di

Gb HLS RESOURCE vanable=d_i core=RAM_2P_BRAM
ul] ace

a ' For_Loop

U HLS UNROLL

7. Synthesize the design.

Chapter 4: Interface Synthesis

Directives Summary for Lab 2 Solution

When the report opens in the Information pane, the Interface summary is as shown in

Figure 4-21.

« The design has the standard clock, reset, and block-level I/O ports.

« Array argument d_o has been implemented as a FIFO interface with a 16-bit data port
(d_o_di n) and associated output write (d_o_wri t e) and input FIFO full

(d_o_full _n) ports.

« Argument d_i has been implemented as a dual-port RAM interface.

il array lo esynth.rpr ©2

Interfacc
= Bummary
RTL Ports Dir  Bits Protocol
ap_clk in 1 ap_ctrl_he
ap_rst in 1 ap_ctrl_he
ap start m 1 ap_clel_hs
#p_done out L ap_ctrl_hs
ap_idle ot 1 ap_ctrl_hs
ap_ready aul 1 ap_ctrl_hs
d_o_din out 16 ap_fifo
d_o_full_n in 1 ap_fifo
d_o_wrile aul 1 ap_hlo
d__addressD  out 5 ap_memory
d_i_ced ot 1 ap_memaory
d_i_qf in 16 ap_memdory
d i addressl ol 3 ap_rmamry
d_i_cel out 1 ap_memory
d_i_gl in 16 ap_memory
Figure 4-21:
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array_io
array_ia
array_io
array_io
Array_in
array_io

d_o
d_o
do
di
d_i
d_i
do
di
d_i
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C Type
raturn value
return value
rturn value
returm value
retum valug
return value

painter
painter
pamnter
array
ATay
Array
array
array
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By using a dual-port RAM interface, this design can accept input data at twice the rate of
the previous design. Because the for-loop was unrolled, the logic in the loop is able to
consume data at this rate. By default, each loop iteration is executed in turn. This
implementation code limits the logic to one read on d_i in each iteration. Unrolling the
loops allows more reads to be performed (but creates N copies of the logic). However, by
using a single-port FIFO interface on the output the output data rate is the same as before.

Step 4. Partitioned RAM and FIFO Array interfaces
In this step, you learn how to partition an array interface into any arbitrary number of ports.

1. Select New Solution from the toolbar or the Project menu and create a new solution.

2. Accept the defaults, and click Finish. This includes copying existing directives from
solution2.

3. Ensure the C source code is visible in the Information pane.

4. 1In the Directive tab, select d_o and right-click to open the Insert Directives Editor
dialog box.

a. Inthe Directives Editor dialog box activate the Directive drop-down menu at the top
and select ARRAY_PARTITION.

b. Activate the options type drop down to partition the array into blocks. Set type to
block.

¢. In the Vivado HLS Directive Editor dialog box, set the factor (optional) to 4.
d. With the Vivado HLS Directive Editor as shown in Figure 4-22, click OK.
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Now, partition the input array into two blocks (not four).

Chapter 4: Interface Synthesis

Vivado HLS Directive Editor

Directive

ARRAY_PARTITION

Destination
Sowrce File
2 Directive File

Options
variable (required): d_o

typee (optional) hlock

factor (optional): 4

dimension {optional): 1

Help Cancel

Figure 4-22: Directives Editor for Partitioning Array d_o

5. In the Directive tab, select d_i and repeat the previous step, but this time partition the
port with a factor of 2.

The directives tab shows the directives now applied to the design (Figure 4-23).
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8z Outline | (1% Directive &1
4 @ array_io
4 do

%% HLS ARRAY_PARTITION partition variable=d_o block factar=4 dim=

% HLS INTERFACE ap_fifo port=d_o
@ da

% HLS ARRAY_PARTITION variable=d_i block factar=2 dim=1

% HLS RESOURCE variable-d_i core = RAM_2P_BRAM

1 ace
a5 For_loop
%% HLS UNROLL

o 1

Figure 4-23: Directives Summary for Lab 2 Solution3
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6. Synthesize the design.

When the report opens in the Information pane, the Interface summary is as shown in
Figure 4-24.

« The design has the standard clock, reset, and block-level I/O ports.

« Array argument d_o has been implemented as a four separate FIFO interfaces.

« Argumentd_i has been implemented as a two separate RAM interfaces, each of which
uses a dual-port interface. (If you see four separate RAM interfaces, confirm a partition
factor for d_i is two and not four).

() array_io_csynth.pt [

Interface =
= Summary
RTL Ports Dir  Bits Protocel Source Object C Type
ap_clk in 1 ap_ctrl_hs array_io  réturn value
ap_rst n 1 ap_chrl_hs array_io  reburn value
ap_start in 1 ap_ctrl_hs array_io  return value
ap_done out 1 ap_ctrl_hs array_io  réturn value
ap_idle oul 1 ap_chrl_hs array_io  reburn value
ap_ready out 1 ap_ctrl_hs array_io  return value
d_a_0_din out 16 ap_fifo d_o_0 painter
d_o 0_full_n n 1 ap_hifo dol poanter
d_o_0_write out 1 ap_fifo do0 pointer
d_a_l_din out 16 ap_fifo d_o_l painter
d o 1 full_n n 1 ap_hifo dol poanter
d_o_1_write out 1 ap_fifo deol pointer
d_o_2_din out 16 ap_fifo d_o_2 painter
d_o 2 full_n n 1 ap_hifo dod poanter
d_o_2_write out 1 ap_fifo do pointer
d_o_3_din out 16 ap_fifo d_o_3 painter
d_o_3_full_n n 1 ap_hifo do 3 poanter
d_o_3_write out 1 ap_fifo do3 pointer
d_i_0_address0  out 4 ap_memory d_i 0 array
d_p 0 ced oul 1  ap_memory d i 0 array
d_i_0_q0 in 1&  ap_memory d_i0 array
d_i_0_addressl  out 4 ap_memory d_i 0 array
d_ 0 cel oul 1  ap_memory d i 0 array =
dii0ql in 1&  ap_memory d_i0 array
d_i_l_address0  out 4 ap_memory d_i_l array
d 1 ced oul 1  ap_memory dl array
d_i_1_gd in 16 ap_memory dil array
d_i_l_addressl  out 4 ap_memory d_i_l array
d 1 cel oul 1  ap_memory dl array
d_i_1lql in 16  ap_memory dil array

Figure 4-24: Interface Report for Partitioned Interfaces
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If input port d_i was partitioned into four, only a single-port RAM interface would be
required for each port. Because the output port can only output four values at once, there
would be no benefit in reading eight inputs at once.

The final step in this tutorial is to partition the arrays completely.

Step 5: Fully Partitioned Array Interfaces
This step shows you how to partition an array interface into individual ports.

1. Select New Solution from the toolbar and create a new solution.

2. Click Finish and accept the defaults. This includes copying existing directives from
solution3.

3. Ensure the C source code is visible in the Information pane.

4. In the Directive tab, select the existing partition directive for d_o as shown in
Figure 4-25.

5. Right-click and select Modify Directive.

82 Outline | (1% Directive &

4 @ array_io
4 do
% HIS ARRAY PARTITION variable-d_o complete factor=4 dim=1
oy & Modify Directive kd o

@ & Remove Directive

U HLS ARRAY _PARTITION partition variable-d_i complete dim=1
O HLS RESOURCE vanable=d_ core=RAM_2P_BRAM
u[l arc

4 5 For_Loop
9% HLS UMNROLL

Figure 4-25: Modifying the Directive for d_o
6. In the Vivado HLS Directive Editor dialog box:

a. Inthe Vivado HLS Directive Editor dialog box, delete the value 4. Since this array will
be completely partitioned into registers, the partitioning factor is no longer relevant.
(If you leave it there, it will be ignored).

b. Activate the type (optional) drop down and modify the partitioning type to
Complete.

c. With the Directives Editor as shown in Figure 4-26, click OK.
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Vivado HLS Directive Editor
Directive
x.ﬁ.RRAY_PARTmGN A

Destination
Sowrce File
2 Directive File

Options
variable (required): d_o

typee (optional) complete -
factor (optional):

dimension {optional): 1

Help Cancel (DK, I

Figure 4-26: Directives Editor for Partitioning Array d_o
7. Inthe Directive tab, selectd_i and repeat the previous step to completely partition the
d_i array.

8. In the Directive tab, select the RESOURCE directive on d_.i , right-click with the mouse
and select Remove Directive. If the array is partitioned into individual elements, it
cannot be assigned to a block RAM.

The Directives tab shows the directives now applied to the design (Figure 4-27).

High-Level Synthesis N send Feedback 88
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—l



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=88

i: X”_INX Chapter 4: Interface Synthesis

ALL PROGRAMMABLE

2= Outline | 1 Directive & =

4 B array_io
® do
% HLS INTERFACE ap_fifo port=d_o
U HLS ARRAY_PARTITION variable-d_o complete dim=1
¥ da
%% HLS ARRAY_PARTITION variable=d_i caomplete dim=1
=1 acc
@ temp

4 5 For_Loop
% HLS UNROLL

Figure 4-27: Directives Summary for Lab 2 Solution4
9. Synthesize the design.

10. When the report opens in the Information pane, review the interface summary. Note the
following:

« The design has the standard clock, reset, and block-level I/O ports.
« Array argument d_o has been implemented as 32 separate FIFO interfaces.

« Argument d_i has been implemented as 32 separate scalar ports. Because the default
interface for input scalars is not in the I/O protocol, they have the I/O protocol
ap_none.

Although this tutorial has focused exclusively on the I/O interfaces, at this point it is worth
examining the differences in performance across all four solutions.

11. Select Compare Reports from the toolbar or the Project menu to open a comparison of
the solutions.

12.In the Solution Selection dialog box, add each of the four solutions to the Selected
Solutions pane (Figure 4-28).

13. Click OK.
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+ | Solution Selection Dialog =5
Solution Selection

PFlease select the solutions you want to compare

Available solulions: Selected solubions:

solubionl
solubion?
solution3

solutiond

K ' Cancel

Figure 4-28: Compare All Solutions for Lab 3

When the solutions comparison report opens (Figure 4-29), it shows that solution4, using a
unique port for each array element, is much faster than the previous solutions. The internal
logic can access the data as soon as it is required. (There is no performance bottleneck due
to port accesses.)

Performance Estimates

=l Timing (ns)
Clock solutionl solution2 solution3  solutiond
ap_clk  Target 4.00 4.00 4.00 4.00
Estimated 239 2.98 2.96 296

=l Latency (clock cycles)

solutionl  solutionZ solution3  solutiond

Latency min 129 33 11 2
max 129 23 11 2
Interval min 130 34 12 3
max 130 34 12 3

Figure 4-29: Performance Comparisons for All Lab 3 Solutions

Scroll further down the comparison report (Figure 4-30) and note that solutions with more
I/O ports (solutions 2, 3, and 4), allows more parallel processing, but also use considerably
more resources.
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Utilization Estimates

solutionl  solution2  solution?  solutiond

BRAM_18K 0O 0 0 0
DSP48E 0 0 0 0

FF 202 1346 916 779
LUT 71 1319 1251 1082

Figure 4-30: Resource Comparisons for All Lab 3 Solutions

In the next exercise, you implement this same design with an optimum balance between the
ports and resources. In addition to this more optimal implementation, the next exercise
shows how to add AXI4 interfaces to the design.

14. Exit the Vivado HLS GUI and return to the command prompt.

Lab 4: Implementing AXI4 Interfaces

Introduction

This exercise explains how to specify AXI4 bus interfaces for the I/O ports. In addition to
adding AXI4 interfaces this exercise also shows how to create an optimal design by using
interface and logic directives together.

Step 1: Create and Open the Project

1. From the Vivado HLS command prompt window used in the previous lab, change to the
lab4 directory.

2. Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.
3. Open the Vivado HLS GUI project by typing vivado hls -p axi interfaces prj.

4. Open the source code as shown in Figure 4-31.
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15| s interfacesc &
A5 #include "axi_intertaces.h” -

7 wold axdi_interfaces (dout_t d_o[MN], din_t d_i[MN]) {
] int i, rem;

ff Store accumulated data
static dacc_ U acc[CHANMELS]:

/f Accumulate each channel
For_Loop: for {1=@;1<N;ive) {
rem=1i¥CHANNELS;
acc[rem] = acclrem] + d_1[1];
d a[i] = acc[rem];

Figure 4-31: Source Code for Lab 4

This design uses similar source C code as Lab 3: with the design renamed to
axi __interfaces.

Step 2: Create an Optimized Design with AX14-Stream Interfaces

In the optimal performance implementation of this design, the data for each channel would
be processed in parallel, with dedicated hardware for each channel.

The key to understanding how best to perform this optimization is to recognize that the
channels in the input and output arrays lend themselves to cyclic partitioning. Cyclic
partitioning is fully explained in the Vivado Design Suite User Guide: High-Level Synthesis
(UG902) [Ref 2], but basically means each array element is, in turn, sorted into a different
partition.

In this exercise, you specify the array arguments to be implemented as AXI4-Stream
interfaces. If the arrays are partitioned into channels, you can stream the samples for each
channel through the design in parallel.

Finally, if the I/O ports are configured to supply and consume individual streams of channel
data, partial unrolling of the for-loop can ensure dedicated hardware processes each
channel.

First, partition the arrays:

1. Ensure the C source code is visible in the Information pane.
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2. In the Directive tab, select d_o and right-click to open the type dialog box.

a. Select the type (optional) drop-down menu at the top and select
ARRAY_PARTITION.

b. Click the Directive drop-down menu to specify cyclic partitioning.

c. In the factor (optional) box, enter the value 8, to create eight separate partitions.
(This results in eight ports.)

d. With the Directives Editor dialog box filled in as shown in Figure 4-32, click OK.

Vivado HLS Directive Editor
Directive
ABBEAY PARTITICON -

Destination
Source File

2 Directive File

Options
variable (required): d_o

type (optional): cyclic -
factor {optional): B

dimension (optional): 1

Hexlp Cancel l D ]

Figure 4-32: Directives Editor for Cyclic Partitioning

3. In the Directive tab, select d_o again and right-click to open the Insert Directives Editor
dialog box.

a. Activate the Directive drop-down menu at the top and select INTERFACE.
b. Click the Mode drop-down menu to specify an axis interface.
c. Click OK.

4. In the Directive tab, select d_i and repeat steps 2 and 3 above.

a. Apply ARRAY_PARTITION.
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b.
C.

d.

Apply Cyclic with a factor of 8.
Apply Interface.

Apply an axis interface.

5. Next, partially unroll and pipeline the for-loop:

a.

d.

e.

In the Directive tab, select For_Loop and right-click and select Insert Directive to
open Vivado HLS Directive Editor dialog box.

Select Activate the Directive drop-down menu at the top and select UNROLL.

Select a factor of 8 to partially unroll the for-loop. This is equivalent to re-writing the
C code to execute eight copies of the loop-body in each iteration of the loop (where
the new loop only executes for four iterations in total, not 32).

Click OK.

In the Directive tab, select For_Loop again and right-click and select Insert
Directive to open Vivado HLS Directive Editor dialog box.

Activate the Directive drop-down menu at the top and select PIPELINE. Leave the
interval (II) blank and let it default to 1.

Select enable loop rewinding.

Click OK.

When the top-level of the design is a loop, you can use the pipeline rewind option. This
informs Vivado HLS that when implemented in RTL, this loop runs continuously (with no
end of function and function re-start cycles).

After performing the above steps, the Directives tab should be as shown in Figure 4-33. Be
sure to check all options are correctly applied. If not, double-click the directive to re-open
the Directives Editor.
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g= Outling | 4 Directive
o axi_interfaces
# do
O HLS INTERFACE aas port=d_o
%% HLS ARRAY_PARTITION partition variable=d_o cyclic factor=8 dim=1
@ d_i
O HLS INTERFACE aus port=d
%% HLS ARRAY_PARTITION partition variable=d_i cyclic factor=38 dim=1
=[] acc
4 For_Loop
U HLS UNRCHLL factar=8
% HLS PIPELINE rewind

Figure 4-33: Directives Tab for Lab 4 Solutionl

6. Synthesize the design.

When the report opens in the information pane, confirm both d_i and d_o are implemented
as eight separate AXI4-Stream ports.

7. In the performance section of the report, confirm that the for-loop processes one
sample every clock cycle (Interval 1) with a latency of 3 (and max 4), and that the design
has less area than solutions 2, 3, or 4 in Lab 3 (Figure 4-33).

Cyclic partitioning of the array interfaces and partial for-loop unrolling has allowed
implementation of this C code as eight separate channels in the hardware.

Pipelining the for-loop allows the logic in each channel to process 1 sample per clock.
Varying the partitioning and loop unrolling allows you to create a design which is the
optimal balance of area and performance to satisfy your particular requirements.

Step 3: Implementing an AXI4-Lite Interfaces

In this exercise, you group block-level I/O protocol ports into a single AXI4-Lite interface,
which allows these block-level control signals to be controlled and accessed from a CPU.

1. Select New Solution from the toolbar or the Project menu to create a new solution.

2. Accept the defaults and click Finish. This includes copying existing directives from
solutionl.

3. Ensure the C source code is visible in the Information pane.

4. Inthe Directive tab, select the top-level function axi_interfaces and right-click to open
the Insert Directives Editor dialog box.

a. Select the Directive drop-down menu at the top and select INTERFACE.
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b. Select the mode drop-down menu and select s_axilite. This specifies that the ports
associated with the function return (the block-level I/O ports) are implemented as an
AXI4-Lite interface. Since the default mode for the function return is ap_ctrl_hs, there
is no requirement to specify this I/O protocol.

c. Click OK.

The Directives tab appears, as shown in Figure 4-34.

o= Duthine |CF Directive &2 = -
4@ axi_interfaces
% HLS INTERFACE s_avilite port=return
4 o
% HLS INTERFACE axis port=d_o
% HLS ARRAY PARTITHON partibion vanable=d_o cyche factor=8 dim=1
# i
% HLS INTERFACE axis port=d_i
% HLS ARRAY PARTITION partition vanable=d i cychic factor=8 dim=1
=] acc
4 5 For_Loop
% HLS UNROLL factor=8
% HLS PIPELIME rewind

Figure 4-34: Directives for Specifying AXl4-Lite Interfaces
5. Synthesize the design.

When the report opens, review the interface summary to confirm the block-level I/O
protocol ports (ap_st art, ap_done, etc.) have been replaced with an AXI4Lite interface
and that the output interrupt signal has been added to the design. The source of the
interrupt can be selected through the AXI-Lite interface.

6. Select Export RTL from the toolbar or the Solution menu to create an IP package.

7. Leave the Format Selection as IP Catalog and click OK.

You can see the IP package in the sol uti on2/i npl folder. Because you used the Vivado
IP Catalog format, the package is in the ip folder.

The i p folder includes the dri ver s subfolder, as shown in Figure 4-35.

When you add an AXI4-Lite interface to the design, the IP packaging process also creates
software driver files to enable an external block, typically a CPU, to control this block (start
it, stop it, set port values, review the interrupt status).
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L\ Explarer 2
4+ =% axi_interfaces_prj
wil' Includes
= Source
= Test Rench
G solutionl
s 7= solution?
@& constraints
a & impl
s = ip
autaimpllog
| auxihary.xml
| component.xml
pack.bat
W run_ippacktcl
wivado.jou
vivado.log
waliny_com_hls_aa_interfaces 1 _0ap
> bl
# constraints
= dog
4 (= drivers
& axi_imterfaces vl 0
= data
X
i Makefile

3 wana_interfaces_hwh

e

| wani_interfaces_linunc
xaxi_interfaces_sinit.c
s XelXl mierfacess

e wawi_interfacesh
& example
> hdl
& misc
= subcore
= Mo
&> verilog
= vhdl
&y

Figure 4-35: IP Package with AXI4 Interfaces

8. Double-click the xaxi _i nt erfaces_hw. h file to open it in the Information pane.

This shows the addresses to access and control the block-level interface signals. For
example, setting control register 0x0 bit O to the value 1 will enable the ap_start port, or
alternatively, setting bit 7 will enable the auto-restart and the design will re-start
automatically at the end of each transaction.

The remaining C driver files are used to integrate control of the AXI4 Slave Lite interface
into the code running on a CPU or microcontroller and are included in the packaged IP.
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Wakedile
& xam_mderfaoes Pach

i raxi_interfaces hw.h

& MAXT_TWTERFACES_AXTLITES_ADDR_AP_CTAL (i
sdefine XAX]_INTERFACES AXILITES ADOR_GIE
Sdefine A]_INTERFACES AXILITES ADDR_TER
Scdafine XAKI _THTERFACES AXILITES_ADDR_TSH

Figure 4-36: IP Software Driver Files

Chapter 4: Interface Synthesis

Conclusion

In this tutorial, you learned:

« What block-level I/O protocols are and how to control them.

« How to specify and apply port-level I/O protocols.
+ How to specify array ports as RAM and FIFO interfaces.
+ How to partition RAM and FIFO interfaces into sub-ports.

+ How to use both I/O directives and optimization directives to create an optimal design

with AXI4 interfaces.
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Chapter 5

Arbitrary Precision Types

Overview

C/C++ provided data types are fixed to 8-bit boundaries:

« char (8-bit)

« short (16-bit)

« int (32-bit)

« long long (64-bit)
« float (32-bit)

« double (64-bit)

« Exact width integer types such as intl6_t (16-bit) and int32_t (32-bit)

When creating hardware, it is often the case that more accurate bit-widths are required.
Consider, for example, a case in which the input to a filter is 12-bit and the accumulation of
the results only requires a maximum range of 27 bits. Using standard C data types for
hardware design results in unnecessary hardware costs. Operations can use more LUTs and

registers than needed for the required accuracy, and delays might even exceed the clock
cycle, requiring more cycles to compute the result.

Vivado High-Level Synthesis (HLS) provides a number of bit accurate or arbitrary precision
data-types, allowing you to model variables using any (arbitrary) width.

This tutorial consists of a two lab exercises:

Lab 1 Description

Synthesize a design using floating-point types and review the results. The design uses
standard C++ floating-point types.

Lab 2 Description

Synthesize the same function used in Lab 1 using arbitrary precision fixed-types
highlighting the benefits in accuracy and results. This exercise shows how this same design
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can be converted to the Vivado HLS ap_fixed types, retaining the required accuracy but
creating a more optimal hardware implementation.

Tutorial Design Description

Download the tutorial design file from the Xilinx website. See the information in Locating
the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado_HLS Tutorial\Arbitary_Precision.

Lab 1: Arbitrary Precision

Arbitrary Precision Lab 1: Review a Design using Standard C/C++ types.

In this lab, you synthesize a design using standard C types. You use this design as a
reference for the design using arbitrary precision types, which is the basis for Lab 2.

i? IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado _HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

a. On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 5-1).

b. On Linux, open a new shell.
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Vivado 20163

o Add Design Toolks or Devices 2016.3
av Manage Xilinx Licenses
$: uninstan 20163

2063

System Generator

Vivado HLS
B Vivado HLS 20163 Command Promp
Vivado HLS 20163 -
4  Back

Figure 5-1:  Vivado HLS Command Prompt

2. In the command prompt window (Figure 5-2), change the directory to the Arbitrary
Precision tutorial, lab1l.

3. Execute the Tcl script to setup the Vivado HLS project, using the command as shown in
Figure 5-2:

vivado hls -f run hls.tcl

C:wUivado_HLS_Tutorialicd Arbitrary_Precision

C:y\Uivado HLS _TutorialhArbitrary_Precision>cd labil

C:\Wivado HLS Tuterial\Arbitrary Precision\lablivivade_hls -f run_hls. tecl -

Figure 5-2: Setup the Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado _hls -p window fn prj as shown in Figure 5-3.

he_result 18 . 24283
Ncl:lalels)

B jtn fels i s i fln el e
O R A D = =

= 31 hu:result

Test Pas |
@I [SIM-1] C3im done with @ errors.
@I [LIC-181] Checked in feature [HLS]

C:\Uivado HLS Tutorial‘ZArbitrary Precision’labliuvivado_hls =p window_fn

Figure 5-3. Initial Project for Arbitrary Precision Labl
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Step 2: Review Test Bench and Run C Simulation

1. Open the Source folder in the Explorer pane and double-click window fn top.cpp to
open the code as shown in Figure 5-4.

&5 Explarer 0= 0 ] window In_top.cpp & =0
2 125 window_fn_prj |45 #include "window_fn_top.h" // Provides typedefs and params i
wil Includes 46
4 = Source a7 ff Include the entire xhls_window_fn namespace so that scope r

A8/ i.e. prepending xhls window fn:: to everything -
o window_In_top.cpp ' [E ( ‘ ry [

s st Bench ‘ I::u:in; namaspace xhls_window_fn;

a ¢ solutiond

- is not nes

51/ /Wivado HLS fequires a top-level function definition that wra
2 @ constraints 52/f instantiations and method calls to be synthesized as well
o directives.tcl .

a

3/ the top-level T/0 (function arpuments’) intofout of the meth:

W seripticl S vedd window_fn_top(
i B ceimn 55 win_fn_out_t outdata[WIM_LEN], =

e win fn_in t indata[WIN LEN])

& build 57

& report 58 {f Instantiate a window_fn object types and params define

- il Fa s ila Fa Lo i VI o TTT W 1 VI o T S Y
o 111

Figure 5-4: C Code for C Validation Lab 3

2. Hold down the Control key and click the wi ndow_f n_t op. h on line 45 to open this
header file.

3. Scroll down to view the type definitions (Figure 5-5).

« window_fr_top.cpp | R window_fn_top.h £ e
ae S Test parameters

S51&define FLOAT_DATA // Used to select error tolerance in test p
52 gdefine WIN_TYPE xhls_window_fm::HANN
51 #define WIN LEN 32
54
55 // Define floating polnt types for input, output and window co
S0 typedef float win fn in t;
57 typedef float win_fn_out_t;
58 typedef float win_fn_coef_L;
58 // Tep level function prototype - wraps all object, method and
6l void window_fn_top(win_fn_out_t outdata[WIN_LEN], win_fn_in_t |
G2 =
63 Mendif // WINDOW_FN_TOP_H_

4 11}

Figure 5-5:  Type Definitions for C Validation Lab 3

This design uses standard C/C++ floating-point types for all data operations. Vivado

High-Level Synthesis can synthesize floating-point types directly into hardware, provided
the operations are standard arithmetic operations (+, -, *, %).

When using math functions from math.h or cmath.h, see the Vivado Design Suite User

Guide: High-Level Synthesis (UG902) [Ref 2] for details on which math functions are
supported for synthesis.
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4. Click the Run C Simulation toolbar button to open the C Simulation Dialog box.

5. Accept the default setting (no options selected) and click OK.

The Console pane shows that the design simulates with the expected results.

Step 3: Synthesize the Design and Review Results

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, the synthesis report opens automatically. Figure 5-6 shows the
synthesis report.

=0 Synthesis(solutionl) &2 = 5

Performance Estimates -
- Timing (ns)
= Summary

Clock Target Estimated Uncertainty
ap_clk 5.00 3.75 0.63

- Latency (clock cycles)
= Summary
Latency Interval

min max min max  Type
257 257 258 258 none

m

= Detail
+ Instance

+ Loop

Utilization Estimates

= Summary
Name BRAM_18K DSP48E FF LuT
DSP - - -
Expression - - 0 9
FIFO - - -
Instance - 3 151 148
Memaory 1 - 0 0
Multiplexer - - - 10
Register - - 123
Total 1 3 274 167
Available 650 600 202800 101400
Utilization (%) ~0 ~0 =0 ~0 =
< il 3

Figure 5-6: Synthesis Report for Floating Point Design

Instances in the top-level design account for most of the area used.
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2. Scroll down the report and expand the Instances in the Details section of the Utilization
Estimates (Figure 5-7).

&l Synthesis(solutionl) 2 = 0
Utilization Estimates i
- Summary
Name BRAM_1BK  DSP48E FF LT
DSP
Expression - - 0 9
FIFO
Instance - 3 151 148
Memary 1 - 0 0
Multiplexer - - - 10
Register - - 123
Total 1 3 m 6 3
Available 650 600 202800 101400
Utilization (%) ~0 ~0 ~0 ~0
- Detail
= Instance
Instance Module BRAM_18K DSP48E FF LUT
window_fn_top_fmul_32ns_32ns_32_5_max_dsp U0 window_fn_top_fmul_32ns_32ns_32_5_max_dsp 0 3 151 148
Total 1 0 3 151 148
# DSP48
¥ Memary o

Figure 5-7: Area Details for Floating Point Design

The details show this is a floating-point multiplier (fmul). Floating-point operations are
costly in terms of area and clock cycles. The Analysis perspective (Figure 5-8) shows this
operator is also responsible for most of the clock cycles (It takes five of the eight states to
execute the logic created by loop wi nf n).

More details on using the Analysis perspective are available in the Chapter 6, Design
Analysis tutorial. For the purposes of understanding this design, two of the operations in
the first state are two-cycle read-from-memory operations, and the operation in the final
state is a write-to-memory operation.
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o Wreacdo HLS - windiow fn pe] 104 Vivado LS, TutorlafArbitrary Precision fabT\wndow i ol

Filg Bl Proseit Sokdfos Window Help
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|
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| weingiow_in_top_communi 3 Perlpireance
Currant Module : windew fm ton

OnocatioodConbool S..L_C0 1L 2 3 4 (5 | Ch 1 (7

® Pararmanes Profls Resticnarct Piotis

“ Sh

: ] 0 IS
W Memcrien(ll 1 LI I :

Figure 5-8: Performance Details for Floating Point Design

3. Exit the Vivado HLS GUI and return to the command prompt.

Lab 2: Arbitrary Precision

Review a Design using Arbitrary Precision types.

Introduction

This lab exercise uses the same design as Lab 1, however, the data types are now arbitrary
precision types. You first review the design and then examine the synthesis results.

Step 1: Create and Simulate the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the lab2 directory as
shown in Figure 5-9.

2. Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.

S\Uivado_HLS_Tuteorialrcd Arbitrary_Precision’labl

SUivade _HLS _TutorialhArbitrary_Precision’labl>cd

C:\Uivado HLS Tuterial‘\Arbitrary_Precisionrcd lab2

SUivado_HLS_TuterialhArbitrary_Precisionhlab2ivivade_hls =f run_hls. tcl

Figure 5-9: Setup for Interface Synthesis Lab 2
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3. Open the Vivado HLS GUI project by typing vivado _hls -p window_fn prj.

4. Open the Source folder in the Explorer pane and double-click window_fn_top.cpp to
open the code as shown in Figure 5-10.

&) Explorer &= S0 L window_ fn_top.cpp ]
H’WI'HJ{JW_'H_F'T] 2, T T 1 0 0 -
& Includes A5 #include "window_fn_top.h™ // Provides typedets and params
o Source 46

A7 ff Include the entire xhls_window_fn namespace so that scope resolution -
A48 /4 1.e. prepending xhls_window_fn:: to everything is not necessary
4% using namespace xhls window_fn;

o

= window_fn_top.cpp
i Test Bench
7= solutioni
# constraints 51/ /MVWivado HLS requires a top-level function definition that wraps all obje
o directives.tcl 52/ instantiations and method calls to be synthesized as well as mapping
[/ the top-level I/0 (function arpuments) intofout of the methads/function

wd Bk

o scripticl 3

& ceirn S4void window _fn_top( =

= build 55 win +n out t owtdata|WIN LEN],
) 56 win_fn_in_t indata[WIN_LEN]}
= repart 57{
58 ff Instantiate a window_fn object - types and params defined in header -

Figure 5-10: C Code for Arbitrary Precision Lab 2

5. Hold the Control key down and click window_fn_top.h on line 45 to open this header
file.

6. Scroll down to view the type definitions (Figure 5-11).

[¢ window_fn_top.cpp T window_fn_top.h 22 =0

54 // Types and top-level function prototype -
55#include <ap_int.h>

56 // Define widths of fixed point fields

57 #define W_IN 8

58 #define IW_TN 8

590 #define W_OUT 24

60 #define IW OUT B8

61 #define W_COEF 18

62 #define IW_COEF 2

63
64 // Define fixed point types for input, output and coefficients i
65 typedef ap_fixed<W IN,IW_IN> win_fn_in_t; ‘:‘

66 typedef ap_fixed<W OUT,IW OUT> win_fn_out_t;
67 typedef ap_fixed<W COEF,IW_COEF> win_fn_coef t;
68 il

< | I | r

Figure 5-11: Type Definitions for Arbitrary Precision Lab 2

This header file, wi ndow_f n_t op. h, is the only file that is different from Lab 1. The data
types have been changed to ap_fixed point types, which are similar to float and double
types in that they support integer and fractional bit representations. These data types are
defined in the header file ap_f i xed. h. The definitions in the header file define sizes of
the data types:
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« The first term defines the total word length.
« The second term defines the number of integer bits.

«  The number of fractional bits is therefore the first term minus the second.

When you revise C code to use arbitrary precision types instead of standard C types, one of
the most common changes you must make is to reduce the size of the data types. In this
case, you change the design to use 8-bit, 24-bit, and 18-bit words instead of 32-bit float
types. This results in smaller operators, reduced area, and fewer clock cycles to complete.

Similar optimizations help when you change more common C types such as int, short, and
char. For example, changing a data type that only needs to be 18-bit from int (32-bit)
ensures that only a single DSP48 is required to perform any multiplications.

In both cases, you must confirm that the design still performs the correct operation and
that it does so with the required accuracy. The benefit of the arbitrary precision types
provided with Vivado High-Level Synthesis is that you can simulate the updated C code to
confirm its function and accuracy.

7. Open the Test Bench folder in the Explorer pane and double-click window_fn_test.cpp
to open the code.

8. Scroll down to see the view shown in Figure 5-12.

Explorer o window_fn_top.cpp | window_fn_toph o) window_fn_testcpp 12
i window_fr_prj window_fn_top(hw_result, testdata); -
s Includes

Check sult
cout << "Checking results against a tolerance of ® <& ABS ERR_THRESH << andl;
cout <« fixed <« setprecision(h);

Source

o winchow_fn_topepp

i Test Bench for {unsigned i = 8; i < WIN_LEMN; iss) {
o window_fn_test.cpp ¥ float abs_err = fleat{hw_result[i]) - sw_result[i];
= solution{ Wif WINDOW FHN_DEBUG
& constraints ; cout << "1 = 7 o4 1 €4 T\thw_result = 7 << hw_result[i];
o directives.tel ) cout << "\t sw_result = " << sw_result[i] << endl;
¥ seripuic] #andif
e if (fabs{abs_err) » ABS_ERR_THRESH) {
= cHm cout <¢ "Errar threshold exceeded: @ = ™ << i
build cout << " Expectad: " << sw_rasult[i];
= report cout ¢ " Got: T oo bw_result[i];
cout ¢ " Delta: " < abs_err <¢ endl;

err_cnt++;

}

H
cout << endl; =

Figure 5-12: Test Bench for Arbitrary Precision Lab 2

The test bench for this design contains code to check the accuracy of the results. The
expected results are still generated using float types. The result checking verifies that the
results are within a specified range of accuracy (in this case, within 0.001 of the expected
result).

This allows the updated design to be validated quickly and efficiently in C, with fast compile
and run times.

High-Level Synthesis N send Feedback 107
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=107

& XILINX

ALL PROGRAMMABLE-

Chapter 5: Arbitrary Precision Types

9. Click the Run C Simulation toolbar button to open the C Simulation dialog box.

10. Accept the default setting (no options selected) and click OK.

The Console pane shows the results of the C simulation. With the updated data types, the
results are no longer identical to the expected results. However, they are within tolerance.

B Consale

& Errors

L Warnings

= [

R latlSE

cterminated = window_In_pr.Debuog [CAC+ « Apphcation] CAVvado HLS TutonabArbitrary_ Precisiomlab2ywandow_In_prisolutionlesimybuold
32 swW_result - 12.00000

i

iy b e fbe s s e

24
95
26
27
28
29
EL
31

h_result
b result
h_result
hw_result
hw result
h_result
hw_result
hw result

lest Passed

5.7
19.754
14,222
9.3721
5.3926
2.4355
B.61426

sworesult = 25,7571
sw_result - 19.75413
sw_result = 1422175
sw result = 9.37258
sw_result = 5,3925%7
sw_result = 243585
sw result = B.61487

-

Figure 5-13: C Simulation Results for Fixed Point Types

Step 2: Synthesize the Design and Review Results

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, the synthesis report opens automatically. Figure 5-14 shows the

synthesis report.
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=l Synthesis(solutionl) 3
Performance Estimates

= Timing (ns)

=1 Summary

Clock  Target  Estimated Uncertainty

ap_clk 5.00 348

-I Latency (clock cycles)
=1 Summary

Latency Interval
min max min  max Type
129 129 130 130 none

=1 Detail
+ Instance

+ Loop

Utilization Estimates

- Summary

Name BRAM_18K  DSP48E
DSP - 1
Expression - -
FIFO - -
Instance - -
Memary 0 -
Multiplexer - -
Register - -
Total 0 1
Available 650 600
Utilization (%) 0 ~0

4 i

0.63

FF

17

23
40
202800
~0

Chapter 5: Arbitrary Precision Types

LUT

25
101400
~0

1

b

Figure 5-14: Synthesis Report for Fixed Point Design

Note that through use of arbitrary precision types, you have reduced both the latency and
the area (by 50% and 80% respectively), and the operations in the RTL hardware are no
larger than necessary. Since the total number of bits in the memory is now less than
1024-bit, it is now automatically implemented with LUTs and FFs rather than with a block

RAM.

2. Scroll down the report to the Interface summary (Figure 5-15).

Figure 5-15 shows the data ports are now 8-bit and 24-bit.
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el m'nda'n;r fn .rnp csynth.pt &}

Interface =
= Summary
RTL Ports Dir Biws Protocel Source Object CType
ap_clk in 1 ap_ctri_hs  window_fn_top  refurn value
ap_rsl m 1 ap_ctrl_hs  window _fn_lop  return value
ap_stan in 1 ap_ctri_hs window_fn_top  return value
ap_dones ot 1 ap_ctri_hs  window_fn_top  retumn value
ap_dle oul 1 ap_ctrd_hs  window_fn_lop  relum value
ap_ready out 1 ap_ctri_hs  window_fn_top  return value
outdata_V_addressll  out 5 ap_memaony outdata_V array
ouldata V_cel oul 1  ap_memony ouldata V array
outdata_V_weD out 1 ap_memory cutdata_V array
oatdata_v_do out M ap_memary outdata_V array =
mdata V_addresys] oul 3 ap_memoay mnclata V array 5
indata_V_cel out 1 ap_memory indata_V array
indata_V_gl in 8  ap_memary indata_\V array
4 {F]) 3

Figure 5-15:  Fixed Point Interface Summary

3. Exit the Vivado HLS GUI and return to the command prompt.

Conclusion

In this tutorial, you learned:

+ How to update the existing standard C types to Vivado High-Level Synthesis arbitrary
precision types.

« The advantages in terms of hardware performance and area of using bit accurate
data-types.
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Chapter 6

Design Analysis

Overview

The general design methodology for creating an RTL implementation from C, C++, or
SystemC includes the following tasks:

« Synthesizing the design.
« Reviewing the results of the initial implementation.

» Applying optimization directives to improve performance.

You can repeat the steps above until the required performance is achieved. Subsequently,
you can revisit the design to improve area.

A key part of this process is the analysis of the results. This tutorial explains how to use the
reports and the GUI Analysis perspective to analyze the design and determine which
optimizations to apply.

This tutorial consists of a single lab exercise that:
« Demonstrates the HLS interactive analysis feature.

« Takes you through one design from the initial implementation through six steps and
multiple optimizations to produce the final optimized design.

As demonstrated throughout the tutorial, performing these steps in a single project gives
you the ability to compare the different solutions.

Lab 1 Description

Synthesize and analyze a DCT design. Use the insights from the design analysis to apply
optimizations and judge the effectiveness of the optimization.
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Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory
Vivado_HLS Tut ori al \ Desi gn_Anal ysi s.

The sample designs used in the lab exercise is a 2-D DCT function. To highlight the design
analysis feature, your goal is to have this design operate with an interval of 125 or less. The
design should be able to process a new set of input data at least every 125 clock cycles.

Lab 1: Design Optimization

This exercise explains the basic operations of the GUI Analysis perspective and how you can
use it to drive design optimization.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or if it is on a Linux system, adjust the few pathnames
referenced to the location at which you placed the Vivado _HLS Tutorial directory.

Step 1: Create and Open the Project

1. Open the Vivado HLS Command Prompt.

- On Windows click Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 6-1).

o On Linux, open a new shell.

Vivado 20163

L Add Design Tooks or Devices 2006.3
e Manage Xilinx Licenses

$5 uninstan 20163

B Vivado 20163 Tel Shell

d - Wivado 20063

Systemn Generator
Vivado HLS
B Vivado HLS 20163 Command Promp

« | Vivado HLS 20163 -

4  Back

Figure 6-1: Vivado HLS Command Prompt
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2. Using the command prompt window (Figure 6-2), change the directory to the Design
Analysis tutorial, lab1l.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vi vado_hl s
-f run hls.tcl, as shown in Figure 6-2.

>:h\Wivado HLS _Tutorial\Arbitrary_Precisionrcd ..

WWivado_HLE _Tutorialrcd Design_Analysis

ZUivado_HLS _Tutorial\Design_Analysisrcd labl

AUivade HLS _Tuteriald\Design_Analysis’labl>vivade_hls -f run_hls. tel

Figure 6-2. Setup the Design Analysis Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado hls -p dct _prj as shown in Figure 6-3.

@I [HLS-18] Cleaning up the solution databasze.

BI [HLS-10] Setting target deuice to 'xcTRIGOtFbg434-1"

BI [$¥YN-281] Setting up clock “default’ with a periocd of Bns.
Compiling ../../../. . fdet_test cpp in debug mode
Compiling . Fo.f . fdet.ecpp in debug mode

Generating csim.exe
Test passed 1
BI [$IM-1] CSim done with 8 errors.
@I [LIC-181] Checked in feature [HLS]

C:\Wivado_HLS Tutorial‘\Design_Analysis\labl>vivade_hls -p det_prj
Figure 6-3: Open Design Analysis Project for Lab 1

Step 2: Review the Source Code and Create the Initial Design

1. Double-click the file det.cpp in the Source folder to open the source code for review.

This example uses a DCT function. Figure 6-4 shows an overview of this code.
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Hierarchy Loops Dataflow
RD_Loop Row: l
RD_Loop_Col:

}
}
Row_DCT_Loop:
DCT_Ourer_Loop:
D . v

Apose_Row_Outer_Loop:
¥pose Row Inner Loop:
H

}
Col_DCT_Loop:
DCT_Outer_Loop:
DCT _Inner_Loop:
}

¥pose Col Outer Loop:
Xpose_Col_Inner_Loop:
}

}
WR_Loop_Row:

WE_Loop_Col: Yy

- |

Figure 6-4: Overview of the DCT Design

« The left side of Figure 6-4 shows the code hierarchy.

. Design Analysis

o Top-level function dct has three sub-functions: read_data, dct_2d and write_data.

o Function dct_2d has a single sub-function dct_1d.
» The center of Figure 6-4 shows loops inside each of the functions.

« The right side of Figure 6-4 shows the how the data is processed throug
and loops.

o The read_data function executes, and the data is processed through
RD_Loop_Row, which has a sub-loop RD_Loop_Col.

o After the read_data function completes, function dct_2d executes.

h the functions

loop

o In function dct_2d, Row_DCT_Loop processes the data. Row_DCT_Loop has two

nested loops inside it: DCT_output_loop and DCT_inner_loop.

o DCT_inner_loop calls function dct_1d.

And so on, until the function write_data processes the data.

« Click the Run C Synthesis toolbar button to synthesize the design to RTL.
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Step 3: Review the Performance Using the Synthesis Report

When synthesis completes, the synthesis report opens automatically. Figure 6-5 shows the
performance section of the report.

J det_csynthapt &
Performance Estimates &
Timing {ns)
= Summary
Closck Target  Estimated  Uncertainty
default A 5.79 100
Latency (clock cycles)
= Summary -
Latency Interval
min - max  min max  Type
3959 3959 3960 3960 none
= Dwetail
= Instance
Latency Intenval
Ivstance Module min max  min max Type
grp_det_2d fu 152  det 2d 3668 166B 3668 3668  none
= Loop
Latency Iratsation Interval
Loop Mame min max Iteration Latency  achieved target Trip Count  Pipelined
- RD_Loop_Row 144 144 18 - - a na
+ RO Loop Col 16 15 2 3 o
-WF_Loop_Row 144 144 18 - - 3 no
+ WER_Loop_Col 16 16 2 a na

Figure 6-5: Report for Initial DCT Design
Figure 6-5 highlights the following information.

« The clock frequency of 8 ns has been met.
« The top-level design takes 3959 clock cycles to write all the outputs.

* You can apply new inputs after 3960 clock cycles. This is one clock cycle after the
output data has been written. This immediately reveals that the design is not pipelined,
but this fact is also noted in the report: t ype is set to none and not pipelined.

« The top level has a single instance, which has a latency and initiation interval of 3668.
- This block also has no pipelining and accounts for most of the clock cycles.

« Notice that the functions read_dat a and wri t e_dat a are not noted here as
instances of the top level.

- Figure 6-6 shows that, during synthesis, these blocks were automatically inlined
(the hierarchy was removed).
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o High-level synthesis might automatically inline small functions to improve the
quality of results (QoR). You can prevent this by adding the Inline directive with the
- of f option to any function being automatically inlined.

Bl Console &2 & @) Errors| & Wamnings Nl =)
Vivado HLS Console

Wl [MLI-LU)] JLOl Ll CUuE Lrans i uimaiivins ..

@1 [HL5-18] Checking synthesizability ...

41 [XFORM-602] Inlining function ‘write data” into “det” (det.cpp:13:

E@l [HL5-111] Elapsed time: 7,476 seconds; current memory usage: /8.6 MB.

@1 [HL5-18] Starting hardware synthesis ...

@I [HL5-18] Synthesizing 'det” ... -

L f] ¥

Figure 6-6: Automatic Optimization Reporting

« The loops in the read_data and write_data functions are therefore implemented at the
top level and are reported as loops in the top-level function (Figure 6-5).

« Each loop has a latency of 144 clock cycles. (Because the loops are not pipelined, there
is no initiation interval.)

« Using RD_Loop_Row as an example, you can see why the loop latency is 144.

o Sub-loop RD_Loop_Col has a latency of 2 cycles for each iteration of the loop
(iteration latency) and a tripcount of 8: 2 x 8 = 16 clock cycles total latency for the
loop.

o From RD_Loop_Row, it takes 1 clock to enter loop RD_Loop_Col and 1 clock cycle to
return to RD_Loop_Row. The iteration latency for RD_Loop_Row is therefore (1 + 16
+1) 18 clock cycles.

o RD_Loop_Row has a tripcount of 8 so the total loop latency is 8 x 18 = 144 clock
cycles.

« The total latency for the dct block is therefore:
o 144 clocks for RD_Loop_Row.
o Plus 3668 clock cycles for dct_2d.
o Plus 144 clock cycles for WR_Loop_Row.

o Plus a clock cycle to enter each block.

To review the details of the instantiated sub-blocks dct_2d and dct_1d, open their respective
reports from the syn/report folder under solutionl in the Explorer pane.

You can also use the design analysis perspective to review these details in a more interactive
manner.

Step 4: Review the Performance Using the Analysis Perspective

Invoke the Analysis perspective any time after synthesis completes.
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1. Click the Analysis perspective button (Figure 6-7) to begin interactive design analysis.

==
i Debug [ | Synthesis [& Analysis

Figure 6-7: Opening the Analysis Perspective

The Analysis perspective consists of five panes, each of which is highlighted in Figure 6-8.
You use all of these in the tutorial. The module and loops hierarchies are shown expanded
(by default, they are shown collapsed).

Figure 6-8:  Overview of the Analysis Perspective

Use the Module Hierarchy pane to navigate through the hierarchy. The Module Hierarchy
pane shows both the performance and area information for the entire design. The
Performance Profile pane shows the performance details for this level of hierarchy. The
information in these two panes is similar to the information you reviewed earlier in the
report (for the top-level dct block).
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The Performance view is also shown (on the right side of Figure 6-9). This view shows how
the operations in this particular block are scheduled into clock cycles.

« The left column lists the resources.
- Sub-blocks are green.
- Operations resulting from loops in the source code are yellow.
- Standard operations are purple.

* Notice that the dct has three main resources:

- Aloop called RD_Loop_Row. The plus symbol (+) indicates that the loop has
hierarchy and that you can expand the loop to view it.

- A sub-block called dct_2d.
- Aloop called WR_Loop_Row.

The top row lists the control states in the design. Control states are the internal states
High-Level Synthesis uses to schedule operations into clock cycles. There is a close
correlation between the control states and the final states in the RTL Finite State Machine
(FSM), but there is no one-to-one mapping.

2. Click loop RD_Loop_Row and sub-loop RD_Loop_Col to fully expand the loop hierarchy
(Figure 6-9).

= Performance(solutionl) &2
current Module : det

lonemationyContral S| co | c1 | c2 | c3 [ ca | ¢5 |
RD Loop Row
r i(phi mux)
exitcondl i(icmp)
r(+)
=RD Loop Col
¢ i(phi mux)
exitcond i(icmp)
c(+)
tmp 5 i(+)
10 input leoad(read)
11 p addrl (+)
12 node 41 (write)
13 | det det 2d(func..
1... ¥WR Loop Bow

Ul LN o R R - TS

Performance | Resource
Figure 6-9: Expanded View of RD_Loop_Row

From this, you can see that in the first state (C1) of the RD_Loop_Row, the loop exit
condition is checked and an add operation performed. This addition is likely the counter for
the loop iterations, and we can confirm this.

3. Select the adder in state C1, right-click and select Go to Source (Figure 6-10).
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a. When the dialog box opens, press OK to select item O.

This opens the C source code to highlight the operation in the C source that created this
adder. From the details on screen (also shown in Figure 6-10), you can determine it is
indeed the loop counter. It is the only addition on this line, and the variable is named “r".

&' Performance(solutionl) 2

Current Mcocdule : dct

| Oneration\Contral S...| co | | c2 |l 3 | ca | c5 |
1 EFRD Loop Row
2 r i(phi mux)
3 exitcondl i(icmp)
r (+) _—
-IRD Loop Col

¢ i(phi mux)

exitcond i (icmp)

c(+)

tmp 5 i(+)

input load(read)

p addrl (+)

node 41 (write)
13 | dect dect 2d(func...
1... ®WR Loop Row

=
Do Bwoe N W

Performance | Resource

[ Properties | [< C Source 2

File: CA\Vivado_HLS_Tutorial\Design_Analysis\labl\dct.cpp
98 void read_data(short input[N], short buf[DCT_SIZE][DCT_SIZE]) -
894

100 intr, c;

101

102 RD_Loop Row:

103 for(r=0;r < DCT _SIZE; r++) {

104 RD_Loop_Col:

105 for (c =0; ¢c < DCT_SIZE; c++)

106 buf[r][c] = input[r * DCT_SIZE + c];
107 }

108}

109

110 void write_data(short buf[DCT_SIZE][DCT_SIZE], short output[N]) =
4 11} 3

11

Figure 6-10: C Source Code View

In the next state of loop RD_Loop_Row (state C2), loop RD_Loop_Col starts to execute.

4. Click any of the operations in the RD_Loop_Col to see the source code highlighting
update.
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This should help confirm your understanding of how the operations in the C source code
are implemented in the RTL.

« The loop exit condition is checked.
« This is an adder for loop count variable “c”.

« Aread from a RAM performed (one cycle to generate the address, one cycle to read the
data).

« A write operation is performed to a RAM.

Loops in the Performance view mean that the design iterates around these states multiple
times. The number of iterations is noted as the loop tripcount and shown in the
Performance Profile.

To improve performance, these loops should be pipelined. You can review the rest of the
design for other performance optimization opportunities.

5. Click the X in the C Source pane tab to close this window.

6. In the Module Hierarchy pane, click the function dct_2d to navigate into the view for
this function (Figure 6-11).

Figure 6-11: DCT_2D Performance View
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Again, you can see a number of loops (shown in yellow in Figure 6-12). Loops ensure the
design will have small area but the design will take multiple iterative states to complete:
each iteration of the loop will complete before the next iteration starts.

You can pipeline the loops to improve the performance. The details in the Performance
Profile show that most of the latency is caused by loops Row_DCT_Loop and Col_DCT_Loop.

7. Click loops Row_DCT_Loop and Col_DCT_Loop in the performance viewer to fully
expand them, as shown in Figure 6-12.

Expanding these loops in Performance view shows both loops call function dct_dct_1d2.
Unless this function itself is pipelined, there is no benefit in pipelining the loop. TheModule
Hierarchy shows the interval for dct_1d is 210 clock cycles, which means it can only accept
a new input every 210 clock cycles.

8. In the Module Hierarchy, click function dct_1d2 to navigate into the view for this
function.

9. Expand the loops in the Performance Profile and Performance view to see the view
shown in Figure 6-12.
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4 Vivado HLS - det_pr (C'\Users\viswanad\Documents\\Vivado_UG\ug871-design-fles\Design Analysis\fabl\det )
File Edit Project Solution Window  Help

@R 1FEXQ
F Module Herachy

BRAM DSP FF LUT Latency Intenal Pipeline type

4ot 51 7833 N9 %60 none
dodtd 3 1 926 68 3668 nane
oddla2 0 1 WL A9 29 none

£ Performance Proffe £\ - Resource Profile

Pipelined Latency Initation Interval Iteration Latency - Trip count
40 et 1d) - 00
0 DCT Outer Loop no m - i} §

Figure 6-12:

BEIR

4 Detug Sy

=0

i dctcpp 2] Synthesistsolutionl) = Performancelsoluiond) £

Current Module : det > det 2d > det 142

‘Onnraﬂnn\tnnrrn\ S.

alololalal

1 tmp 61 read(read)
2 tmp 6 read(read)
3 EDCT Juter Loop
4 k(phi mux)

5 tup(icup)

6 k1

7 tmp 16(3)

§ EICT Inner Loop
9 n(phi mx)

10 tmpd (phi mix)
11 tp 1 (icup)
. nif)

13 tmp 19()

14 twp 20()

15 det coeff tab...
16 src load(read)
7 mhp

18 tm 1)

19 tmp 12(1)

20 node 57(write)

Performance Resource

T Propeties 2 . & Wamings
Property

ER)

d o0

Value

DCT_1D Performance View

In Figure 6-12 you can see a series of nested loops that can be pipelined.

You can choose to do one of the following:
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« You can pipeline the function and then pipeline the loop that calls it. (Because the
function is pipelined, the loop can take advantage of using a pipelined part.)

» You can pipeline the loops within this function and simply make this function execute
faster.

Pipelining the function unrolls all the loops within it, and thus greatly increases the area. If
the objective is to get the highest possible performance with no regard for area, this may be
the best optimization to perform.

You can find more details on pipelining loops and functions in the Chapter 7, Design
Optimization tutorial. For this case, the approach is to optimize the loops and keep the area
at a minimum.

10. Click the Synthesis perspective button to return to the main synthesis view.

=N EoE =
#% Debug || | Synthesis |6 Analysis

Qutline 2 &4 Directive S

Figure 6-13: Re-Opening the Synthesis Perspective

Step 5: Apply Loop Pipelining and Review for Loop Optimization
In this step, you create a new solution and add pipelining directives to the loops.

When pipelining nested loops, it is generally best to pipeline the inner-most loop. Typically,
High-Level Synthesis can generally flatten the loop nest automatically (allowing the outer
loop to simply feed the inner loop). For more information on why it is better to perform
certain loop optimizations rather than others, see the Chapter 7, Design Optimization
tutorial.

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution.

2. Click Finish and accept the defaults.

3. Ensure that you can see the C source code in the Information pane.

4. Inthe Directive tab, add a pipeline directive to loop DCT_Inner_Loop in function dct_1d.
a. Right-click DCT_Inner_Loop in the Directive pane and select Insert Directive.

b. Inthe Directives Editor dialog box activate the Directive drop-down menu at the top
and select PIPELINE.

c. Click OK to select the default maximum pipeline rate (II=1).
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5. Repeat step 4 for the following loops:
a. Infunction dct_2d loop Xpose_Row_I nner _Loop
b. Infunction dct_2d loop Xpose_Col _I nner _Loop
c. Infunction read_data loop RD_Loop_Col
d. Infunction wite_dataloopWR_Loop_Col

The Directive pane shows the following (highlighted) optimization directives applied.

gt Outline | (14 Directive 2
4 @ det_1d -
[ det_coell_table
a5 DET_Cuter_Loop
45 DCT_Inner_Locp
% HLS PIPELINE
« % det_2d
L1 ronwy_owtbud
Hl col_outhuf
=11 col_inbuf
T Row DCT_Loop
a5 Xpose Row_ Outer_Loop
45 Xpose Row_Inner_Loop
% HLS PIPELINE
5 Col_DCT_Loop
4% ¥pose_Col_Outer_Loop
44" Xpose Col_Inner_Loop
%% HLS PIPELINE
4 @ read_data
4" RD_Loop_Row
4 5 RD_Loop_Col
% HLS PIPELINE
4 B write_data
5 WR_Loop_Row
445 WER_Loop_Col
%% HLS PIPELINE
4 0 det bl

Figure 6-14: Optimization Directive for DCT Loop Pipelines

6. Click the Run C Synthesis toolbar button to synthesize the design to RTL. If a file was
modified, please select YES.

7. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 1 and 2.

Figure 6-15 shows the results of comparing solutionl and solution2. Pipelining the loops
has improved the latency of the design with an almost 50% reduction in solution2.
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Performance Estimates

= Timing (ns)
Clock solutionl  solution2
ap_clk Target 8.00 8.00
Estimated 5.79 5.79

-l Latency (clock cycles)

solutionl  solution?

Latency min 3959 1787
max 3959 1787
Interval min 3960 1788
max 3960 1788

Figure 6-15: DCT Solutionl and Solution2 Comparison

Next, you once again open the Analysis perspective, analyze the results, and determine
whether or not there are more opportunities to for optimization.

8. Click the Analysis perspective button to begin interactive design analysis.

When the Analysis perspective opens, you can see that the majority of the latency is still
due to block dct_2d. Before proceeding to analyze further, you can review how the loops at
this level have been optimized.

The Performance Profile (Figure 6-16) shows that the latency of both loops has been
reduced from 144 clock cycles in solutionl to only 64 clock cycles.

£F Performance Profile 2 . | . Resource Profile

Pipelined Latency Initiation Interval Iteration Latency Trip count

4 ® dct - 1787 1788 - -
@ RD_Loop_Row_RD_Loop_Col vyes 64 1 2 64
e WE_Loop_Row_WR_Loop_Col yes b4 1 64

Figure 6-16: DCT Solution2 Performance of Top-Level Loops

Pipelining loops transforms the latency from
Latency = iteration latency * (tripcount * interval)
to

Latency = iteration latency + (tripcount * interval)

High-Level Synthesis N send Feedback 125
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—]



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=125

& XILINX

ALL PROGRAMMABLE-~

Chapter 6: Design Analysis

High-Level Synthesis
UG871 (v2016.4) November 30, 2016

Vivado HLS also made this possible by automatically performing loop flattening (there is no
longer any loop hierarchy). You can see this by reviewing the Console pane, or log file, for
solution2. Figure 6-17 shows the loops that have been automatically optimized.

B Console & & 9 Errors| & Warnings 7

Vivado HLS Console
o g e wam

S St P e —————— T

[ ] g function wrlte_data into dct
1 [XFORM-541] Flattening a loop nest 'RD _Loop Row' (det.cpp:59) in function ‘det’.
T [XFORM-5417 Flattening a loop nest "WR Loop Row' (det.cpp:71) in function 'det'.
I [XFORM-541] Flattenlng a leoop nest "Xpose_ Row Outer_Loop® (det.cpp:37) in function "det_2d°.
nest "Xpose Col Outer Loop' (det.cpp:43) in function 'det 2d'.
hi [HL5-111] Elapsed 't"n‘msl 12.191 seconds; current memory usape: 39.6 MB.

@I [HL5-18] 5tarting hardware synthesis ...

EAT TH 5. 181 Swnthecizine "det "
L I ¥

Figure 6-17: DCT Solution2 Loop Flattening

9. In the Module Hierarchy, click functi on dct_2d to navigate into the view for this
function.

In the Performance Profile you can see that the latency of all the loops has been
substantially reduced (Row_DCT_Loop and Col_DCT_loop have been approximately halved
from the earlier report in Figure 6-11). However, the majority of the latency is still due to
these two loops, each of which calls the dct_1b block.

10.In the Module Hierarchy, click functi on dct _1d to navigate into the view for this

function.

The Performance Profile (Figure 6-18) shows the loop latencies have been reduced, but
there is still a loop hierarchy here. (There is still loop DCT_Outer_Loop, shown in
Figure 6-18, so no loop flattening occurred).

EF Performance Profile 2 . | . Resource Proﬁle} = = O
Pipelined Latency InitiationInterval Iteration Latency Trip count
4 @ dct_dct_1d2 - 97 97 - -
4 o DCT_Outer_Loop no 96 - 12 8
@ DCT_Inner_Loop yes 9 1 3 8
Figure 6-18: DCT Solution2 Performance of dct_1d Loops

Viewing these loops in Performance view shows why this loop was not optimized further.

11.In the Performance view, click loops DCT_Qut er _Loop and DCT_I nner _Loop to view

the loop hierarchy (Figure 6-19).
12. Select the write operation in state C3.

13. Right-click and select Go to Source.
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Figure 6-19 shows that this loop was not flattened because additional operations outside of
DCT_I nner _Loop, at the level of DCT_Qut er _Loop, prevented loop flattening. One of the
operations that prevented loop flattening is highlighted in Figure 6-19, below.

= Performance(solution2) &2 = B

Current Medule : dct > dct dect 2d > det det 1d2

| Oneration\Contral 5.1 co | c1 | o2 | | ca |
tmp 21 read(read)

tmp 2 read(read)
s DCT Outer Loop
k(phi mux)
exitcondl (icmp)
k 1(+)
tmp 5(+)
8-...| ¥DCT Inner Loop
19 tmp s (+)

node 60 (write) M

Performance | Resource

RN Rl R, ER RS R S R

[ Properties | [<| C Source 2 = 8

File: CA\Vivado_HLS_Tutorial\Design_Analysis\labl\dct.cpp
55 ).
56 DCT_OQuter_Loop:
57 for (k =0; k< DCT_SIZE; k++) {
58 DCT_Inner_Loop:
59 for(n =0, tmp = 0; n < DCT_SIZE; n++) {
60 int coeff = (int)dct_coeff_table[k][n];
61 tmp += src[n] * coeff;
62 3
63 dst[k] = DESCALE(tmp, CONST_BITS);
64 }
65}
66
67 void dct_2d(dct data tin_block[DCT_SIZE])DCT_SIZE],
68 dct data_t out_block[DCT_SIZEJ[DCT_SIZE])
694
70 dct_data_t row_outbuf[DCT_SIZE]DCT_SIZE];

71 dct data t col outbuf[DCT SIZENDCT SIZE], col inbuf[DCT SIZE] ™
< 1 b

111

Figure 6-19: DCT Solution2 dct_1d Performance View

The write to the array cannot be flattened into the inner loop. To achieve an interval of 1 on
DCT Quter Loop you will need to pipeline the output loop - there is no benefit in simply
pipelining the inner loop itself.

You should pipeline the outer loop instead. This causes the inner loop to be completely
unrolled. An increase in area results, but you are still far from the throughput goal of 125
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and not yet ready to pipeline the entire function (and see an even greater area increase, as
the outer loop is also completely unrolled).

14. Click the Synthesis perspective button to return to the main synthesis view.

Step 6: Apply Loop Optimization and Review for Bottlenecks

1.

Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution.

Click Finish and accept the defaults to create solution3.

Ensure the C source code is visible in the Information pane.

In the Directive tab

a.
b.

C.

f.

In function dct_1d, select the pipeline directive on loop DCT_Inner_Loop.
Right-Click and select Remove Directive.

Still in function dct_1d, select loop DCT_Outer_Loop.

Right-click and select Insert Directive.

In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

Click OK to select the default maximum pipeline rate (II=1).

The Directive pane should show the following (highlighted) optimization directives applied.
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= Outline | 4 Directive & D
4 @ det_ld =
=[1 det_coeff_table
a 5 DCT_Outer_Loop
% HLS PIPELINE
¢ DCT_Inner_Loop
4 @ gt 2d
H[l row_outhuf
=1 col_outbuf
L1 gl _inbuf
5 Row_DCT_Loop
a ' Npose_Row_Outer_Loop
4 5" ¥pose Row_Inner_Loop
%% HLS PIPELINE
F ol DCT_Loop
4 5 ¥pose Col_Outer_Loop
4 3 Xpose_Col_Inner_Loop
b HLS PIPELINE
4 o read_data
4 %' RD_Loop_Row
4 5" RD _Loop Col
%% HLS PIPELINE
4 @ write_data
a ' WR_Loop_Row
4 = WR_Loop_Cal
% HLS PIPELINE
a @ dct i

Figure 6-20: Updated Optimization Directives for DCT Loop Pipelines
5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, click the Compare Reports toolbar button to compare
solutions 2 and 3.

Figure 6-21 shows the results of comparing solution2 and solution3. Pipelining the
outer-loop has in fact resulted in an increase to the performance and the area.

The significant latency benefit is achieved because multiple loops in the design call the
dct_1d function multiple times. Saving latency in this block is multiplied because this
function is used inside many loops.
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= Timing (ns)
Clock solution?2  solution3
ap_clk Target 8.00 8.00
Estimated 5.79 8.74

-1 Latency (clock cycles)

solutionZ2  solution3

Latency min 1787 811
max 1787 811
Interval min 1788 812
max 1788 812

Utilization Estimates

solution2  solution3

BRAM_18K 5 5
DSP48E 1 8
FF 248 670
LUT 561 636

Figure 6-21: DCT Solution2 and Solution3 Comparison

In this case, the report indicates the clock period for solution3 cannot be achieved. Vivado
HLS will sometimes create a design in which the estimated clock period fails to meet the
required clock period. Typically, the design will meet timing after RTL synthesis - in this
case, you can confirm this by using the Export RTL feature and selecting Evaluate. In the
event you encounter a case where the design fails to meet timing after RTL synthesis, use
LATENCY directive in conjunction with regions in the C code to force Vivado HLS to register
intermediate points on the failing RTL path.

Now that all the loops are pipelined, it is worthwhile to review the design to see if there are
performance-limiting "bottlenecks.” Bottlenecks are limitations in the flow of data that can
prevent the logic blocks from working at their maximum data rate.

Such limitations in the data flow can come from a number of sources, for example, I/O ports
and arrays implemented as block RAM. In both cases, the finite number of ports (on the I/O
or block RAM) limits the rate at which data can be read or written.

Another source of bottlenecks is data dependencies in the original source code. In some
cases, these data dependencies are inherent in how the algorithm operates, as when a
calculation cannot be performed until an earlier calculation has completed. Sometimes,
however, the use of an optimization directive or a minor change to the C code can remove
them.
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The first task is to identify such issues in the RTL design. There are a number of approaches
you can take:

« Start with the largest latency of interval in the Module Hierarchy report and navigate
down the hierarchy to find the source of any large latency or interval.

7. Click the Resource Profile to examine I/O and memory usage.

8. Use the power of the graphical viewer and look for patterns in the Performance view
which indicate a limitation in data flow.

In this case, you will use the latter approach. You can use the Analysis perspective to
identify such places in the design quickly.

9. Click the Analysis perspective button to begin interactive design analysis.
10. In the Module Hierarchy, ensure module dct is selected.

11.In the Performance view, expand the first loop in the design as shown in Figure 6-22,
RD_Loop_Row_RD Loop_Col (these loops were flattened and the name is now a
concatenation of both loops).

This loop is implemented in two states. The red arrow in Figure 6-22 shows the path from
the start of the loop to the end of the loop: the arrow is almost vertical (everything happens
in two clock cycles) and this loop is well implemented in terms of latency.

— Performance - dct = S

Current Module : dect

Oneration\Cantral S cn e L Y 7 C3 o C5
1 EHRD Loop Row RD ... l |
2 indvar flatten...
3 r i(phi mux) I I
4 ¢ i(phi mux) | I
5 exitcond flatt...
3] indvar flatten... | I
7 exitcond i(icmp) | |
8 c i mid2(select) I I
9 r{+)
10 r i mid2(select) I I
11  tmp 5 i(#) | |
12 input load(read) I
13 c(+) ]
14 p addrl(+) I |
15 node 47 (write) l. I
16  dct Zd(function) ERksl —
1... #WE Loop Row WR ...

Performance  Resource

Figure 6-22: Analysis of DCT RD_Loop_Row
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12.1In the Performance view, expand the WR_Loop Row and perform similar analysis. It is
similarly well optimized for latency.

13. Double-click function dct _2d and navigate into the dct _2d function.

You can use same analysis process down through the hierarchy. If you perform this analysis
you will discover that all the function blocks and loops have a similar optimal (few cycles)
implementation, until the dct_1d block is examined.

14.In the Performance view, double-click function dct _1d and navigate into the dct _1d
function.

15. Expand the DCT_CQut er _Loop to see the view shown in Figure 6-23.

Figure 6-23 shows a very different view from the earlier loop schedules (which had only a
few cycles of latency). The schedule shows a long drift from input to output (as shown by
the red arrow).

Figure 6-23 shows the analysis of dct _1d RD_Loop_Row.
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o T S e B S o J L i B 0 ] S i (i o i B 7 |

Lo LR Wk

tmp 21 read(read)
tmp 2 read(read)
tmp 10(()

tmp 12(])

tmp 14(])

tmp 16(1)

tmp 18(1)

tmp 20(])

tmp 23(])

10 EDCT Outer Loop

k{phi mux)
exitcondl (icmp)
k 1(+)

tmp 25 (+)

det coeff tabl...

src load 1(read)

dct coeff tabl...

src load 3 (read)

det coeff tabl oo

src load(read)

dct coeff tabl...
det coeff tabl...
dct coeff tabl...

src load 5(read)

det coeff tabl...
det coeff tabl...

tmp 10 1(*)

src load 2(read)
tmp 10 3(*)

src load 4 (read)
tmp 3(*)

tmp: 10 5(*)

src load 6(read)
src load 7 (read)
tmp2 (+)

tmp 10 2 (%)

tmp 10 4(*)

tmp3 (+)

tmpl (+)

tmp5 (+)

tmp 10 6(*)

tmp 10 7 (*)

tmp? (+)

tmp6 (+)

tmpd (+)

tmp s (+)

node 114 (write)

.
| Performance | Resource

Figure 6-23: Analysis of dct_1d RD_Loop_Row

There are typically two things that cause this type of schedule: data dependencies in the
source code and limitations due to I/O or block RAM. You will now examine the resources
sharing in this block.

16.In the Performance view, click the Resource tab at the bottom of the window.
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17. Expand the Memory Ports, as shown in Figure 6-24.

= Resource(solution3) 2

Current Module

: det > det det 2d > det det 1d2

Chapter 6: Design Analysis
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|Resource\Control Sten| €0 c1 |l c2 | 3 | s | ca | c7 |
1 EI/0 Ports
2 tmp 21 read
3 tmp 2 read
4 src (p0) read read read read
5 src(pl) read read read read
6 dst (p0) write
7 EMemory Ports
8 dct coeff tabl... read
9 dct coeff tabl... read
10 src(pl) read read read read
11 src (p0) read read read read
12 dct coeff tabl... read
13 dct coeff tabl... read
14 dct coeff tabl... read
15 dct coeff tabl... read
16 dct coeff tabl... read
17 dct coeff tabl... read
18 dst (p0) write
1... ¥ExXpressions

Performance | Resource

Figure 6-24: Resource Sharing of Memory Ports in DCT_1d

The Resource view shows how the resources in the design are used in different control
states.

The rows list the resources in the design. In Figure 6-24, the memory resources are
expanded.

The columns show the control states in which the resource is used. If a resource is active in
multiple states, the resource is being re-used in different clock cycles.

Figure 6-24 shows the memory accesses on block RAM sr ¢ are being used to the maximum
in every clock cycle. (At most, a block RAM can be dual-port and both ports are being used).
This is a good indication the design may be bandwidth-limited by the memory resource. To
determine if this really is the case, you can examine further.

18. Select one of the read operations for the sr ¢ block RAM.

19. Right-click and select Goto Source to see the view shown in Figure 6-25.
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& Resource(solution3) 2 = 0
Current Module : dct > det det 24 > det det 1d2
|Resource\Contral Sten| co | |l c2 l cal cal s |l co | c7 -
1 EI/0 Ports
2 tmp 21 read
3 tmp 2 read
4 src (p0) read read read read
5 src(pl) read read read read
6 dst (p0) write
7 EMemory Ports
8 dct coeff tabl... read i
9 dct coeff tabl... read =
10 src(pl) read read read read
src (p0) read read read
12 dct coeff tabl... read
13 dct coeff tabl... read
14 dct coeff tabl... read
15 dct coeff tabl... read
16 dct coeff tabl... read
17 dct coeff tabl... read
18 dst (p0) write _
4 B . I b
Performance Resource
= 0

[ Properties | [¢] C Source 3

File: C\Vivado_HLS_Tutorial\Design_Analysis\labl\dct.cpp

56 DCT_Quter_Loop:

57 for (k = 0; k < DCT_SIZE; k++) {

58 DCT _Inner_Loop:

59 for(n =0, tmp = 0; n < DCT_SIZE; n++) {

60 int coeff = (int)dct_coeff_table[k][n];
61 tmp += src[n] * coeff;

62 1}

63 dst[k] = DESCALE(tmp, CONST_BITS);
64 }

65}

Figure 6-25:

m

Memory Resource SRC and Source Code

Figure 6-25 shows this read on the sr c variable is from the read operation inside loop
DCT_I nner _Loop. This loop was automatically unrolled when DCT_Qut er _Loop was
pipelined and all operations in this loop can occur in parallel (if data dependencies allow).

The eight reads are being forced to occur over multiple cycles because the array src is
implemented as a block RAM in the RTL and a block RAM can only allow two reads
(maximum) in any one clock cycle. In Figure 6-25, the read operations take 2 clocks cycles:
a cycle to generate the address for the block RAM and a cycle to read the data. Only the
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launch (address generation cycle) is shown because it overlaps with the operation in the
next clock cycle.

You can optimize the block RAM accesses using optimization directives to partition the
block RAM. The array that function dct _1d accesses is defined as an input argument to the
function and therefore resides outside this block.

« The input array to the first instance of dct _1d is buf _2d_i n in function dct.

« The input array to the second instance of dct _1d is col _i nbuf in function dct _2d.

In both cases, the arrays are 2-dimensional of size DCT_SIZE by DCT_SIZE (8x8). By default,
this results in a single block RAM with 64 elements. Because the arrays are configured in the
code in the form of Row by Column, we can partition the second dimension and create eight
separate Block RAMs: one for each row, allowing the row data to be accessed in parallel.

20. Click the Synthesis perspective button to return to the main synthesis view.

Step 7: Partition Block RAMs and Analyze Concurrency

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution4.

2. Click Finish and accept the defaults to create solution4.
3. Ensure the C source code is visible in the Information pane.
4. In the Directive tab:

a. In function dct, select array buf _2d_i n.

b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box, activate the Directive drop-down menu at the
top and select ARRAY_PARTITION.

d. Leave the type as Complete.

e. Change the dimension setting to 2 to partition the array along the second
dimension.

f. Click OK.

5. Repeat this process for array col _i nbuf in function dct _2d.

The Directive pane displays optimization directives, as shown in Figure 6-26 (the two new
directives are highlighted).
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@ do_ld
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Y DCT_Outer_Loop
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DT Inner_Loop
@ det_2d
=1 row_outbuf
1 col_outbul
#[] col_inbuf
9 HLS ARRAY PARTITION variable=col_inbuf complete dim=2
" Row DCT_Loop
i ¥pose_Row_Quter_Loop
i ¥pose_Row_Inner_Loop
U HLS PIPELINE
Y Col_DCT_Loop
¥ Xpose_Col_Outer_Loop
i Xpose Col_nner_Loop
% HLS PIPELINE
@ read_data
i RO Loop_Row
i RD_Loop_Col
% HLS PIPELIMNE
& wnle_data
! WR_Loop_Row
' WR_Loop_Col
U HLS PIPELINE
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=11 buf_2d_in
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=1 buf_2d_out
2 input
4 putput

Figure 6-26: Optimization Directives for Array Partitioning
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

7. When synthesis completes, use the Compare Reports toolbar button to compare
solutions 3 and 4.

Figure 6-27 shows the results of comparing solution3 and solution4. Improving access to
the data in the src block RAM in the dct_1d block has improved the overall performance
because the dct_1d block executes frequently.
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Performance Estimates

-1 Timing (ns)
Clock solution3  solutiond
ap_clk Target 8.00 8.00
Estimated 874 8.93

-1 Latency (clock cycles)

solution3  solutiond

Latency min @ 811 445
max 811 445
Interval min 812 446
max 812 446

Figure 6-27: DCT Solution3 and Solution4 Comparison

You can review the impact of the partitioning directive on the device resource.

8. Click the Analysis perspective button to begin interactive design analysis.
9. In the Module Hierarchy, ensure nodul e dect is selected.
10. Select the Resource Profile tab in the lower-left.

11. Expand the Memories and Expressions see the view in Figure 6-28.
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5] Module Hierarchy 7 B = B8
BRAM DSP FF LUT Latency Interval Pipeline type
4 ® dct 3 8 1237 661 445 446 none
+ @ dct_2d 2 8 917 479 310 310 none
e read_data O ] 28 54 66 66 none
EF Performance Profile || . Resource Profile &3 F = T 8
BRAM DSP  FF LUT Bits PO Bits P1 Bits P2 Banks/Depth Words W?*Bits*Banks
< @ dct 3 8 1237 661
» 52 IfO Ports(2) 32
- T2 Instances(2) 2 8 945 533
« B8 Memories(9) 1 256 16 144 9 128 2048
+ buf_2d_out U 1 o} o} 16 1 64 1024
4 buf_2d_in6_L O 32 2 1a 1 8 128
4+ buf_2d_in_5_L O 32 2 16 1 8 128
+ buf 2d_in.4 L O 32 2 16 1 8 128
+ buf_2d_in_3_L 0 32 2 1a 1 8 128
4+ buf 2d_in_7_L O 32 2 16 1 8 128
4+ buf 2d_in_.2 L O 32 2 16 1 8 128
4+ buf 2d_in_1.L 0O 32 2 16 1 8 128
4 buf 2d_in_0_L O 32 2 16 1 8 128
- 2. Expressions(9) 0 0 0 42 36 41 8
+ il Registers(11) 36 36
Channels(0) 0 0 0 0 0 0 0
- e Multiplexers(34) 0 0 70 70 0

Figure 6-28: DCT Resource Profile

The Resource Profile shows the resources being using at the current level of hierarchy (the
block selected in the Module Hierarchy pane). Figure 6-28 shows:

« This block has two I/O ports.
« Most of the area is due to instances (sub-blocks) within this block.

« There are nine memories, eight of which are the partitioned buf_2d_in block RAM. Since
they are less than 1024 bits they are automatically implemented as LUTRAM.

« Most of the logic (expressions) at this level of hierarchy is due to adders, with some due
to comparators and selectors.

The important point from the previous optimization is that you can see there are now
additional memories due to the array partitioning optimization.

You still have a goal to ensure that the design can accept a new set of samples every 125
clock cycles. Figure 6-28, however, shows that you can only accept new data every 525
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clocks. This is much better than the original, pre-optimized design (approx. 3700 clock
cycles), but further optimization is required.

Up to this point, you have focused on improving the latency and interval of each of the
individual loops and functions in the design. You must now apply the dataflow
optimization, which enables the individual loops and functions to execute in parallel, thus
improving the overall design interval.

12. Click the Synthesis perspective button to return to the main synthesis view.

Step 8: Partition Block RAMs and Apply Dataflow optimization

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, solution5.

2. Click Finish and accept the defaults to create solution5.
3. Ensure the C source code is visible in the Information pane.
4. In the Directive tab

a. Select the top-level function dect.

b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box activate the Directive drop-down menu and
select DATAFLOW.

d. Click OK.

The Directive pane now displays the following optimization directives (the new directive is
highlighted).
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Figure 6-29: Dataflow Optimization for the DCT Design
5. Click the Click the Run C Synthesis toolbar button to synthesize the design to RTL.

6. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 4 and 5.

Figure 6-30 shows the results of comparing solution4 and solution5, and you can see the
interval has improved. The design takes 525 clocks cycles to produce the outputs but can
now accept new inputs every 374 clocks.
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Performance Estimates

= Timing (ns)
Clock solutiond  solution5
ap_clk Target 8.00 8.00
Estimated 8.93 8.93

-l Latency (clock cycles)

solutiond  solution>

Latency min 445 444
max 445 444
Interval min 446 311
max 446 311

Figure 6-30: DCT Solution4 and Solution5 Comparison

This is still greater than the 125 cycles required, so you must analyze the current
performance.

7. Click the Analysis perspective button to begin interactive design analysis.

8. In the Module Hierarchy, you can see dct_dct_ 2d accounts for most of the interval.
Ensure module dct _2d is selected to see the view in Figure 6-31.

t7| Module Hierarchy
BEAM D5P FF LUT Latency Interval  Pipeline type

4 B det 4 ] 14059 654 444 311 dataflow
4 0 det_2d 2 a 918 479 310 310 none
@ det 1d 0 3 381 103 13 13 none
& write_data 0 o 32 62 bh Gk none
o read_data 0 0 28 M 66 66 none
£” Performance Profile 22 . |= Resource Profile
Pipelined  Latency  Imbation Interval  Rterabion Latency  Trip cownt
4w del_2d 310 310
& Row_DCT_Loop no 120 15 a
e Xpose_Row_Outer_Loop yes 32 4 5 B
& Col_DCT_Loop no 120 15 a
e Xpose_Col_ Outer_Loop  yes 32 4 5 B

Figure 6-31: DCT Analysis View after Dataflow Optimization

Here, you can see two things:

« The interval of the dct block is less than the sum of the individual latencies (for
read_dat a, dct _2d and wri t e_dat a). This means the blocks are operating in
parallel.
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« The interval of dct is the same as the interval for sub-block dct _2d. The dct _2d
block is therefore the limiting factor.

Because the dct _2d block is selected in the Module Hierarchy and the Performance Profile
shows the details for this block. Figure 6-32 shows the interval is the same as the latency, so
none of these blocks operate in parallel.

One way to have the blocks in dct _2d operate in parallel would be to pipeline the entire
function. This, however, would unroll all the loops, which can sometimes lead to a large area
increase. An alternative is use dataflow optimization on function dct _2d.

Another alternative is to use a less obvious technique: raise these loops up to the top-level
of hierarchy, where they will be included in the dataflow optimization already applied to the
top-level. This can be achieved by using an optimization directive to remove the dct _2d

hierarchy: inline the dct _2d function.

Before performing this optimization, review the area increase caused by using dataflow
optimization.

9. In the Module Hierarchy, ensure module dct is selected.

10. Activate the Resource Profile view.

11. Expand the memories to see the view in Figure 6-32.

s Module Hierarchy

< B dct

BERAM DSP FF

4

- @ dct_2d 2
@ write_data 0
@ read_data O

£° Performance Profile ||

- @ dct_2d
> 22t IO Ports(9)
- Te Instances{l)
- B8 Memories{10)

&

L AR B SE K K SE BE

&

row_outbuf_ U
col_outbuf U

col_inbuf_0_U
col_inbuf_1_U
col_inbuf_6_U
col_inbuf_7_U
col_inbuf_2_U
col_inbuf_3_U
col_inbuf_ 4 U
col_inbuf_5_U

- 2. Expressions{19)

» oed Registers(21)
Channels(0)

- @ Multiplexers(43)
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12. Click the Synthesis perspective button to return to the main synthesis view.

Step 9: Optimize the Hierarchy for Dataflow
Select the New Solution toolbar button to create a new solution, solution6.
Click Finish and accept the defaults to create solution6.

Ensure the C source code is visible in the Information pane.

> w N

In the Directive tab:
a. Select function dct _2d.
b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select INLINE.

d. Click OK.

The Directive pane now shows the following optimization directives (the new directive is
highlighted).
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8z Outline | (1% Directive & =
« @ det_1d
11 det_coetl_table
4 50 DT _Outer_Loop
% HLS PIPELINE
DT _Inner_Loop
. ® det_2d
% HLS INLINE
*[1 row_outbuf
W[l col_outhuf
=1 col_inbuf
U HLS ARRAY _PARTITION partition varable=col_inbuf complete dim=2
5" Row_DCT_Loop
% Mpose_Row_Outer_Loop
« 5" Mpose Row_Inner_Loop
%% HLS PIPELINE
% Col_DCT_Loop
H Mpose Col_Outer_Loop

4 5" ¥pose_Col_Inner_Loop
% HLS PIPELIMNE
« @ read_data
4 5" RD_Loop_Row
+ 5 RD_Loop_Col
Gh HLS PIPELINE
¢ mowrite_data
4 %" WR_Loop_Row
« 5" WR_Loop_Col
% HLS PIPELINE
¢ @ gt
U HLS DATAFLOW
{1 buf_2d_in
U HLS ARRAY_PARTITION partition variable -buf_2d_in complete dim=2
11 buf_2d_out
@ inpurt
# output

Figure 6-33: Dataflow Optimization for the DCT Design
5. Click the Run C Synthesis toolbar button to synthesizes the design to RTL.

6. When synthesis completes, use the Compare Reports toolbar button or the menu
Project > Compare Reports to compare solutions 5 and 6.

Figure 6-34 shows the results of comparing solution5 and solution6. You can see the
interval has improved substantially.
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=1 Timing (ns)
Clock
ap_clk Target

Estimated

-1 Latency (clock cycles)

Latency min
max
Interval  min
max

solution>  solutiond
8.00 8.00
8.93 8.93
solution>  solutioné
444 431
444 431
311 114
311 114

Chapter 6: Design Analysis

Figure 6-34: DCT Solution5 and Solution6 Comparison

The interval is now below the 125 clock target. This design can accept a new set of inputs

data every 106 clock cycles.

t=] Module Hierarchy

BRAM DSP FF
4§ dct 6 16 2355
@ lLoop_Row DCT_Loop_pr 0 8 601

@ Loop_Col DCT_Loop_pr 0O 8 601

@ loop_Xpose_Row_Outer 0 0 26

@ loop_Xpose_Col_Outer 0 ] 26

@ write_data 0 0 32

@ read_data ] ] 28

Figure 6-35:
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Conclusion

In this tutorial, you learned:

+ How to analyze a design using the analysis perspective.
* How to cross-link operations in the views with the C code.
« How to apply and judge optimizations.

« A methodology for taking the initial design results and creating an implementation
which satisfies the design goals.
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Chapter 7

Design Optimization

Overview

A crucial part of creating high quality RTL designs using High-Level Synthesis is having the
ability to apply optimizations to the C code. High-Level Synthesis always tries to minimize
the latency of loops and functions.To achieve this, within the loops and functions, it tries to
execute as many operations as possible in parallel. At the level of functions, High-Level
Synthesis always tries to execute functions in parallel.

In addition to these automatic optimizations, directives are used to:

« Execute multiple tasks in parallel, for example, multiple executions of the same function
or multiple iterations of the same loop. This is pipelining.

« Restructure the physical implementation of arrays (block RAMs), functions, loops and
ports to improve the availability of data and help data flow through the design faster.

« Provide information on data dependencies, or lack of them, allowing more
optimizations to be performed.

The final optimization technique is to modify the C source code to remove unintended
dependencies in the code that may limit the performance of the hardware.

This tutorial consists of two lab exercises. You may perform the analysis in these lab
exercises using the Analysis perspective. A prerequisite for this tutorial is completion of the
Chapter 6, Design Analysis tutorial.

Lab 1 Description

Contrast the uses of loop and function pipelining to create a design that can process one
sample per clock. This lab includes examples that give you the opportunity to analyze the
two most common causes for designs failing to meet performance requirements: loop
dependencies and data flow limitations or bottlenecks.

Lab 2 Description

This lab shows how modifications to the code from Lab 1 can help overcome some
performance limitations inherent, but unintended, in the code.
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Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

For this tutorial you use the design files in the tutorial directory
Vivado_HLS Tutorial\Design_Optinization.

The sample design you use in the lab exercise is a matrix multiplier function. The design
goal is to process a new sample every clock period and implement the interfaces as
streaming data interfaces.

Lab 1: Optimizing a Matrix Multiplier

This exercise uses a matrix multiplier design to show how you can fully optimize a design
heavily based on loops. The design goal is to read one sample per clock cycle using a FIFO
interface, while minimizing the area.

The analysis includes a comparison of a methodology that optimizes at the loop level with
one that optimizes at the function level.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado HLS Tutorial directory.

Step 1: Create and Open the Project
1. Open the Vivado HLS Command Prompt.

- On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 7-1).

o On Linux, open a new shell.
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Vivado 20163

o Add Design Toolks or Devices 2016.3

av Manage Xilinx Licenses
$: uninstan 20163

System Generator
Vivado HLS
B Vivado HLS 20163 Command Promp

Vivado HLS 20163 -

Figure 7-1: Vivado HLS Command Prompt

2. Using the command prompt window (Figure 7-2), change directory to the Design
Optimization tutorial, labl.

3. Execute the Tcl script to set up the Vivado HLS project, using the command
vivado hls -f run hls.tcl, as shown in Figure 7-2.

C:wUivado_HLS_Tutorialicd Design_Optimization

C:\Uivado_HLS _Tutorial\Design_Optimizationircd labl

C:\Wivada HLS Tuterial)\Design_Optimization’labliuvivads_hls -f run_hls.tel T

Figure 7-2: Setup the Design Optimization Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado _hls -p matrixmul prj, as shown in Figure 7-3.

BI [HLS=18] Creating and opening solution "C:/Uivado_HLS _Tutorial/Design_Optimizjg
ation/labl/matrizmul_prj/selution? .
@I [HLS-18] Cleaning up the solution databasze.
@I [HLS-18] Setting target device to 'xcTkI1EBtFbg4¥24-1"
AT [S¥W-201]1 Setting up clock "defasult” with a peried of 13.3333ns.
Compiling ../ ../ .. .. /matrixmul_test.cpp in debug mode
Compiling .. SAmatrizmul cpp in debug mode

Generating csim. exe
Test passes
BI [$IM-1] CSim done with 8 errors.
BI [LIC=181] Checked in feature [HLS]

C:\Wivados HLS Tuterial\Design_Optimization’labl»uivade_hls -p matrixmul _prij -

Figure 7-3. Open Design Optimization Project for Lab 1

5. Expand the Sources folder in the Explorer pane and double-click mat ri xmul . cpp to
view the source code (Figure 7-4).

Scroll down the file to see that the source code has two input arrays, a and b, and output
array res. Hold the mouse over the macros (as shown in Figure 7-4) to see that each is
three-by-three for a total of nine elements.
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G Explorer & 0= 00 6 matrixmulepp
& matrixmul_prj AG #include "matrixmul.h” =
0 Includes

Source 18 void matrixmul(
d mat_a_t a[MAT_A_ROWS][MAT_A_COLS],

L& matrixmul.cpp mat b t B[MAT B an.”.m.in_

& Test Bench 51 result_t res[MAT_A_ROW, 1
= solutiont 52 {
# constraints ff Tterate over the rows oT™rme—rrmrrrrx
¥ directives.tcl 54 Row: for{int 1 - @; 1 < MAT_A_ROWS; i++) {
W scnpttct At ff Iterate over the columns of the Ea'l- alrix
+ esim Col: for{int j - ©; j <« MAT_G_COLS; j++) {
o res[1][i] = ©;
= build ] Hf D the dionner nradurt aof a8 row of A and cal of B T
= report 4 I r

Figure 7-4:  Source Code for the Matrix Multiplier

Step 2: Synthesize and Analyze the Design

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, the synthesis report opens (Figure 7-5), and the Performance
Estimates appears:

« Theinterval is 80 clock cycles. Because there are nine elements in each input array, the
design takes approximately nine cycles per input read.

« The interval is one cycle longer than the latency, so there is no parallelism in the
hardware at this point.

« The latency/interval is due to nested loops.

- The inner loop called Product:
- Has a latency of 2 clock cycles.
- Has 6 clock cycles total for all iterations.

o The Col loop:
- It requires 1 clock to enter loop Product and 1 clock to exit.
- It takes 8 clock cycles for each iteration (1+6+1).
- Has 24 cycles for all iterations to complete.

o The top-level loop has a latency of 26 clock cycles per iteration, for a total of 78
clock cycles for all iterations of the loop.
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=l Synthesis(solution1) &2

Performance Estimates

= Summary
Clock  Target  Estimated
ap_clk 13.33 8.18
-| Latency (clock cycles)
= Summary
Latency Interval
min max min  max
79 79 80 80
= Detail
+ Instance
=l Loop
Latency
Loop Name  min  max
- Row 78 78
+ Col 24 24
++ Product 6 6
Figure 7-5:

Uncertainty
167

Type
none

Iteration Latency
26

Initiation Interval

achieved

target

Chapter 7:

Trip Count
3
3
3

Synthesis Report for the Matrix Multiplier

Design Optimization

m

Pipelined
no
no

no

You can do one of two things to improve the initiation interval: Pipeline the loops or
pipeline the entire function. You begin by pipelining the loops and then compare those
results to pipelining the entire function.

When pipelining loops, the initiation interval of the loops is the important metric to

monitor. As seen in this exercise, even when the design reaches the stage at which the loop
can process a sample every clock cycle, the initiation interval of the function is still reported
as the time it takes for the loops contained within the function to finish processing all data

for the function.

Step 3: Pipeline the Product Loop

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, sol uti on2.

2. Click Finish and accept the defaults to create sol uti on2.

3. Ensure the C source code is visible in the Information pane.
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When pipelining nested loops, you realize the greatest benefit by pipelining the inner-most
loop, which processes a sample of data. High-Level Synthesis automatically applies loop
flattening, collapsing the nested loops, removing the loop transitions (essentially creating a
single loop with more iterations but overall fewer clock cycles).

4. In the Directive tab:
a. Select loop Product.
b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box, activate the Directive drop-down menu at the
top and select PIPELINE.

d. Click OK. With the default options, an initiation interval (II) of 1 (one new loop
iteration per clock) will be the default.

The Directive pane should show the following optimization directives. (The new directive is
highlighted.)

8% Qutline |14 Directive &2
4 @ matrixmu

@ a

# b

# res

4% Row
a3 Cal
4 Prosduct
% HLS PIPELIME

Figure 7-6: Initial Pipeline Directive

5. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

During synthesis, the information reported in the Console pane shows loop flattening was
performed on loop Row and that the default initiation internal target of 1 could not be
achieved on loop Product due to a dependency.

INFO: [XFORM 203-541] Flattening a loop nest 'Row' (matrixmul.cpp:54:37) in function
'matrixmul'.

INFO: [SCHED 204-61] Pipelining loop 'Product'.
WARNING: [SCHED 204-68] Unable to enforce a carried dependency constraint (II = 1,
distance = 1)
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between 'store' operation (matrixmul.cpp:60) of variable 'tmp 8', matrixmul.cpp:60
on array 'res' and 'load' operation ('res load', matrixmul.cpp:60) on array 'res'.
INFO: [SCHED 204-61] Pipelining result: Target II: 1, Final II: 2, Depth: 2.

The synthesis report (Figure 7-7) shows that although the Product loop is pipelined with an
interval of 2, the interval of top-level loop is not pipelined.

=1 Synthesis(solution2) &2 = 5
Performance Estimates

- Timing (ns)

-| Summary

Clock ~ Target  Estimated  Uncertainty
ap_clk 13.33 10.57 167

m

-I Latency (clock cycles)

= Summary

Latency Interval
min  max min max Type
82 82 83 83  none

= Detail
+ Instance

= Loop
Latency Initiation Interval
Loop Name min  max [teration Latency  achieved target Trip Count  Pipelined
- Row_Col 81 81 9 - - g no
+ Product 6 6 2 2 1 3 yes

Figure 7-7: Matrixmul Initial Pipeline Report

The reason the top-level loop is not pipelined is that loop flattening only occurred on loop
Row. There was no loop flattening of loop Col into the Product loop. To understand why
loop flattening was unable to flatten all nested loops, use the Analysis perspective.

6. Open the Analysis perspective.

7. In the Performance View, expand loops Row_Col and Product.
8. Selectthewrite operation in state Cl.
9

Right-click and select Goto Source to see the view in Figure 7-8.

The write operation in state C1 is due to the code that sets res to zero before the Product
loop. Because res is a top-level function argument, it is a write to a port in the RTL: This
operation must happen before the operations in loop Product are executed. Because it is
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not an internal operation but has an impact on the I/O behavior, this operation cannot be
moved or optimized. This prevents the Product loop from being flattened into the Row_Col

loop.

= Performance(sclution2) &2

Current Module

| Oneration\Control S...

: matrixmul

(8]

c2

c3 | -

[ Y
NohBwo N w A

j (phi mux)
exitcond flatt...
indvar flatten...
exitcondl (icmp)
] midZ2 (select)
5(+}
mid2 (select)
addr7 (-)

addrB (+)

node 35(write)
# Product

j 1(+)

o e e

Performance | Resource

[ Properties | [< C Source 2

11

File: C\Vivado_HLS_Tutorial\Design_Optimization\labl\matrixmul.cpp

55
56
57
58
59
60
61
62
63
64
65}

}

// lterate over the columns of the B matrix
Col: for(int ] =0; ) <« MAT_B_COLS; j++){

res(i](] = 0;

// Do the inner product of a row of A and col of B

Product: for(int k = 0; k < MAT_B_ROWS; k++) {
res[i]j] += a[i][k] * bIk][];

}
¥

I

Figure 7-8:

111

Matrixmul Initial Performance View

More importantly, it is worth addressing why only an II of 2 was possible for the Product
loop (as shown in Figure 7-7).

The message SCHED-68 in the console pane (and fil e vivado_hl s. | og) tells you:

WARNING:
distance

[SCHED 204-68] Unable to enforce a carried dependency constraint (II = 1,

1)

between 'store' operation (matrixmul.cpp:60) of variable 'tmp 8', matrixmul.cpp:60
on array 'res' and 'load' operation ('res load', matrixmul.cpp:60) on array 'res'.
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« The issue is a carried dependency. This is a dependency between an operation in one
iteration of a loop and an operation in a different iteration of the same loop. For
example, an operation when k=1 and when k=2 (where k is the loop index).

« The first operation is a load (memory read operation) on array res on line 60.

« The second operation is a store (memory write operation) on array res on line 60.

From Figure 7-9 you can see line 60 is a read from array res (due to the += operator) and a
write to array res. An array is mapped into a block RAM by default and the details in the
Performance View can show why this conflict occurred.

The Performance view shows in which states the operations are scheduled. Figure 7-9
shows that two of the operations are shown in red. These are the operations which have a
dependency between loop iterations. If you double-click on any of these red operations, the
Critical Pipeline Dependence windows opens, showing two iterations of the loop over
multiple clock cycles.

The first iteration of the loop shows the states in which the operations occur. The read in
states 2 and 3, and the write in state 3. The operation in the next iteration must start 1 cycle
after this, because the 2nd read cannot occur until the 1st write has finished: the operations
in each iteration of the loop are to a different address and only 1 address can be applied at
the same time.
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Current Module : matrixmul

| Oneration\Control S| _co | c1 | | |
6 indvar flatten... L ——
7 i1(4) ¢ (Critical Pipeline DependenceIn.. | = | [ || &3
8 WeESshu e Critical pipeline dependence inform
o] 7 mid2 (select)
10 1 cast3 mid2 v...
11 tmp 7(-)
12 tmp 8(+)
13 node 33(write) Region: II=2
14 EProduct 2 3 4 5
15 k(phi mux) s -
16 exitcond (icmp) I1I
17 k 1(+) i H
18 t:mp 9[_” LT 1
19 tmp 10(-) i’1 """""" I
20 tmp 11(+) : I
21 a load(read) .. - i
a2 b load(read)

res load(read) W
24 tmp 2 (*)
25 tmp 3(+) [ 0K l ‘ Cancel
26 node 62 (write) -
27 3 1(%)
Performance | Resource
Figure 7-9. Carried Dependency Analysis

m

You cannot pipeline the Product loop with an initiation interval of 1. The next lab exercise
shows how re-writing the code can remove this limitation. In this lab exercise you will
continue to optimize the code as it is.

The next step is to pipeline the loop above, the Col loop. This automatically unrolls the
Product loop and creates more operators and hence more hardware resources, but it
ensures there is no dependency between different iterations of the Product loop.

10. Return to the Synthesis perspective.

Step 4. Pipeline the Col Loop

1. Select the New Solution toolbar button to create a new solution, solution3.

2. Because solution2 already has a directive added, use the drop-down menu to select
solutionl as the source for existing directives and constraints (solutionl has none).

3. Click Finish and accept the default solution name, solution3.

4. Openthe C source code matri xmul . cpp to make it visible in the Information pane.
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5. In the Directive tab:
a. Select loop Col.
b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

d. Click OK. With the default options, an initiation interval (II) of 1 (one new loop
iteration per clock) becomes the default.

The Directive pane, shown below, displays the following optimization directives (the new
directive is highlighted).

o= Outhine | 2% Directive &
@ matriornul
# 3
4 b
4 res
4 5 Row
e Col
% HLS PIPELINE
7 Product

Figure 7-10: Col Pipeline Directive
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

During synthesis, the information reported in the Console pane shows that loop Product
was unrolled, loop flattening was performed on loop Row, and the default initiation internal
target of 1 could not be achieved on loop Row_Col due resource limitations on the
memory for array a.

INFO: [XFORM 203-502] Unrolling all sub-loops inside loop 'Col' (matrixmul.cpp:56) in
function 'matrixmul' for pipelining.

INFO: [XFORM 203-501] Unrolling loop 'Product' (matrixmul.cpp:59) in function
'matrixmul' completely.

INFO: [XFORM 203-541] Flattening a loop nest 'Row' (matrixmul.cpp:54:37) in function
'matrixmul’.

INFO: [SCHED 204-61] Pipelining loop 'Row Col'.

WARNING: [SCHED 204-69] Unable to schedule 'load' operation ('a load 1',
matrixmul.cpp:60) on array 'a' due to limited memory ports.

INFO: [SCHED 204-61] Pipelining result: Target II: 1, Final II: 2, Depth: 3.

Reviewing the synthesis report shows, as noted above, that the interval for loop Row_Col is
only two: the target is to process one sample every cycle. Once again, you can use the
Analysis perspective to highlight why the initiation target was not achieved.
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7. Open the Analysis perspective.

8. In the Performance View, expand the Row_Col

Chapter 7: Design Optimization

The operations on array a (mentioned in the SCHED-69 message above) are highlighted in
Figure 7-11. There are three read operations on array a. Two operations start in state C1 and
a third read operation starts in state C2.

Arrays are implemented as block RAMs and arrays which are arguments to the function are
implemented as block RAM ports. In both cases a block RAM can only have a maximum of
two ports (for dual-port block RAM). By accessing array a through a single block RAM

interface, there are not enough ports to be able to read all three values in one clock cycle.

= Performance(solution3) &2

Current Module : matrixmul
| Oneration\Control S. . cO
i1 ERow Col
2 indvar flatten...
3 i(phi mux)
4 j (phi mux)
5 exitcond flatt...
6 indvar flatten...
7 i 1(+)
8 exitcond (icmp)
[s] j mid2 (select)
10 tmp mid2 wv(sel...
11 tmp 1(-)
12 tmp 8 (+)
13 tmp s (+)
a load(read)
15 b load(read)
a load 2 (read)
17 b load 2 (read)
18 tmp 4 (+)
19 tmp 9(+)
20 tmp 10 (+)
21 tmp 7 (*)
a load 1 (read)
23 b load 1 (read)
24 tmp 7 2(*)
25 tmpl (+)
26 J 1(+)
27 tmp 7 1(*)
28 tmp 8 2(+)
29 node 69 (write)

Performance | Resource
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Another way to view this resource limitation is to use to the Resource pane.

9. Click the Resource tab.

10. Expand the Memory Ports to see the view shown in Figure 7-12.

In Figure 7-12 the 2-cycle read operations in state C1 overlap with those starting in state C2
and so only a single cycle is visible: however, it is clear that this resource is used in multiple
states.

In looking at this view, it is clear that even when the issue with port a is resolved, the same
issue occurs with port b: it also has to perform 3 reads.

High-Level Synthesis can only report one schedule error or warning at a time, because, as
soon as the first issue occurs, the actions to create an achievable schedule invalidates any
other infeasible schedules.

=' Resource(solution3) 2 = 8

Current Module : matrixmul

|R95err_9\Cnn‘rm| Sten|  CO | C1 | (0 | C3 |
1-6 ®I/0 Ports
7 EMemory Ports

8 a(pl) read read

9 a(pl) read

10 b(pl) read

11 b (p0) read read

12 res (p0) write

1... ¥EXpressions

Performance | Resource

Figure 7-12: Matrixmul Pipeline Col Resource View

High-Level Synthesis allows arrays to be partitioned, mapped together and re-shaped.
These techniques allow the access to array to be modified without changing the source
code.

11. Return to the Synthesis perspective.

Step 5: Reshape the Arrays

1. Select the New Solution toolbar button or use the menu Project > New Solution to
create a new solution, sol uti on4.

2. Click Finish and accept the default solution name solution4.
Because the loop index for the Product loop is k, both arrays should be partitioned along

their respective k dimension: the design needs to access more than two values of k in each
clock cycle.
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For array a, this is dimension 2 because its access patternsis a[ i ] [ k] ; for array b, this is
dimension 1 because its access patternis b[ K] [j].

Partitioning these arrays creates k arrays - in this case, k number ports. Alternatively, we can
use re-shape instead of partition allowing one wide array (port) to be created instead of k
ports.

After this transformation, the data in the block RAM outside this block must be reshaped in
an identical manner: if this process is not done by HLS, the data must be arranged as:

« For array a: i elements, each of width data_word_size times k.
« For array b: j elements, each of width data_word_size times k.
3. Open the C source code mat ri xrmul . cpp to make it visible in the Information pane.
4. In the Directive tab
a. Select variable a.
b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select ARRAY_RESHAPE.

d. Set the dimension to 2.
e. Click OK.

5. Repeat this process for variable b, but set the dimension to 1.

The Directive pane should show the following optimization directives.

8% Qutline | (14 Diractive i1
@ matrixrmul
4 o
%% HLS ARRAY_RESHAPE reshape variable=a complete dim=2
# O
U HLS ARRAY RESHAPE reshape vanable=b complete dim=1
# res
% Row
Col
%% HLS PIPELINE
% Product

Figure 7-13:  Array Reshape Directive
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

The synthesis report shows the top-level loop Row_Col is now processing data at 1 sample
per clock period (Figure 7-14).
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=l Synthesis{solution3) 2 = g

Performance Estimates

-1 Timing {ns)
=l Summary
Clock Target Estimated Uncertainty
ap_clk 13.33 11.13 167 =

- Latency (clock cycles)
=l Summary

Latency Interval
min max  min max  Type
12 12 13 13  none

= Detail
+ Instance
-l Loop
Latency Initiation Interval

Loop Name min  max Iteration Latency  achieved  target Trip Count  Pipelined
- Row_Cal 10 10 3 1 1 9 yes

< 11 3

Figure 7-14: Optimized Loop Processing Report
+ The top-level module takes 12 clock cycles to complete.
« The Row_Col loop outputs a sample after 3 cycles (iteration latency).
« It then reads 1 sample every cycle (Initiation Interval).
« After 9 iterations/samples (Trip count) it completes all samples.

« 3+ 9=12clock cycles
The function can then complete and return to start to process the next set of data.

Now, change the block RAM interfaces to FIFO interfaces to allow for streaming data.

Step 6: Apply FIFO Interfaces
Select the New Solution toolbar button to create a new solution.
Click Finish and accept the default solution name, solution5.

Open the C source code mat ri xmul . cpp to make it visible in the Information pane.

Bl S

In the Directive tab

a. Select variable a.
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b. Right-click and select Insert Directive.

c. In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select INTERFACE.

d. Click the mode drop-down menu to select ap_fi fo.
e. Click OK.

5. Repeat this process for variables b and variable r es.

The Directive pane displays the following optimization directives. (The new directives are
highlighted).

&= Outline | 25 Directive & =0
4 @ matrixmul

4 a

% HLS ARRAY RESHAPE reshape vanable=a complete dim=2

%% HLS INTERFACE ap_fifo port=a

b

% HLS INTERFACE ap_fifo port=b

9% HLS ARRAY_RESHAPE reshape variable-b complete dim=1

a4 res

% HLS INTERFACE ap_fifo port=res

45 Row
1 Col

Figure 7-15:  Matrixmul FIFO Directives
6. Click the Run C Synthesis toolbar button to synthesizes the design to RTL.

Figure 7-16 shows the Console display after synthesis runs.

El Consale &2 & < Errors| & Warmnings w il e T 0O
Vivado HLS Console
@1 [HL5-1M] Opening project 'C:/Vivado HLS Tutorial/Design_Optimization/labl/matrixmul prj’. -

@1 [HL5-18] Adding desipn file 'matrixmul.cpp’ to the project.
@I [HL5-18] Adding test bench tile 'matrixmul_test.cpp’ to the project.
@1 [HL5-18] Opening solution "C:/Vivado HLS Tutorial/Design_ Optimization/labl/matrixmul prjfsolutions’
@T [SYN-201] Setting up clock with a period of 13.3333ns.
@I [HL5-18] Setting target dewvice to "xc7k1&0ttbgddd-1°
@1 [HL5-18] Importing test bench file "matrixmul_test. cpp’
@T [HL5-18] fAnalyzing desipn file 'matrixmul.cpp’
@I [HL5-18] Validating synthesis directives ...
@1 [HL5-18] Checking synthesizability ...
E [SYNCHK-%1] Port 'res' (matrixmul.cpp:51) of function 'matrixmul’ cannot be set to a FIFD as it has _
I [SYNCHK-1@] 1 error(s), @ warning(s}.| =

-

[ % T

'] il 3

Figure 7-16: FIFO Synthesis Warning

From the code shown in Figure 7-17, array res performs writes in the following sequence
(MAT_B_COLS = MAT_B_ROWS = 3):
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«  Write to [0][0] on line57.

« Then a write to [0][0] on line 60.

« Then a write to [0][0] on line 60.

« Then a write to [0][0] on line 60.

« Write to [0][1] on line 57 (after index J increments).
« Then a write to [0][1] on line 60.

+ Etc.

Four consecutive writes to address [0][0] does not constitute a streaming access pattern;
this is random access.

|| matrixmul cpp = f
2 { -

ff Iterate over the rows of the A matrix
Row: for{int 1 = @; 1 < MAT_A ROWS; 1++) {
ff Iterate over the columns of the B matrix
Col: For{int j = @; j < MAT_B _COLS; je+) [
res[1][§] = &;
f/f Do the inner product of a row of A and col of
Product: for{int k = @; k < MAT_B_ROWS; kes) {
res[1][i] += a[il[k] * blk][4];
}

= :
Figure 7-17: Matrixmul Code

Examining the code in Figure 7-17 reveals that there are similar issues reading arrays a and
b. It is impossible to use a FIFO interface for data access with the code as written. To use a
FIFO interface, the optimization directives available in Vivado High-Level Synthesis are
inadequate because the code currently enforces a certain order of reads and writes. Further
optimization requires a re-write of the code, which you accomplish in Lab 2.

Before modifying the code, however, it is worth pipelining the function instead of the loops
to contrast the difference in the two approaches.

Step 7: Pipeline the Function

1. Select the New Solution toolbar button to create a new solution, solution6.

f IMPORTANT: In this step, copy the directives from solution4 as this solution does not have FIFO
interfaces specified.

2. Select solution4 from both the drop down menus in the Options section. The Solution
Wizard appears as shown in Figure 7-18.
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¢ Solution Wizard = _I_?I_.

Solution Configuration

Create Vivado HLS solubion for selected technology

Solution Mame:  solutiond

Clock

Period: 75MHz Uncertainty:
Part Selection

Par: Xe7kT1600hgdBd-T

Oplions
' Copy directives and constraimts from solubion: m -

! Finish | | Cancel

Figure 7-18: New Solution Based on Solution4 Directives

3. Click Finish and accept the default solution name, sol uti on6.

4. Open the C source code mat ri xmul . cpp to make it visible in the Information pane.

5. In the Directive tab:

a.

b.

f.

Select the pipeline directive on loop Col.
Right-click and select Remove Directive.
Select the top-level function matrixmul.
Right-click and select Insert Directive.

In the Directives Editor dialog box activate the Directive drop-down menu at the
top and select PIPELINE.

Click OK.

The Directives tab should appear as Figure 7-19.
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& Qutline |14 Directive £ = a
4 @ matrixmul
36 HLS PIPELIMNE
# a
% HLS ARRAY_RESHAPE reshape variable-a complete dim=2
4 b
% HLS ARRAY_RLSHAPE reshape variable-b complete dim-1
4 res
a7 Row
5 Col

Figure 7-19: Directives for Solution6
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.
7. Click the Compare Reports toolbar button.
a. Add sol ution4.
b. Add sol uti on6.
c. Click OK.

The comparison of solutions 4 and 6 is shown in Figure 7-20.
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£7 compare reports = B8

Performance Estimates

= Timing (ns)
Clock solutiond  solutiond
ap_clk Target 13.33 13.33
Estimated 11.13 11.13

-l Latency (clock cycles)

solutiond  solutionf

Latency min 12 6
max 12 6

Interval min 13 5 |
max 13 5 ]

Utilization Estimates

solutiond  solutiond

BRAM_18K O 0
DSP48E 3 27
FF 56 503
LuT 32 47

Figure 7-20:  Loop Versus Function Pipelining

The design now completes in fewer clocks and can start a new transaction every 5 clock
cycles. However, the area and resources have increased substantially because all the loops
in the design were unrolled.

INFO: [XFORM 203-502] Unrolling all sub-loops inside loop 'Col' (matrixmul.cpp:56) in
function 'matrixmul' for pipelining.

INFO: [XFORM 203-501] Unrolling loop 'Product' (matrixmul.cpp:59) in function
'matrixmul' completely.

INFO: [XFORM 203-541] Flattening a loop nest 'Row' (matrixmul.cpp:54:37) in function
'matrixmul’.

Pipelining loops allows the loops to remain rolled, thus providing a good means of
controlling the area. When pipelining a function, all loops contained in the function are
unrolled, which is a requirement for pipelining. The pipelined function design can process a
new set of 9 samples every 5 clock cycles. This exceeds the requirement of 1 sample per
clock because the default behavior of High-Level Synthesis is to produce a design with the
highest performance.

The pipelined function results in the best performance. However, if it exceeds the required
performance, it might take multiple additional directives to slow the design down.
Pipelining loops gives you an easy way to control resources, with the option of partially
unrolling the design to meet performance.
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Lab 2: C Code Optimized for I/0 Accesses

In Lab 1, you were unable to use streaming interfaces. The nature of the C code, which
specified multiple accesses to the same addresses, prevented streaming interfaces being
applied.

« In a streaming interface, the values must be accessed in sequential order.

« Inthe code, the accesses were also port accesses, which High-Level Synthesis is unable
to move around and optimize. The C code specified writing the value zero to portres
at the start of every product loop. This may be part of the intended behavior. HLS
cannot simply decide to change the specification of the algorithm.

The code intuitively captured the behavior of a matrix multiplication, but it prevented a
required behavior in the hardware: streaming accesses.

This lab exercise uses an updated version of the C code you worked with in Lab 1. The
following explains how the C code was updated.

Figure 7-21 shows the I/O access pattern for the code in Lab 1. Out of necessity the address
values are shown in a small font.

As variables i,] and k iterate from 0 to 3, the lower part of Figure 7-21 shows the
addresses generated to read a, b and write to r es. In addition, at the start of each Product
loop, r es is set to the value zero.

.-ﬁﬁﬁuuu

Row |
Colj Sl

Potu
0010 i i 0 G0 Dl 1m0 o ol

Figure 7-21: Matrix Multiplier Address Accesses

To have a hardware design with sequential streaming accesses, the ports accesses can only
be those shown highlighted in red. For the read ports, the data must be cached internally to
ensure the design does not have to re-read the port. For the write port res, the data must
be saved into a temporary variable and only written to the port in the cycles shown in red.

The C code in this lab reflects this behavior.

High-Level Synthesis N send Feedback 168
UG871 (v2016.4) November 30, 2016 www.xilinx.com I—\ /_l



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=168

g: X”_INX Chapter 7: Design Optimization

ALL PROGRAMMABLE

Step 1. Create and Open the Project

1. From the Vivado HLS command prompt used in Lab 1, change to the lab2 directory as
shown in Figure 7-22.

2. Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.

C:\Uivado_HLS_TutorialhDesign_Optimization'lablled .

C:3Uivado HLS_TutorialhDesign_Optimization:cd lab2

C:\Uivado HLS Tutorial\Design_Optimization‘\lab2:uivado_hls -f run_hls, tel

Figure 7-22: Setup for Interface Synthesis Lab 2
3. Open the Vivado HLS GUI project by typing vivado _hls -p matrixmul prj.

4. Open the Source folder in the Explorer pane and double-click mat ri xmul . cpp to open
the code as shown in Figure 7-23.

£ matrixmul.cpp E
£ 1 -
#pragma HLS ARRAY_RESHAPE variable-b complete dim-1
1#pragma HLS ARRAY _HESHAPE wvarlable=a complete dim=2
#pragma HLS TNTERFACE ap fifo port=a
#pragma HLS INTERFACE ap_fifc peort-b
#pragma HLS INTERFALE ap_fifo port=res
mat a t a row[MAT A ROWS];
mat_b_t b_copy|[MAT_B_ROWS ] [MAT_B COLS];
int tmp = 8;

Lterabte owver Lhe rows f the A matrix
Row: Forfint 1 = @; i < MAT A ROWS; i++) {
Iterate over the columns £ the B matri
Col: For(int j = 8; J < MAT_B_COLS; j++) {
[ #pragma HLS PIPFLINE
Do the inner product f a row + A& and col
Lmp=4;
ff Cache eact w (50 it's only read once pe unction)
if {j @)
Cache_Row: fFor(int k = 8; k < MAT_A ROWS; kes+)
a rom[k] = a[i]l[k];

it

if (i - @)
Cache Col: fFor(int k = 8; k < MAT_B ROWS; k++)

b_copy[k1[] = bIKI[1];

Product: for(int k = 8; k ¢« MAT_B_ROWS; kes) {
tmp += a row[k] * b copy[k]1[3];

Figure 7-23: C Code with Updated 1/0 Accesses
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Review the code and confirm the following:

The directives from Lab 1, including the FIFO interfaces, are specified in the code as
pragmas.

For-loops have been added to cache the row and column reads.

A temporary variable is used for the accumulation and port res is only written to when
the final result is computed for each value.

Because the for-loops to cache the row and column would require multiple cycles to
perform the reads, the pipeline directive has been applied to the Col for-loop, ensuring
these cache for-loops are automatically unrolled.

Synthesize the design and verify the RTL using co-simulation.

5.
6.

7.

Click the Run C Synthesis toolbar button to synthesize the design to RTL.

When synthesis completes, use the Run C/RTL Cosimulation toolbar button to launch
the Cosimulation Dialog box.

Click OK to start RTL verification.

The design has been now been fully synthesized to read one sample every clock cycle using
streaming FIFO interfaces.

Conclusion

In this tutorial, you learned:

High-Level Synthesis

How to analyze pipelined loops and understand exactly which limitations prevent
optimizations targets from being achieved.

The advantages and disadvantages of function versus loop pipelining.

How unintended dependencies in the code can prevent hardware design goals from
being realized and how they can be overcome by modifications to the source code.
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Chapter 8

RTL Verification

Overview

The High Level Synthesis tool automates the process of RTL verification and allows you to
use RTL verification to generate trace files that show the activity of the waveforms in the
RTL design. You can use these waveforms to analyze and understand the RTL output. This
tutorial covers all aspects of the RTL verification process.

To perform RTL verification, you use both the RTL output from High-Level Synthesis
(Verilog, VHDL or SystemC) and the C test bench. RTL verification is often called
cosimulation or C/RTL cosimulation; because both C and RTL are used in the verification.

This tutorial consists of three lab exercises.

Lab 1 Description

Perform RTL verification steps and understand the importance of the C test bench in
verifying the RTL.

Lab 2 Description

Create RTL trace files and analyze them using the Vivado Design Suite.

Lab 3 Description

Create RTL trace files and analyze them using a third-party RTL simulator. This lab requires
a license for Mentor Graphics ModelSim simulator. (You can use an alternative, third-party
simulator with minor modifications to the steps).

Tutorial Design Description

You can download the tutorial design file from the Xilinx website. See the information in
Locating the Tutorial Design Files.
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This tutorial uses the design files in the tutorial directory
Vivado_HLS Tutorial\RTL_Verification.

The sample design used in the lab exercise is a DUC (digital up converter) function. The
purpose of this lab is to demonstrate and explain the features of RTL verification. There are
no design goals for these lab exercises.

Lab 1: RTL Verification and the C Test Bench

This exercise explains the basic operations for RTL verification and highlights the
importance of the C test bench.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create and Open the Project
1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 8-1).

o On Linux, open a new shell.

Vivado 2016.3
L Add Design Tool or Devices 2016.3
e Manage Xilinx Licenses
$5 uninstan 20163
W Vivado 20163 Tl Shell
d - Wivado 20063
Systemn Generator
Vivado HLS
Bl Vivado HLS 20163 Command Promp

« | Vivado HLS 20163 -

4  Back

Figure 8-1: Vivado HLS Command Prompt

2. Using the command prompt window (Figure 8-2), change directory to the
RTL_Verification tutorial, | ab1l.

3. Execute the Tcl script to setup the Vivado HLS project, using the command vi vado_hl s
-f run hls.tcl, as shown in Figure 8-2.
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C:\Vivado_HLS_Tutorial>cd RTL_Uerification

C:\Vivado_HLS_Tutorial\RTL_Verification>cd labl

1 (I

C:\Uivado_HLS_Tutorial\RTL Uerification\labl>vivado_hls -f run_hls.tcl

Figure 8-2: Setup the RLTL Verification Tutorial Project

4. When Vivado HLS completes, open the project in the Vivado HLS GUI using the
command vivado_hls -p duc_prj, as shown in Figure 8-3.

@I [LIC-101] Checked in feature [HLS] -
Generating csim.exe

*xx DUC hardware test PASSED ! seex

BI [SIM-1] CSim done with © errors.
@I [LIC-101] Checked in feature [HLS]

1 (1M

C:\Uivado_HLS_Tutorial\RTL_Uerification\labl>vivado_hls -

Figure 8-3: Open RTL Verification Project for Lab 1

Step 2: Perform RTL Verification

1. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

2. When synthesis completes, use the Run C/RTL Cosimulation toolbar button
(Figure 8-4) to launch the Cosimulation dialog box.

File Edit Project Solution Window Help

b 4 CE8B R &8 b V]S

Figure 8-4: Run C/RTL Cosimulation Toolbar Button

The Cosimulation Dialog box opens, as shown in Figure 8-5.
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¢# Co-simulation Dialog @

C/RTL Co-simulation

Verilog/VHDL Simulator Selection

Auto -

RTL Selection
@ Verilog () VHDL

Options
[] Setup Only

Dump Trace

[ Optimizing Compile

|| Reduce Diskspace

Compiled Library Location

Input Arguments

[] Do not show this dialog box again.

[ OK l l Cancel

Figure 8-5: Cosimulation Dialog Box

The drop-down menu allows you to select the RTL simulator for HDL simulation. For this

exercise, you use the default Auto selection (Auto selects the Vivado Simulator) with Verilog
RTL for cosimulation.

3. Click OK to start RTL verification.

When RTL Verification completes, the simulation report opens automatically (Figure 8-6).

The report indicates if the simulation passed or failed. In addition, the report indicates the
measured latency and interval.

High-Level Synthesis
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Cosimulation Report for "duc’

Result
Latency Interval
RTL Status min  avg max min  avg max
VHDL NA  NA NA NA  NA NA NA

Verilog Pass 34 35 42 35 36 43

Figure 8-6: Cosimulation Report

RTL simulation completes in three steps. To better understand how the RTL verification
process is performed, scroll up in the console window to confirm that the messages
described below were issued.

First, the C test bench is executed to generate input stimuli for the RTL design.

INFO: [COSIM 212-14] Instrumenting C test bench ...

< C simulation executes to generate input stimuli >

At the end of this phase, the simulation shows any messages generated by the C test bench.
The output from the C function is not used in the C test bench at this stage, but any
messages output by the test bench can be seen in the console.

INFO: [COSIM 212-302] Starting C TB testing ...
*** DUC hardware test PASSED ! **%*

An RTL test bench with newly generated input stimuli is created and the RTL simulation is
then performed.

INFO: [COSIM 212-333] Generating C post check test bench ...
INFO: [COSIM 212-12] Generating RTL test bench ...

Finally, the output from the RTL simulation is re-applied to the C test bench to check the
results. Once again, you can see any message output by the C test bench in the console.
Finally, RTL verification issues message SIM-1000 if the RTL verification passed.

INFO: [COSIM 212-316] Starting C post checking ...
*%*% DUC hardware test PASSED | ***
INFO: [COSIM 212-1000] *** C/RTL co-simulation finished: PASS **x*

To fully understand why the C test bench should check the results and how message
SIM-1000 is generated, you will modify the C test bench.
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Step 3: Modify the C test bench

1. Expand the Test Bench folder in the Explorer pane (Figure 8-7).

2. Double-click duc_t est. c to open the C test bench in the Information pane.

&5 Explorer 22 & = 0| [ duc teste &3 =0
ot /* Lheck The result */

1= duc_prj . ) . .
.UC_[JI’] 1 int retl = system("diff --brief duc_i.dat golden/duc_i.d:
! Includes 2 int ret2 = system("diff --brief duc_g.dat golden/duc_g.d:
£ Source 3
i Test Bench 4 if (retl | ret2) {
[¢] duc_testc printf("\n *** DUC hardware test FAILED ! *** \n\n"),
& golden } else {
¢= solution{ printf("\n *** DUC hardware test PASSED | *#* \n\n"),

[==]

}

# constraints

(4]
[Ebc-5|m 0 return ((retl | ret2) 2 1 : 0);
& sim 1//return 1; =
(= syn 2}

i e S o T o T o T e T R e R B ]
et I = N |

[FERy N
1

4| Il | b
Figure 8-7:  RTL Test Bench
3. Scroll to the end of the file to see the code shown in Figure 8-8.

4. Edit the return statement to match Figure 8-8 and ensure the test bench always returns
the value 1.

[¢ *duc_test.c & = O
k /7 Lheck The result =/ Pl
int retl = system("diff --brief duc_i.dat golden/duc_i.d:
system("diff --brief duc_g.dat golden/duc_q.d:

i

62 int ret2 =

63

64  if (retl | ret2) {

65 printf("\n *** DUC hardware test FAILED ! *** \n\n");

66  } else {

67 printf("\n *** DUC hardware test PASSED ! *** \n\n");

68 1}

69

70 //return ((retl | ret2) ? 1 : @); i

?"_| return 1; =

72} E

73 7
4 | 1] ' P

Figure 8-8: Modified RTL Test Bench
5. Save the file.
6. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

High-Level Synthesis N send Feedback 176
UG871 (v2016.4) November 30, 2016 www.xilinx.com I—\ /—l



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=176

i: X”_INX Chapter 8: RTL Verification

ALL PROGRAMMABLE-

7. Click the Run C/RTL Cosimulation toolbar button to launch the Cosimulation Dialog
box.

8. Leave the Cosimulation options at their default value and click OK to execute the RTL
cosimulation.

When RTL cosimulation completes, the cosimulation report opens and says the verification
has failed (Figure 8-9).

= Simulation(solution1) & = B ||E Outline % I Directive v =8

. . . , An outline is not available.
Cosimulation Report for 'duc

Result

Latency Interval
RTL  Status min avg max min avg max
VHDL NA NA NA NA NA NA NA
Verilog Fail NA NA  NA NA NA NA

Export the repart(html) using the Export Wizard

B Console 2 . @] Errors| & Wamings %= #B~yiZ "0
Vivado HLS Console
INFO: [COSIM 212-3@2] Starting C TB testing ... -

*#% DUC hardware test PASSED | ***

CRITICAL WARNIMG: [COSIM 212-359] Aborting co-simulation: C TB simulation failed, nonzero return value '1'.
CRITICAL WARNING: [COSIM 212-328] C TB testing failed, stop generating test vectors. Please check C TB or re-run cosim.
CRITICAL WARNING: [COSIM 212-4] *** (/RTL co-simulation finished: FAIL ***
command 'ap_source' returned error codd
while executing
"source C:/Vivado HLS Tutorial/RTL Verification/labl/duc_prj/solutionl/cosim.tcl”
invoked from within
"hls::main C:/Vivado HLS_Tutorial/RTL_Verification/labl/duc_prj/solutionl/cosim.tcl"
("uplevel” body line 1)
invoked from within
"uplevel 1 hls::main {*}$args"
¢ I »

4 |11

Figure 8-9: Cosimulation Report Failure

In Figure 8-9, you can see from the message printed to the console (DUC har dwar e t est
PASSED) that the results are correct, however, the verification report says the RTL
verification failed.

If required, you can confirm the results are correct. To do this, compare the output files
created by the RTL simulation with the golden results. The RTL simulation is executed in the
simulation directory wrapc, which is inside the solution directory. Figure 8-10 shows the
solution directory, with the output files highlighted.
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{5 Explorer &3

i Includes
+ = Source
» = Test Bench
a = solution1
4 g constraints

4 directives.tcl
& scripttcl

> = csim
4 = s5im

+ = autowrap
» = report
A=A
4 = wrapc
l AESL_pkg.h

l¢] apatb_duc.cpp

l¢| apatb_duch
|5 apcc.log

b cosim.tv.exe
cosim.tv.mk

l¢| dds.c_pre.ctb.c

duc_ldat
duc_g.dat

m

Chapter 8: RTL Verification

l¢ duc_test.c_pre.ctb.c
duc.autotvin.dat
duc.autotvout.dat

lel duc.c_pre.ctb.c

lel imfl.c_pre.ctb.c

lel imf2.c_pre.ctb.c

Figure 8-10:

Cosimulation Output Files

RTL Cosimulation only reports a successful verification when the test bench returns a value
of 0 (zero). Modifying the test bench to return a non-zero value ensures RTL verification
(and C simulation if it was performed) would always report a failure.

To ensure that the RTL results are automatically verified: the C test bench must always check
the output from the C function to be synthesized and return a 0 (zero) if the results are

correct OR return any other value if they are not correct.

When RTL Verification is performed, the same testing occurs in the test bench, and the
output from the RTL block is automatically checked. This is why it is important for the C test
bench to check the results and return a zero value only if they are correct (or return a
non-zero value if they are incorrect).

9. Exit the Vivado HLS GUI and return to the command prompt.
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Lab 2: Viewing Trace Files in Vivado

This exercise explains how to generate RTL trace files and how to view them using the
Vivado Design Suite tools.

Step 1: Create an RTL Trace File using Vivado Simulator

1. From the Vivado HLS command prompt you used in Lab 1, change to the lab2 directory
as shown in Figure 8-11.

2. Create a new Vivado HLS project by typing vivado hls -f run hls.tcl.

@I [HLS5-10] Running 'C:/Xilinx/Uivado_HLS$/2014.1/bin/unwrapped/wing4.o/vivado_hl
Ss.exe’

for user ‘duncanm’ on host ‘xsjduncanm38’ (Windows NT_amd&4 version
6.1) on Tue Apr 08 15:46:41 -0T00 2014

in directory °'C:/Uivado_HLS_Tuterial/RTL_Uerification/labl’

@I [HLS-18] Bringing up Uivado HLS GUI ...

C:\Uivado_HLS_Tutorial\RTL_Uerification\labl>cd ..

C:\Uivado_HLS_Tutorial\RTL_Uerification>cd lab2

4 |1

C:\Uivado_HLS_Tutorial\RTL_Uerification\lab2>vuivado_hls -f run_hls.tcl

Figure 8-11: Setup for RTL Verification Lab 2
3. Open the Vivado HLS GUI project by typing vivado _hls -p duc_prj.
4. Click the Run C Synthesis toolbar button to synthesize the design to RTL.

5. Click the Run C/RTL Cosimulation toolbar button to launch the Cosimulation Dialog
box.

In this case, you will produce a trace file you can open using the Vivado Simulator.

6. In the Co-simulation Dialog box:
a. Leave the default auto selection (using Vivado Simulator and Verilog).

b. Activate the Dump Trace drop-down menu and select the all option, to have the
options shown in Figure 8-12.

c. Click OK to execute RTL cosimulation.
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¢# Co-simulation Dialog @

C/RTL Co-simulation

Verilog/VHDL Simulator Selection

Auto -

RTL Selection

@ Verilog () VHDL
Options

[] Setup Only

Dump Trace

[ Optimizing Compile

|| Reduce Diskspace

Compiled Library Location

Input Arguments

[] Do not show this dialog box again.

[ OK l l Cancel

Figure 8-12: Cosimulation Dialog Box for Lab 2

When RTL verification completes, the cosimulation report automatically opens. The report
shows that the Verilog simulation has passed (and the measured latency and interval). In
addition, because the Dump Trace option was used with the Vivado Simulator simulator
option and because Verilog was selected, two trace files are now present in the Verilog
simulation directory. These are shown highlighted in Figure 8-13.
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[t Explorer &2 = O
4 (= s5im &
» = autowrap
» = report
= tv
4 = verilog
“@ check_sim.tcl
ait duc_am_submul_16s_16s_18s_32 4v
st duc_ama_addmuladd_18s_18s_16s5 325 32 3w
rit duc_ama_submuladd_18s_18s_165_32s_32 3
duc_c_2 rom.dat

i

ad duc_c_2v

= duc_c_ 3 rom.dat

ad duc_c_3wv

= duc_imf2_c_ 1 rom.dat

rrd duc_imf2_c_lw

=l duc_imf2_shift_reg_p_ram.dat
st duc_imf2_shift_reg_p.v

it duc_imf2y

[

duc_imf3_c_0_rom.dat

duc_imf3_c 0w

E]
2
="

m

duc_imf3_c_rom.dat

[

E]
2
="

duc_imf3_cv
duc_imf3_shift_reg_p0_ram.dat
st duc_imf3_shift_reg_pO.v

[

rit duc_imf3.v

st duc_mac_muladd_18s_18s 38ns_38 4w
=l duc_mixer_dds_table_rom.dat

s duc_mixer_dds_tablew

= duc_mixer_DI_cache_ram.dat

s duc_mixer DI cachev

it duc_mixery

|=l duc_shift_reg_p_1_ram.dat

st duc_shift_reqg_p_lv

|=l duc_shift_reg_p_2_ram.dat

st duc_shift_reqg_p_2.v

sl duc.autotby
duc.performance.result.transaction.xml

= duc.prj

|5l ducresultlatrb

W ductcl

arit ducy

|5 ducwcfg

=l ducwdb gl

Figure 8-13: Verilog Vivado Simulator Cosimulation Results
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The next step is to view the trace files inside the Vivado Design Suite.

Since waveform trace data has been generated for the Vivado Simulator, the Open Wave
Viewer toolbar button is now highlighted, as shown in Figure 8-14.

Note: The Open Wave Viewer toolbar button can only be used when Vivado Simulator is selected
as the Verilog/VHDL Simulator.

File Edit Project Solution Window Help
X o REBWB BRI P Y @iHA-E

Figure 8-14: Opening the Trace File in Vivado

7. Click on the Open Wave Viewer toolbar button to open the Vivado IDE with the RTL
waveforms traces.

Note: The only functionality provided by the Vivado IDE by this action is the viewing and analysis of
RTL waveforms.

You can then view the waveforms in the waveform viewer. Figure 8-15 shows the zoomed
waveforms where the output data ports and their associated I/O protocol signals (output
valid signals) are expanded to view.
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& ducwdig* x

a2, Objects

o' Name

o B8 AESLclk_counter{31:0]
oY lhap_ck

bap_rst

b ap_start

¥ ap_done

3 Properties

b ap_idle
b ap_ready

8 ready_cnif31:0]
i ready_iniial
i ready_initial_n
i ready_last_n
i ready_delay_last_n
s dona_delay last n
i interface_done
B AESL_REG_din_i{17:0]
B AESL_REG_freq[15:0]
s AESL_REG_dout_i_ap_vid
B AESL_REG_dout_[17:0]
s AESL_REG_dout g ap vid |0
B AESL_REG_dout_q[17:0]
nap_ck

Baprst

'y ap_start
M din_[17:0]
0 M freq[15:0]

8. Exit the Vivado IDE.

Figure 8-15: Analyzing the RTL Trace File

9. Exit and close the Vivado GUI.

10. Type exit to close the Vivado Tcl command prompt.
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Lab 3: Viewing Trace Files in ModelSim

This exercise explains how you can generate and view RTL trace files and using the Mentor
Graphics ModelSim RTL simulator. Other third-party simulators are supported, and similar
process can be used if another RTL simulator is selected.

C CAUTION! This lab exercise requires that the executable for ModelSim is defined in the system search
path and that the required license to perform HDL simulation is available on the system.

Step 1: Create an RTL Trace File using ModelSim

1. From the Vivado HLS command prompt you used in Lab 2, change to the | ab3
directory.

Create a new Vivado HLS project by typing vivado _hls -f run hls.tcl.
Open the Vivado HLS GUI project by typing vivado hls -p duc_prj.
Click the Run C Synthesis toolbar button to synthesize the design to RTL.

v~ wWN

Click the Run C/RTL Cosimulation toolbar button to launch the Cosimulation Dialog
box.

This exercise uses the Mentor Graphics ModelSim RTL simulator. The path to the simulator
executable must be set in your system search path.

6. In the Co-simulation Dialog box:
a. Select ModelSim from the Verilog/VHDL Simulator Selector.
b. Select VHDL.

c. Activate the Dump Trace drop-down menu and select the all option, to have the
options shown in Figure 8-16.

d. Click OK to execute RTL cosimulation.
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¢# Co-simulation Dialog @

C/RTL Co-simulation

Verilog/VHDL Simulator Selection

ModelSim -

RTL Selection

() Verilog @ VHDL
Options

[] Setup Only

Dump Trace

[ Optimizing Compile

|| Reduce Diskspace

Compiled Library Location

Input Arguments

[] Do not show this dialog box again.

[ OK l l Cancel

Figure 8-16: Cosimulation Dialog Box for Lab 3

When RTL verification completes, the cosimulation report automatically opens, showing the
VHDL simulation has passed (and the measured latency and interval). In addition, because
the Dump Trace option was used with the ModelSim simulator option and because VHDL

was selected, a trace file is now present in the VHDL simulation directory. The trace file is
shown highlighted in Figure 8-17.
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s duc_c_l.whd

s duc_c.vhd

s duc_mul_175_18s_32 4.vhd

s duc_mul_18s_17ns_35_3.vhd

rrd duc_mul_18s 18s 36 3.vhd

sl duc_mul_19s_16s_32 3.vhd

s duc_shift_reg_p_lvhd

s duc_shift_reg_p.vhd

s duc.autotb.vhd
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st iImf2_shift_reg_p_2vhd -

Figure 8-17: VHDL ModelSim Trace File
The next step is to view the trace files inside ModelSim.

7. Exit the Vivado HLS GUI and return to the command prompt.

Step 2: View the RTL Trace File in ModelSim
1. Launch the Mentor Graphics ModelSim RTL Simulator.

2. Click the menu File > Open.

3. Select Log Files as the file type (Figure 8-18).
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4. Navigate to the VHDL simulation directory and select duc. Wl f.

5. Click Open.
ﬁOpenFiIe @
@Ov\ « 0SDik(C) » Vivado HLS Tutorial ¥ RIL Verfication » Iab3 ¥ duc_pj ¥ soutiond ¥ sim ¥ vhal b [ 4p[ Seorvnal Pl
Organize = New folder =+ 0 @
* Name Date modified Type Size
| work 3/6/2013452PM  File folder
ducwlf 3/6/2013 4:52PM  WLF File 3936 KB
.‘Lzl
|
.‘/
_J\', =
A
&
F v
File name: ducwlf v |LogFiles (~wif) v
’ Open ‘v Cancel ‘

Figure 8-18: ModelSim Open File WLF

6. Add the signals to the trace window and adjust to see a view similar to Figure 8-19.
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Figure 8-19: Viewing the Trace File in ModelSim

7. Exit and close the ModelSim RTL simulator.
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Conclusion

In this tutorial, you learned how to:

« Perform RTL verification on a design synthesized from C and the importance of the test
bench in this process.

« Create and open waveform trace files using the Vivado Design Suite.

« Create and open waveform trace files using a third-party HDL simulator (ModelSim)
and view the trace file created by RTL verification.
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Chapter 9

Using HLS IP In IP Integrator

Overview

You can package the RTL from High-Level Synthesis and use it inside IP Integrator. This
tutorial demonstrates how to take HLS IP and use it in IP Integrator as part of a larger
design.

This tutorial consists of a single lab exercise.

Lab 1 Description

Complete the steps to generate two HLS blocks for the IP catalog and use them in a design
with Xilinx IP, an FFT. You validate and verify the final design using an RTL test bench.

Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory Vi vado_HLS_Tut ori al \
Using IP with_IPI.

The design blocks in this tutorial process the data for a complex FFT.

« The Xilinx FFT IP block only operates on complex data. Although you can perform an
FFT of real data on a complex data set with all imaginary components set to zero, it can
be done more efficiently by pre-processing the data.

» The front-end HLS block in this lab applies a Hamming windowing function to the 1024
(N) real data samples and sends even/odd pairs to an N/2-point XFFT as though they
are complex data.

« The back-end HLS block takes bit-reverse ordered data, puts it in natural order and
applies an O(N) transformation to FFT output to extract the spectral data for the
N-point real data set. Note, the first output pair packs the Oth and 512th (purely real)
spectral data point into the real and imaginary parts, respectively.
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« The designs are fully pipelined, streaming designs for high throughput; intended for
continuous processing of data, but with throttling capability (stalls if input stalls).

« AXI4 Streaming interfaces are used to connect all blocks in IP Integrator (IPI).

Lab 1: Integrate HLS IP with a Xilinx IP Block

This lab exercise shows how two HLS IP blocks are combined with a Xilinx IP FFT in IP
Integrator and the design verified in the Vivado Design Suite.

ﬁ IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS_Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado HLS Tutorial directory.

Step 1: Create Vivado HLS IP Blocks

Create two HLS blocks for the Vivado IP Catalog using the provide Tcl script. The script runs
HLS C-synthesis, RTL co-simulation and package the IP for the two HLS designs
(hl's_real 2xfft and hl s_xfft2real).

1. Open the Vivado HLS Command Prompt.

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt.

o On Linux, open a new shell.

Vivado 20163
L Add Design Tools or Devices 2016.3
e Manage Xilinx Licenses
$5 uninstan 20163
B Vivado 20163 Tel Shell
d - Wivado 20063
Systemn Generator
Vivado HLS
B Vivado HLS 20163 Command Promp

« | Vivado HLS 20163 -

4  Back

Figure 9-1: Vivado HLS Command Prompt

2. Using the command prompt window, change the directory to
Vi vado_HLS Tutorial\Using_IP_with_IPI\Ilabl\hls_designs (Figure 9-2).

3. Typevivado _hls -f run hls.tcl to create the HLS IP (Figure 9-2).
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ZUivado_HLS _Tutorialrcd Using_IP_with_IPI

C:3wWivado_HLS _TutorialUsing_IP_with_IFI>cd labi

Figure 9-2:  Create the HLS Design for IPI

When the script completes, there are two Vivado HLS project directories, f e_vhl s_prj
and be_vhl s_prj, which contain the HLS IP, including the Vivado IP Catalog archives for
use in Vivado designs.

« The "front-end” IP archive is located at fe_vhl s_prj /| PXACTExport/inpl/ip/
e The "back-end” IP archive is located at be_vhl s_prj /1 PXACTExport/inpl/ip/

The remainder of this tutorial shows how the Vivado HLS IP blocks can be integrated into a
design (in IP Integrator) and verified.

Step 2: Create a Vivado Design Suite Project

1. Launch the Vivado Design Suite (not Vivado HLS):

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado 2016.3.

o On Linux, type vivado in the shell.

2. From the Welcome screen, click Create New Project (Figure 9-3).
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Figure 9-3: Create a Vivado Project

: Using HLS IP in IP Integrator
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3. Click Next on the first page of the Create a New Vivado Project wizard.

4. Click the ellipsis button to the right of the Project location text entry box and browse to

and select the tutorial directory (Figure 9-4).
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Figure 9-4. Path to the Vivado Design Suite Project

5. Click Next to move to the Project Type page of the wizard.

a. Select RTL Project.

b. Select Do not specify sources at this time (if not the default).

c. Click Next.

6. On the Default Part page, under Specify, click Boards and select the ZYNQ-7 ZC702
Evaluation Board, as shown in Figure 9-5 and press Next.
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¢ New Project @

Default Part

Choose a default Xilinx part or board for your project. This can be changed later. ‘
Select: @ Parts |@ Boards
4 Filter

Vendor: All -

Display Name: | All -

Board Rev: Latest A

Reset All Filters
Search: v
Display Mame Vendor Board Rev  Part /O Pin Count  File Version
@ ZedBoard Zynq Evaluation and Development Kit em.avnet.com d @ xc7z020clg484-1 484 1.3 1
@ Artix-7 AC701 Evaluation Platform xilinx.com kil % xc7a200tfbg676-2 676 1.2 3
@ Kintex-7 KC705 Evaluation Platform xilinx.com 1.1 @ xc7k325tffg900-2 900 1.2 4
M Kintex-Ultrascale KCU105 Evaluation Platform  xilinx.com 1.0 @ xcku040-ffvall56-2-2 1,156 1.1 £
@ Virtex-7 VC707 Evaluation Platform xilime.com 1.1 @ xcAnastffg1761-2 1,761 1.2 1
@ Virtex-7 VC709 Evaluation Platform xilinx.com 1.0 & xcIvx690tfigl1761-2 1,761 1.7 1
@ Virtex-Ultrascale VCU108 Evaluation Platform  xilinx.com 1.0 @ xowu095-ffva2104-2-e-es2 2,104 1.0 1
' Z¥YNQ-7 ZC702 Evaluation Board i xc72020clg484-1 i
@ Z¥NQ-7 ZC706 Evaluation Board xilinx.com 1.1 @ xc7z045ffgo00-2 900 1.2 g
<| i} =
[ <Back || Next> 1§ Finish

Figure 9-5. Vivado Project Specification

7. On the New Project Summary Page, click Finish to complete the new project setup.

The Vivado workspace populates and appears as shown in Figure 9-6.
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Figure 9-6:

Vivado Project

Step 3: Add HLS IP to an IP Repository

1. In the Project Manager area of the Flow Navigator pane, click IP Catalog.
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Figure 9-7. Open the IP Catalog
2. The IP Catalog appears in the main pane of the workspace. Click the IP Settings icon.
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Figure 9-8: Open the IP Catalog Settings

3. In the IP section of the Project Settings dialog, select the Repository Manager tab and
click on the “+" symbol to Add Repository.

4. In the IP Repositories dialog:

a. Browse to the tutorial directory,

Using IP_ with_IPI\labl\hls_designs\fe_vhls_prj\IPXACTExport\im
pl \'i p as shown in Figure 9-9.
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b. Click Select to close the IP Repositories window.

¢ [P Repositories @
Recent: |1 C:/Vivado_HLS_Tutorial/Using_IP_with_IPY/labi/his_designs/fe_vhis_pri/IPXACTExport/impl..v (7 = 54 W | X I 2 5

Directory: |C:\Vivado_HLS_Tutorial\ L5yl BT 1

T\lab1\hls_designs\fe_vhls_prj

= | Vivado_HLS_Tutorial "
--, Arbitrary_Precision
i | C_Validation
--, Design_Analysis
--, Design_Optimization
--, Interface_Synthesis
--, Introduction Al
[ | RTL_Verification
5| Using_IP_with_IPI
B | lab1
B Xi
| hls_designs
--, be_vhls_prj
= | fe_vhls_prj
5 | PXACTExport
--, .autopilot

111

| csim
B--, impl
Xil
bd
| constraints -
doc

l Select H Cancel ]

Figure 9-9: Create a New IP Repository
5. Press Select to accept the new repository.

6. Follow the same procedure to add the second HLS IP package:
| abl/ hl s_desi gns/ be_vhls_prj /1 PXACTExport/inpl/ip/.

7. Click OK to exit the dialog box.

A Vivado HLS IP category now appears in the IP Catalog as HLS IP (Figure 9-10).
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Figure 9-10: IP Catalog with HLS IP

Step 4: Create a Block Design for RealFFT
1. Click Create Block Design under IP Integrator in the Flow Navigator.
a. In the resulting dialog box, name the design Real FFT.

b. Click OK.
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Figure 9-11:

Cafis:

Pre-Frodircfinn

Create Block Design

The upper-right pane now has a Diagram tab. Add a Xilinx FFT IP block to the design and

customize it.

2. In the Diagram tab click the Add IP link (Figure 9-12).

a. In the Search box type fouri er.

b. Select Fast Fourier Transform.

c. Press Enter.
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Figure 9-12: Add the Xilinx FFT IP

The Xilinx IP block FFT is now instantiated in the design, as shown in Figure 9-13.
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Figure 9-13:  Xilinx FFT IP

3. Double-click the new Fast Fourier Transform IP symbol to open the Re-customize IP
dialog box.

4. On the Configuration tab (Figure 9-14):
a. Change the Transform Length to 512.

b. Select Pipelined, Streaming 1/0 in the Architecture Choice section.
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Figure 9-14: Xilinx FFT Configuration
5. Select the Implementation tab (Figure 9-15):
a. Select ARESETN (active low) in the Control Signals group.
b. Verify that Non Real Time is selected as Throttle Scheme.

c. Click OK to exit the Re-customize IP dialog box.
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Figure 9-15: Xilinx FFT Implementation

Add one instance of each of the HLS generated blocks to the design.

6. Right-click in any space in the canvas and select Add IP (Figure 9-16).
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Figure 9-16: Add IP Blocks
7. Type “hls” into the Search text entry box.
a. Highlight both IPs. (Click the control key and select both.)

b. Press Enter.

The design block now has three IP blocks, as shown in Figure 9-17.
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Figure 9-17: RealFFT IP Blocks
The next step is to connect HLS blocks to the FFT block and ports.

8. Hover the cursor over the dout interface connector of the Hl s_r eal 2xftt block until
pencil cursor appears.

a. Left-click and hold down the mouse button to start a connection.

b. Drag the connection line to the S_AXIS_DATA port connector of FFT block and
release (when green check mark appears next to it).

9. In a similar fashion, connect the FFT's M_AXIS_DATA interface to the din interface of
the H s_xfft 2real block.

The two connections are shown in Figure 9-18.
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Figure 9-18:

Connecting Ports on the IP Blocks

To create I/O ports for the design, make some external connections.

10. Right-click the din_V_V interface connector on the hl s_r eal 2xfft block and select

Make External (Figure 9-19).
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Figure 9-19: Make External Connections
11. Give the new interface port a clearly unique name.
a. Click the port symbol to highlight it.

b. In the External Interface Properties pane (Figure 9-20), click in the Name text entry
box to highlight din_V.

c. Typereal 2xfft_di n and press Enter.

f IMPORTANT: Property changes might not take effect if this re-naming step is not done.
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12.In a similar manner to the previous step:

a.

Chapter 9: Using HLS IP in IP Integrator
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[ & RealFFT

real 2xfft_din
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CCROQM LY BHLOOTE LR

Port Naming

Make the dout _V interface of the H s_xf ft 2real block external and rename it

xfft2real _dout.

13. Right-click the acl k connector of FFT block and select Make External.

14. Right-click the ar eset n connector of the FFT block and select Make External.

15. Tie the ap_st art ports of both HLS blocks High.

a.

b.

Right-click the canvas and select Add IP.
Type const into the Search text entry box.

Select Constant IP.

Double-click the Constant IP symbol (Figure 9-21) and verify that Const Width and

Const Val are set to 1.
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Figure 9-21: Constant IP Properties

f. Expand the ap_ctr| bus port on both hl s_xfft2real and hl s_real 2xfft
(click the plus symbol associated with each port).

g. Connect ap_start in both HLS blocks to the Constant block (Figure 9-22).
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Figure 9-22: Connect AP_START to Constant
16. Make the remaining connections.

a. Click and drag from the acl k connector of hl s_real 2xfft and hl s_xfft 2real
blocks to the acl k external port (or acl k connector on FFT block or anywhere on
“wire"” connecting them).

b. Connectap_rst_n of the hl s_real 2xfft and hl s_xfft 2real blocks to the
ar eset n network.

17. Click the Regenerate Layout icon to clean up and reorganize the Block Design.
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Figure 9-23: Re-generated Design Diagram

18. Click the Validate Design button to validate the design is correct.

The vlaidate design will show some warnings. These are related to the s_axis_config pin of
the FFT.

a. The XFFT configuration interface is left unconnected because this design always
operates in the default mode of the core.

b. Click OK to close the messages..
19. Click File > Save Block Design.
20. Close the Block Design.
21. The next step is to generate output products.

a. Inthe Sources tab of Project Manager pane (Figure 9-24), right-click RealFFT.bd and
select Generate Output Products.

b. Click Generate in the resulting dialog to initiate the generation of all output
products.

c. Select OK to ignore the warnings discussed above.
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Figure 9-24. Generating Output Products
22. Create an HDL Wrapper.

a. Inthe Sources tab of the Project Manager pane, right-click Real FFT. bd and select
Create HDL Wrapper. (This is the same procedure and menu as described in the
previous step.)

b. Click OK and let Vivado manage the wrapper.

Step 5: Verify the Design

The next step in creating the final design is to verify design with the HDL test bench
provided in the lab exercise: real fft_rtl _tb.v.

1. Right-click Simulation Sources in the Sources tab of the Project Manager pane
(Figure 9-25).

2. Select Add Sources.

High-Level Synthesis N send Feedback 213
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—l



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=213

8 X”_INX Chapter 9: Using HLS IP in IP Integrator

ALL PROGRAMMABLE-~

P F T O TR LSS | ISUMAR LAk L Y
Black Drsign  RealFFT

Sources = 012 % || [Famegan x| @ Realn

= sk B | Ciiekniponsliiis 1

=i D Sources (1 W 1 'T“_""f"m"‘ 1y
S if gw PealFFT_wrapper (FosFRT 2 Lib IP_Inte

00 Corstrainks (1 N Jmodule RealFFT

o Gl 4 Anelk,

Ltr w| 3 acess b,

Hierarchy Update ¥ '-'-.. L] ceal?uEEL o

.l 7 eral2wdffn

& Hefresh Hierarchy x| 8 cealZefrt

Edit Camstraints Sets... I 9 Eeal2cEEE o

Edit Simulatinn Sets... sz | 10 pealizflfn

(Ll xEETZreal

& dd Sourcer.. Bl 412 uffrareal i

.| 13 sEfviceal o

el TP xEETETeal

| ‘;_ 15 sefrdreal
Hierarchy | [P Sources | Libraries | Compds Order W 16 ipput aclk:

o T T—— _ |47 input aressm

e |18 drpur [31:07

Fropesties - O X P19 doput [3:0]w

= %5k |20 input [0:0]8

21  ougpue reald

Figure 9-25: Adding Simulation Sources
3. Select Add or Create Simulation Sources in the Add Sources dialog box.
4. Click Next.
5. In the Add Sources dialog box, click the “+" symbol Figure 9-26 and select Add Files.
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Figure 9-26: Add Source Dialog Window

6. Browse to the filereal fft_rtl _tb. v in the tutorial directory
Using IP with IPI\labl\verilog_tbh.

7. Select it and click OK.
8. Select the checkbox Copy sources into the project (Figure 9-27).
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Figure 9-27: Copy Design Sources

Note: When you copy the design source files into the project, edits to the file(s) are not
automatically propagated to the original source file.

9. Click Finish.

10. Click Run Simulation in the Flow Navigator (Figure 9-28) and select Run Behavioral
Simulation.
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1F IP Calaiog
4 1P Integrator
5 Creabe Biock Design
% Open Rlock Design
4 Sinulation
@ Srdstion Settings

o Semulstion |1
Fun Behraord Srdstion
4 [T

Figure 9-28: Execute Simulation

11. Once the simulation has started, click the Run All icon to complete simulation.
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Figure 9-29: Run the Simulation to Conclusion

In this tutorial, you learned:

+ How to create Vivado HLS IP using a Tcl script.

« How to import a created design using IP integrator (IPI) and include both Xilinx IP and

the Vivado IP blocks.
« How to verify the design in IPL
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Chapter 10

Using HLS IP in a Zynq AP SoC Design

Overview

A common use of High-Level Synthesis design is to create an accelerator for a CPU - to
move code that executes on the CPU into the FPGA programmable logic to improve
performance. This tutorial shows how you can incorporate a design created with High-Level
Synthesis into a Zynq device.

This tutorial consists of two lab exercises:

Lab 1 Description

You create and configure a simple HLS design to work with the CPU on a Zynq device. The
HLS design used in this lab is simple to allow the focus of the tutorial to be on explaining
the connections to the CPU and how to configure the software drivers created by
High-Level Synthesis to control the device and manage interrupts.

Lab 2 Description

This lab illustrates a common high performance connection scheme for connecting
hardware accelerator blocks that consume data originating in the CPU memory and/or
producing data destined for it in a streaming manner. The lab highlights the software
requirements to avoid cache coherency issues.

Tutorial Design Description

You can download the tutorial design file can be downloaded from the Xilinx Website. See
the information in Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory Vi vado_HLS_Tut ori al \
Usi ng_I P_wi t h_Zynq.

The sample design is a simple multiple accumulate block. The focus of this tutorial exercise
is the methodology, connections and integration of the software drivers. (The tutorial does
not focus on the logic in the design itself.)
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Lab 1: Implement Vivado HLS IP on a Zynq Device

This lab exercise integrates both the High-Level Synthesis IP and the software drivers
created by HLS to control the IP in a design implemented on a Zynq device.

IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial. If the tutorial data
directory is unzipped to a different location, or on Linux systems, adjust the few pathnames referenced,
to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create a Vivado HLS IP Block

1. Open the Vivado HLS Command Prompt.

o

On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado HLS > Vivado HLS 2016.3 Command Prompt (Figure 10-1).

On Linux, open a new shell.

Vivado 2016.3
= Add Design Tools or Devices 2016.3
av Manage Xilinx Licenses
$: Uninstall 20163
Wivado 2006.3 Tel Shel
0E3

System Generator
Vivado HLS
Bl Vivado HLS 20163 Command Promp

Figure 10-1: Vivado HLS Command Prompt

2. Using the command prompt window, change the directory to
Vi vado_HLS_Tutorial\Using_I P_w th_Zynqg\l abl\ hl s_macc (Figure 10-2).

3. Type vivado hls -f run hls.tcl to create the HLS IP (Figure 10-2).

ZWivado_HLS _Tutorial»
SMUivade HLS Tutorial’,
C:\Uivado HLS Tutorisly

C:\Uivado HLS _Tutorial®,

Figure 10-2:

High-Level Synthesis
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cd Using_IP_with_2Zyng
Using_IF_with_2yngred labl

Using_IF_with_Zyngilablrcd hls_macc

Using_IP_with_2yngilabli\hls_maccruivado_hls -f run_hls. tofg

Create the HLS Design
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When the script completes, there is a Vivado HLS project directory vhl s_prj, which
contains the HLS IP, including the Vivado IP Catalog archive for use in Vivado designs.

The remainder of this tutorial exercise shows how the Vivado HLS IP blocks can be
integrated into a Zynq design using IP Integrator.

Step 2: Create a Vivado Zynqg Project

1. Launch the Vivado Design Suite (not Vivado HLS):

o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado 2016.3.

o On Linux, type vi vado in the shell.

2. From the Welcome screen, click Create New Project (Figure 10-3).

Bl Fiow Tooh yedow |jiip

VIVADO! £ XILINX

Quick Start
¥
i
b !E
Creale biw Frogss Dpen Projec Coen Example Frojpes
Tasks
| ¥
Hgnage F R HErBAR s Mg Xl Tl Sloew
Information Center
#; G
<9 [# -
Qacumentatind mid Tulinis Quick Tikie Wideod Helgase |iohed Cuide
d Corly

Figure 10-3: Vivado Welcome Screen
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3. In the New Project wizard:
a. Click Next.

b. In the Project Location text entry box, browse to the location of the tutorial file
directory Usi ng_I P_wi t h_Zynqg\ | abl and click Next (Figure 10-4).

c. On the Project Type page, select RTL Project and Do not specify sources at this
time (if it is not the default).

d. Click Next.
4. New Project ===
Project Name
Enter & name for your project and specify a directory where the project data files will be stored ‘q'_,,

Froject name:  project_1
Project lecation: | C/Vivado_HLS_Tuterial/Using_IP_with_Zyng/labll
+ Create project subdirectory

Froject will be created at: C:/vivado_HLS_Tutoriad/Using_IF_with_Zyng/labl/project_1

[ < Back Huewd = (I [ Cancal ]

Figure 10-4: Specify the Vivado Project Directory
4. On the Default Part page:
a. Click Boards.
b. Select the ZYNQ-7 ZC702 Evaluation Board (Figure 10-5).
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#. New Project =
Default Part
Choose a default Xilinx part or board for your project. This can be changed later. '

Select: @ Parts |@ Boards

4 Filter

Vendor: All hd

Display Name: | All -

Board Rev: Latest hd

Reset All Filters
Search: | L
. ' ) ' Avali

Display Name Vendor Board Rev  Part /O Pin Count  File Version 0B
@ ZedBoard Zynq Evaluation and Development Kit em.avnet.com d @ xc72020clg484-1 484 1.3 200
@ Artix-7 AC701 Evaluation Platform xilinx.com kil @ xc7a200tfbg676-2 676 1.2 400
@ Kintex-7 KC705 Evaluation Platform xilinx.com 1.1 @ xc7k325tffga00-2 900 1.2 500
M Kintex-Ultrascale KCU105 Evaluation Platform  xilinx.com 1.0 @ xckuo40-fival156-2-e 1,156 1.0 520
@ Virtex-7 VC707 Evaluation Flatform xilinx.com 1.1 @ xc7wndB5tifg1761-2 1,761 1.2 700
@ Virtex-7 VC709 Evaluation Flatform xilinx.com 1.0 @ xc7vxR90tfgl761-2 1,761 1.6 850

¢ 7YNQ-7 ZC702 Evaluation Board bdlinccom — [1.0 [

B 7YNQ-7 ZC706 Evaluation Board xilinx.com 1.1 @ xc7z045ffgo00-2 900

1.2

362

4 i | =

’ < Back ” Mext = ] Finish

Figure 10-5: Specify the Vivado Project Details
a. Click Next.

b. Click Finish on the New Project Summary Page.

The project workspace opens as shown in Figure 10-6.
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Figure 10-6:

Initial Vivado Zynq Project

Step 3: Add HLS IP to the IP Catalog

1.

High-Level Synthesis
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In the Project Manager area of the Flow Navigator pane, click IP Catalog.
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Figure 10-7: Open the IP Catalog

The IP Catalog appears in the main pane of the workspace.

2. Click the IP Settings icon (Figure 10-8).

1@ 8| E GBS oo ek Layouk - W | &)
Project Manmsger  peoject 1
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Figure 10-8: Open the IP Catalog Settings

3. In the IP section of the Project Settings dialog box, click the "+" symbol to Add
Repository.

4. In the IP Repositories dialog box:

a. Browse to the location of the IP created by Vivado HLS,
Using_IP_with_Zynqg\lab1\hls_macc\vhls_prj\solutionI\impN\ip and click Select.

High-Level Synthesis N send Feedback 224
UG871 (v2016.4) November 30, 2016 www.xilinx.com l—\ /—I



http://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG871&Title=Vivado%20Design%20Suite%20Tutorial%3A%20High-Level%20Synthesis&releaseVersion=2016.4&docPage=224

8 X”_INX Chapter 10: Using HLS IP in a Zynq AP SoC Design

ALL PROGRAMMABLE-~

¢ Project Settings | 23 |
’ P
w i _g_g_rls._*[ql"' Repository Manager I'Eackager [
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Elaboration 1
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Synthesis

v

Implementation
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Bitstream
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Refrash All
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Figure 10-9: IP Repository
5. Click OK to close the IP repository manager.
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Figure 10-10: HLS IP in the Repository
6. There is now an HLS IP in the IP Catalog, HLS_macc.

Step 4: Creating an IP Integrator Block Design of the System
1. In the IP Integrator area of the Flow Navigator, click Create Block Design and type
Zynq_Desi gn in the dialog box.
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Figure 10-11: Create the Zynq Design

The Block Design view opens in the main pane, with a new Diagram tab, containing a blank
Block Design canvas.

2. Press the Add IP button on the main screen open the IP search dialog.
a. Type zynq into the Search text entry box.
b. Select ZYNQ7 Processing System and press Enter.
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Figure 10-12: Add a CPU Processor to the Design
An IP symbol for the ZYNQ7 Processing System appears on the canvas.
3. Double-click the ZYNQ IP symbol to open the associated Re-customize IP dialog box.
a. Click the Presets icon and select ZC702 (Figure 10-13).
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Figure 10-13: Configure the Zynq AP SoC
4. Click MIO Configuration in the Page Navigator pane.
a. Expand the Application Processor Unit tree view.

b. Deselect Timer O (or any other timers if they are selected).
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Figure 10-14: Zynq AP SoC MIO Configuration
5. Click Interrupts in the Page Navigator pane.
a. Select Fabric Interrupts and expand its tree view.

b. Select IRQ_F2P[15:0] and click OK to close the Re-customize IP dialog box.

# Re-customize IP
Z¥YNQ7 Processing System (5.01)

ﬁ Documentation [ IP Lacation @ Presets

Page MNavigator Eoe |Interrupts
Zynq Black Design & Search; | ©,
P5-PL Configuration Z Interrupt Port ) Description
g | B Fabric Interrupts Enable PL Interrupts ko PS5 and vi
MID Configuration =
I TR , [68:... [Enables 16-bit shared interrupt m
- ore0_n nables Fast private interrupt sig
anle Yiew Cored_nFIQ) 28 Eniables Fast private interrupt si
ek G ~ [ Cored_nIRQ 31 Enables private interrupt signal fo
i orel_n nables Fast private interrupt sig
: Corel_nFIG i} Enables Fast private inf L s
DOR. Configuration w [[] Caorel_nIRQ 31 Enables private interrupt signal f
=+ PS-PL Inkerrupt Parts
SMIC Timing Calculation IRG_P2F_DMAC_ABORT Enables shared interrupt abart si;
IRG_P2F_DMACD Enables shared interrupt signal 0
Interrupts IRG_P2F_DMACL Enables shared interrupt signal 1
IRG_P2F_DMACZ Enables shared interrupt signal 2

Figure 10-15: Zynqg AP SoC Interrupt Configuration

IPI provides Designer Assistance to automate certain tasks, such as making the correct
external connections to DDR memory and Fixed I/O for the ZYNQ PS7.
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6. Click the Run Block Automation link under the title bar (Figure 10-16).
a. Ensure processing_system7_0 is selected.

b. Ensure Apply Board Presets is deselected. If this remains selected it re-applies the
timers that were disabled in step 4 and results in additional ports on the Zynq block
in Figure 10-16.

c. Click OK to complete in the resulting dialog box.

%= Diagram X | B Address Editor X ——
#] 4 Zynq_Design

Q¢| (% Designer Assistance available. Run Block Automation

¢ Run Block Automation =

Automatically make connections in your design by checking the boxes of the blocks to connect. Select a block on the left to display its
configuration options on the right. ‘

@, |[=H{] All Automation (2 out of 1 selected) Description

4
™
E
a
%
L]
5
I

N Zyng7 block automation applies current board preset and generates external
= connections for FIXED_IO, Trigger and DDR interfaces.

WOTE: Apply Board Preset will discard existing IP configuration - please uncheck
this box, if you wish to retain previous configuration.

Instance: [processing_system?7_0

Options
Make Interface External: FIXED IO, DDR

e Mg itHA L I m|EA

& Apply Board Preset: I
i
B Cross Trigger In: Disable
Cross Trigger Out: Disable -
l 0K H Cancel l
4 b

Figure 10-16: Run Automation
7. To add HLS IP to the design:
a. right-click in an open space of canvas and select Add IP from the context menu.

b. Type hl s in the Search text entry box and press Enter to add it to design
(Figure 10-17).
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Figure 10-17: Processor and HLS IP

[ LI

Designer assistance is also available to automate the interconnection of IP blocks.

8. Click the Run Connection Automation link at the top of the canvas.

9. Select/hls_macc_0/S_AXI _HLS_MACC_PERI PH_BUS and click OK in the resulting
dialog box to automatically connect the HLS IP to the M_AXI _GPO0 interface of the Zynq
Processor.

This adds an AXI Interconnect (block instance: processi ng_syst em7_0), a Proc Sys Reset
block and makes all necessary AXI related connections to create the design shown in

Figure 10-18.
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Figure 10-18: Design with AXI4 Interconnect

The only remaining connection necessary is from the HLS interrupt port to the PS7
| RQ_F2P port.

10. Mouse over the interrupt pin on the hl s_macc_0 IP symbol. When the cursor changes
to pencil shape, click and drag to the | RQ_F2P[ 0: 0] port of the PS7 and release,
completing the connection.

11. Select the Address Editor tab and confirm that the hl s_macc_0 peripheral has been
assigned a master address range. If it has not, click the Auto Assign Address icon.

&= Diagram x | B Address Editor x o x

A el Slave Interface  Base Name  Offset Address Range  High Address

e
e [=HF processing_system7_0
% Bﬂ Data (32 address bits : 0x40000000 [ 1G ])

“m hls_mace_0 s_axi_HLS_MA... Reg 0x43C0_0000 64K v 0x43C0_FEFF

R

Figure 10-19: Address Editor

The final step in the Block Diagram design entry process is to validate the design.

12. Click the Validate Design icon in the toolbar.

13. Upon successful validation, save the Block Design.
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Step 5: Implementing the System

Before proceeding with the system design, you must generate implementation sources and
create an HDL wrapper as the top-level module for synthesis and implementation.

1. Return to the Project Manager view by clicking on Project Manager in the Flow
Navigator.

2. In the Sources browser in the main workspace pane, a Block Diagram object called
Zynqg_Desi gn is at the top of the Design Sources tree view (Figure 10-20). Right-click
this object and select Generate Output Products.

3. In the resulting dialog box, click Generate to start the process of generating the
necessary source files.

File Fdit Fow Tools: Window Lapoul View  Help

SRR BeRh X Py &K L G| E oo - ek D
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9 & B i 1
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3 - =
3 Froject Settings = Desingn Sourons sa|l=} ] processing_system?_0
SRy Desig M Data (32 address bat
‘ﬁ' Aadd Bources ; Constraints o Spurce Node Properties... Ctr+E w hls_mace_
W Language Templabes == Simulation Sourcd *  Open File Alt=0)
1F 1 catalog & sm_1 (1 Create HOL Wrapper...
Wiewr Insdantiation Temglate
4 IP Integrator =
. Generate Output Products...
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Hesat Output Froducts...
2 Qpen Block Design pu
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Figure 10-20: Generate Output Producs

4. Right-clickthe Zynq_Desi gn object again, select Create HDL Wrapper, and click OK to
exit the resulting dialog box.

The top-level of the Design Sources tree becomes the Zynq_Desi gn_wr apper . v file. The
design is now ready to be synthesized, implemented and to have an FPGA programming
bitstream generated.
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5. Click Generate Bitstream to initiate the remainder of the flow.
a. Click Yes to implement the design.

6. In the dialog that appears after bitstream generation has completed, select Open
Implemented Design and click OK.

Step 6: Developing Software and Running it on the ZYNQ
System

You are now ready to export the design to Xilinx SDK. In SDK, you create software that runs
on a ZC702 board (if available). A driver for the HLS block was generated during HLS export
of the Vivado IP Catalog package. This driver must be made available in SDK so that the PS7
software can communicate with the block.

1. From the Vivado File menu select Export > Export Hardware.

Note: Both the IPI Block Design and the Implemented Design must be open in the Vivado
workspace for this step to complete successfully.

2. In the Export Hardware dialog box (Figure 10-21), ensure that the Include Bitstream is
enabled and click OK.

4. Export Hardware =

Export hardware platform for software
development tools.

Figure 10-21: Export Hardware Dialog Box
3. From the Vivado File menu, select Launch SDK.
4. Click OK to open SDK.
5. From the SDK File menu, select New > Application Project.
a. In the New Project dialog enter the project name Zynq_Desi gn_Test .
b. Click Next.
c. Select the Hello World template.
d. Click Finish.
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Figure 10-22: Application Project

6. Power up the ZC702 board and test the Hello World application. Ensure the board has all
the connections to allow you to download the bitstream on the FPGA device. See the
documentation that accompanies the ZC702 development board.

7. Click Xilinx Tools > Program FPGA (or toolbar icon).

Notice that the Done LED (DS3) is now on.

8. Setup a Terminal in the tab at bottom of workspace:

a. Click the Connect icon (Figure 10-23).
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Figure 10-23: The Connect Icon
b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected (generally not COM1
or COM3). On Windows, if you are not sure, open the Device Manager and identify
the port with the Silicon Labs driver under Ports (COM & LPT).

d. Change the Baud Rate to 115200 (Figure 10-24).
e. Click OK to exit the Terminal Settings dialog box.

i Terrninal Settings ]

Wirw Setings:
Wiew Tible;  Terminal 1

Encoding: [90-D059-1 -

Connection Type:

Senal s
Setting s
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Seop Bits: :L v:
Fanty: _.Nl.lnr -'._
Flerae Contral: .Nnru- -

Timeaut (sec): 5

0K | Cancel

Figure 10-24: Terminal Settings

9. Right-click the application project Zynq_Design_Test in the Explorer pane
(Figure 10-25).

a. Click Run As > Launch on Hardware.
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Figure 10-25: Run the Application Project

10. Switch to the Terminal tab and confirm that Hel | o Wér | d was received.
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Figure 10-26: Console Output
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Step 7: Modify software to communicate with HLS block

The completely modified source file is available in the ar m_code directory of the tutorial
file set. The modifications are discussed in detail below.

1.
2.

High-Level Synthesis

Open the hel | owor | d. ¢ source file.

Several BSP (and standard C) header files need to be included:

#include <stdlib.h> // Standard C functions, e.g. exit()

#include <stdbool.h> // Provides a Boolean data type for ANSI/ISO-C
#include "xparameters.h" // Parameter definitions for processor peripherals
#include "xscugic.h" // Processor interrupt controller device driver
#include "xHls macc.h" // Device driver for HLS HW block

Define variables for the HLS block and interrupt controller instance data. The variables
will be passed to driver API calls as handles in the respective hardware.

// HLS macc HW instance
XHls_macc HlsMacc;

//Interrupt Controller Instance
XScuGic ScuGic;

Define global variables to interface with the interrupt service routine (ISR).

volatile static int RunHlsMacc = 0;
volatile static int ResultAvailHlsMacc = 0;

Define a function to wrap all run-once API initialization function calls for the HLS block.

int hls macc_init (XHls macc *hls maccPtr)
XHls_macc_Config *cfgPbtr;
int status;

cfgPtr = XHls macc_LookupConfig (XPAR XHLS MACC 0 DEVICE ID) ;

if (lcfgPtr) {
print ("ERROR: Lookup of accelerator configuration failed.\n\r");
return XST_ FAILURE;

}
status = XHls _macc_CfgInitialize(hls_maccPtr, cfgPtr);
if (status != XST SUCCESS) {

print ("ERROR: Could not initialize accelerator.\n\r");
return XST FAILURE;

}

return status;

}

Define a helper function to wrap the HLS block API calls required to enable its interrupt
and start the block.

void hls macc_start (void *InstancePtr) {
XHls macc *pAccelerator = (XHls macc *)InstancePtr;
XHls macc_InterruptEnable (pAccelerator,1);
XHls macc_InterruptGlobalEnable (pAccelerator) ;
XHls_macc_Start (pAccelerator) ;
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An interrupt service routine is required in order for the processor to respond to an interrupt
generated by a peripheral.

Each

peripheral with an interrupt attached to the PS must have an ISR defined and

registered with the PS’s interrupt handler.

The ISR is responsible for clearing the peripheral’s interrupt and, in this example, setting a
flag that indicates that a result is available for retrieval from the peripheral. In general, ISRs
should be designed to be lightweight and as fast as possible, essentially doing the
minimum necessary to service the interrupt. Tasks such as retrieving the data should be left
to the main application code.

void hls macc_isr(void *InstancePtr) {

}

XHls_macc *pAccelerator = (XHls macc *)InstancePtr;

//Disable the global interrupt

XHls macc_InterruptGlobalDisable (pAccelerator) ;
//Disable the local interrupt

XHls macc_InterruptDisable (pAccelerator, OXff£f£ff£ff) ;

// clear the local interrupt
XHls macc_InterruptClear (pAccelerator,1);

ResultAvailHlsMacc = 1;
// restart the core if it should run again
if (RunHlsMacc) {

hls macc_start (pAccelerator) ;

}

7. Define a routine to setup the PS interrupt handler and register the HLS peripheral’s ISR.

int setup_interrupt ()

{

High-Level Synthesis

//This functions sets up the interrupt on the ARM
int result;
XScuGic_Config *pCfg = XScuGic_LookupConfig (XPAR SCUGIC_ SINGLE_DEVICE_ID) ;
if (pCfg == NULL) {

print ("Interrupt Configuration Lookup Failed\n\r");

return XST_ FAILURE;
}
result = XScuGic CfgInitialize (&ScuGic,pCfg,pCfg->CpuBaseAddress) ;
if (result != XST SUCCESS) {

return result;
}
// self-test
result = XScuGic_SelfTest (&ScuGic) ;
if (result != XST SUCCESS) {

return result;
}
// Initialize the exception handler
Xil_ ExceptionInit () ;
// Register the exception handler
//print ("Register the exception handler\n\r") ;
Xil ExceptionRegisterHandler (XIL EXCEPTION ID INT,

(Xil ExceptionHandler)XScuGic_ InterruptHandler, &ScuGic) ;

//Enable the exception handler
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Xil ExceptionEnable() ;
// Connect the Adder ISR to the exception table
//print ("Connect the Adder ISR to the Exception handler table\n\r");
result = XScuGic Connect (&ScuGic, XPAR FABRIC HLS MACC 0 INTERRUPT INTR,
(Xil_InterruptHandler)hls macc_isr, &HlsMacc) ;
if (result != XST SUCCESS) {
return result;
}

//print ("Enable the Adder ISR\n\r");
XScuGic_ Enable (&ScuGic,XPAR FABRIC HLS MACC 0 INTERRUPT INTR) ;
return XST SUCCESS;

8. Define a software model of the HLS hardware functionality with which you can compare
reference results.

void sw _macc(int a, int b, int *accum, bool accum clr)

{

}

static int accum reg = 0;
if (accum_clr)

accum_reg = 0;
accum _reg += a * b;
*accum = accum_reg;

9. Modify main() to use the HLS device driver API and the functions defined above to test
the HLS peripheral hardware.

int main()

{

High-Level Synthesis

print ("Program to test communication with HLS MACC peripheral in PL\n\r");
int a = 2, b = 21;

int res hw;

int res sw;

int 1i;

int status;

//Setup the matrix mult
status = hls macc_init (&HlsMacc) ;

if (status != XST SUCCESS) {
print ("HLS peripheral setup failed\n\r");
exit (-1);

}

//Setup the interrupt

status = setup_ interrupt();

if (status != XST SUCCESS) {
print ("Interrupt setup failed\n\r");
exit (-1);

}

//set the input parameters of the HLS block
XHls macc_SetA(&HlsMacc, a);

XHls macc_SetB(&HlsMacc, b);

XHls macc_ SetAccum clr (&HlsMacc, 1);

if (XHls_macc_IsReady (&HlsMacc))
print ("HLS peripheral is ready. Starting... ");
else {
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print ("!!! HLS peripheral is not ready! Exiting...\n\r");
exit (-1);

}

if (0) { // use interrupt
hls macc_start (&HlsMacc) ;
while (!ResultAvailHlsMacc)
i // spin
res hw = XHls macc_GetAccum(&HlsMacc) ;
print ("Interrupt received from HLS HW.\n\r") ;
} else { // Simple non-interrupt driven test
XHls_macc_Start (&HlsMacc) ;
do {
res_hw = XHls macc_GetAccum(&HlsMacc) ;
} while (!XHls macc IsReady (&HlsMacc)) ;
print ("Detected HLS peripheral complete. Result received.\n\r");

}

//call the software version of the function
sw_macc(a, b, &res sw, false);

printf ("Result from HW: %d; Result from SW: %d\n\r", res hw, res_ sw);
if (res_hw == res_sw) ({

print ("*** Results match ***\n\r");

status = 0;

}

else {
print ("!!! MISMATCH !!!\n\zr");
status = -1;

}

cleanup platform() ;
return status;

}

10. Save the modified source file. When you save the file, SDK automatically attempts to
re-build the application executable. If the build fails, fix any outstanding issues.

Run the new application on the hardware and verify that it works as expected. Ensure that
a TCF hardware server is running, that the FPGA is programmed and a terminal session is
connected to the UART. Then Launch on Hardware, as you did for the previous Hello World
application code.

Upon success, the Terminal session looks similar to Figure 10-27.

[2 Problerns | v Tasks | B Consale | 71 Praperties | 2 Temainal 1 12 HME LR 2 -

Serial (COMS, 115088 2 1 Mone, None - CONNECTED) - Encoding §50-2855.1)

Result from HE: 42; Reswlt from SH: 42 &
id and HE results matchl

Program Lo test commnicalion mith HLE WALC block in PL

fecelerstor is resdy. Starting... Delected HLE block complebe. Resull received.

Result from HE: 42; Reswlt from SH: 42

*E EN amd B resulls emabch **7

Figure 10-27: Console Output with Updated C Program
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Lab 2: Streaming Data Between the Zyng CPU and
HLS Accelerator Blocks

This lab illustrates a common high-performance connection scheme for connecting
hardware accelerator blocks that consume data originating in the CPU memory and/or
producing data destined for it, in a streaming manner.

« This tutorial uses the same Vivado HLS and XFFT IP blocks created in Lab 1 of the
tutorial “Using HLS IP in IP Integrator”. In this lab exercise these blocks are connected
to the HPO Slave AXI4 port on a Zynq7 processing system via an AXI DMA IP core.

« The hardware accelerator blocks are free-running and do not require drivers; as long as
data is pushed in and pulled out by the CPU (often simply referred to as the Processing
System or PS).

« The lab highlights the software requirements to avoid cache coherency issues.

Step 1. Generate the HLS IP

1. From the Vivado HLS command prompt used in Lab 1, change to the | ab2 directory as
shown in Figure 10-27.

2. Run Vivado HLS to create two HLS IP blocks by typing vivado hls -f run hls.tcl.

A Vivado HLS 20122 Command Prompt = ||mi=l |-...H
C:\Uivade HLS _Tutorial\Usimg_IP_with_Zyngilabl:cd ..

C:\Uivade HLS Tutoeriali\Using_ IP_with_Zyngrcd lab2

C:yUivade HLS TuterialiUsing_ IP_with_Zungilab2red hls_designs

C:%\Wivado_HLS_Tuterial‘WUsing_IP_with_Zung\lab2\hls_designsiuivado_hls -f run_hlsE
Ltel

Figure 10-28:  Setup for Zynq Lab 2

When the script completes, there are two Vivado HLS project directories, f e_vhl s_prj
and be_vhl s_prj, which contain the HLS IP, including the Vivado IP Catalog archives for
use in Vivado designs.

e The "front-end” IP archive is located at f e_vhl s_prj /| PXACTExport/inpl/ip/
« The "back-end” IP archive is located at be_vhl s_prj /| PXACTExport/inpl/ip/

Step 2: Create a Vivado Design Suite Project
1. Launch the Vivado Design Suite (not Vivado HLS):
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o On Windows use Start > All Programs > Xilinx Design Tools > Vivado 2016.3 >
Vivado 2016.3.

o On Linux, type vivado in the shell.
From the Welcome screen, select Create New Project.
Click Next on the first page of the Create a New Vivado Project wizard.

Click the ellipsis button to the right of the Project location text entry box and browse to
the | ab2 tutorial directory.

Set the project name to project_1, if it is not already specified.

Click Next to move to the Project Type page of the wizard.

a. Select RTL Project.

b. Select do not specify sources at this time (if not the default); just click Next.

On the Default Part page, under Specify, click Boards and select the ZYNQ-7 ZC702
Evaluation Board. Click Next.

On the New Project Summary Page, click Finish to complete the new project setup.

Step 3: Add HLS IP to an IP Repository

1.
2.
3.

High-Level Synthesis

In the Project Manager area of the Flow Navigator pane, click IP Catalog.
The IP Catalog appears in the main pane of the workspace. Click the IP Settings icon.

In the IP section of the Project Settings dialog box, click the “+" symbol to Add
Repository.

In the IP Repositories dialog box:

a. Browse to the | ab2 tutorial directory .

b. Click the Create New Folder icon.

c. Entervivado_i p_repo in the resulting dialog box.
d. Click OK.

e. Click Select to close the IP Repository window.

On returning to the IP Setting dialog box:

a. Click the "+" symbol to Add IP.

b. In the IP Repositories dialog box, browse to the location of the HLS IP
lab2/ hl s_designs/ fe_vhl s_prj /1 PXACTExport/inpl/ip/ or, if using IP
created in previous tutorial, browse to the corresponding path.

c. Selectthexilinx_comhls_hls_real2xfft_1 00_a. zi p file.

d. Click OK.
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6.

Follow the same procedure to add the second HLS IP package, in directory
| ab2/ hl s_desi gns/ be_vhl s_prj /1 PXACTExport/inpl/ip/, tothe repository:
xilinx_comhls_hls_xfft2real _1_00_a. zip.

The new HLS IP now appears in the IP Setting dialog box.
Click OK to exit the dialog box.
There is now HLS IP in the IP Catalog (HIs_real2xfft and Hls_xfft2real).

Step 4: Create a Top-level Block Design

1.

High-Level Synthesis

Click Create Block Diagram under IP Integrator in the Flow Navigator.
a. In the resulting dialog box, name the design Zynq_Real FFT.

b. Click OK.

In the Diagram tab, click the Add IP button to add IP

a. In the Search box, type fouri er.

b. Select the Fast Fourier Transform and double-click with the mouse.

Double-click the new Fast Fourier Transform IP symbol to open the Re-customize IP
dialog box. On the Configuration tab:

a. Change the Transform Length to 512.

b. Change the Target Clock Frequency to 100 MHz.

c. In the Architecture Choice section, select Pipelined, Streaming 1/0.
Select the Implementation tab:

a. Select ARESETN (active-Low) in the Control Signals group.

b. Verify that Bit/Digit Reversed Order is selected under Output Ordering Options.
c. Verify that Non Real Time is selected as Throttle Scheme.

d. Click OK to exit Re-customize IP dialog

Add one instance of each of the HLS generated blocks to the design.

a. Right-click in any space in the canvas and select Add IP.

b. Type hl s into the Search text entry box.

c. Highlight both IPs. (Click the control key and select both.)

d. Press Enter.

Connect the HLS blocks to the FFT block.

a. Mouse over the dout interface connector of the hl s_real 2xftt block until a
pencil cursor appears.
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b. Left-click and hold down the mouse button to start a connection.

c. Dragthe connection line to the S_AXI S_DATA input port connector of the FFT block
and release when a green check mark appears next to it.
7. In a similar fashion:

a. Connect the FFT's M_AXI S_DATA interface to the di n input interface of the
hl s_xfft2real block.

8. Put the data processing blocks into their own level of hierarchy.
a. Select everything in the current digram by pressing Ctri+A.

b. Right-click the canvas and select Create Hierarchy from the context menu.

i Dagram =
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|7 woigre
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v " 4 = Fi
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Figure 10-29: Create a Hierarchy Block
c. Inthe Create Hierarchy dialog box, enter Real FFT as the Cell name.

d. Ensure that the Move ‘3’ selected blocks to new hierarchy option is checked, as
shown in Figure 10-30.
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Flease specify name of hierarchecal cell to create in Zyng_RealrrT.
You can al=n moer Selected blocks to sy hierarchy. i

el name: | TR

7] Move '3' selected blocks to new hierarchy

Lok || concel |

Figure 10-30: Name Hierarchy Block
e. Click OK.

The diagram will appear as shown in Figure 10-31.

a
I
4

| & 2ymq_RealFFT »

Pt

+

2Cg8Dm e ABCR AR

Figure 10-31: New Hierarchy Block
Add pins to the Real FFT hierarchical block so that you can connect it at the top-level.

9. Double-click the Real FFT block to open its diagram.
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Figure 10-32: RealFFT Diagram

10. Right-click the di n_V_V pin of the hl s_r eal 2xfft _0 block and select Create
Interface Pin from the context menu.
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Figure 10-33: Creating an Interface Pin

11.In the Create Interface Pin dialog box, change the Interface name to

real fft_s_axis_din.

a. Accept all other defaults and click OK.

4= Create Interface Pin

Crovabe interfaoe pin lor cell RealFFT.

Interface name: | TR SR

VLNV
Maode:

[¥] Connect to selectad interface din

iliroe cormzinterfaoe

SLAVE

-

[
saxis_rtl:1.0 -
vV

[ ox ][ cancel

Figure 10-34:

12. Right-click the ap_cl k pin of thehl s_re
the context menu.
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a. Change the name to acl k and click OK.
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Figure 10-35: Create a Clock Pin
After you create this clock pin, the Real FFT diagram appears as shown in Figure 10-36.

i iagram % 3o Diagram - RealfFl X Ouv =
| & 2yng_RealFFT » [ RealFFT

Qs

o

A
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ik
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i HS S

Figure 10-36: RealFFT Diagram with Interface Pin and Clock Pin
13. Following the procedures in steps 10 to 12:

a. Create an interface pin called real fft_m axi s_dout connected to the dout _V
pin of the hl s_xfft 2real component.

b. Create a pin for ar eset n (from any one of the blocks).
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After this step, the Real FFT diagram appears as shown in Figure 10-37.

F= Diagram 2 | Fo Diagram - RealfFl X 0w =
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Figure 10-37: RealFFT Diagram with All Pins

Finalize Real FFT block internal connections. The ap_st art pins for the HLS blocks are
tied HIGH, and the acl k and aresetn pins on all blocks are tied together.

14. Right-click the canvas and select Add IP from the context menu.
a. Type const into the search box and press Enter.

b. Double-click the xI const ant _0 component and verify that the Const Val field in
the Customize IP dialog is set to 1.
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Figure 10-38: Create a Constant 1 Tie-Off

15. Expand the ap_ctr| interface by clicking the + sign next to it on the hl s_real 2xfft
and hl s_xfft2real block symbols and:

a. Connect the output pin of xI const ant _0 to the ap_start pin of
hls_real 2xfft _0.

b. Connect the output pin of xI const ant _0 to the ap_start pin of
hls_xfft2real _O.

16. Similarly, connect all remaining component dout _V and r eset pins to the Real FFT
block diagram acl k and ar eset n pins respectively.

17. Add another x| const ant block and configure it with a Const Width of 16 and Const
Val of 0.

18. Expand the S_AXI S_CONFI Ginterface of the FFT block and connect
s_axis_config_tdataands_axis_config_tvalid tothe new constant block.

Leave all other output pins of the components disconnected. The final Real FFT diagram
appears with the connections shown in Figure 10-39.
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Figure 10-39: Final RealFFT Diagram

19. Close the Real FFT diagram tab and return to the top-level Zynq_Real FFT diagram.

20. Create the Zynq system.

a.

High-Level Synthesis
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Right-click the canvas of the top-level diagram and select Add IP from the context
menu.

Type zyng in the search box, select ZYNQ7 Processing System and press Enter.

Notice that designer assistance is available and click the Run Block Automation
link. Accept the defaults in the dialog by clicking OK.

Double-click the processing_system7_0 component to enter the Re-customize IP
wizard for the ZYNQ7.

Click the Presets button near the top of the wizard screen, select the ZC702
Development Board Template, and click OK.

Click PS-PL Configuration in the Page Navigator pane on the left of the wizard.

Expand the HP Slave AXI Interface category and check the box for the S AXI HPO
interface, leaving the S AXI HPO DATA WIDTH at 64.
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h. Select Clock Configuration in the Page Navigator, expand PL Fabric Clocks, and
change the requested frequency to 100 (MHz).
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Figure 10-41: Configuring the Clock
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i. Leave all other settings at their defaults; click OK to apply customizations.

21. Make a connection from RealFFT block’s realffft_s_axis_din to Zynq AP SoC’'s S_AXI_HPO,
accept the defaults in the Make Connection dialog and click OK.

IPI will place several new blocks require to complete the connection automatically,
including an AXI DMA core, an AXI Interconnect and a Processor System Reset block.

High-Level Synthesis
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22. Make a connection from the RealFFT block’s realfft_m_axis_dout to the Zynq's
S_AXI_HPO interface. Accepting the defaults in the Make Connection dialog will cause IPI
to use the existing AXI DMA (which has an unused write channel) and AXI Interconnect
to make the ‘S2MM'’ connection.

23. Note that Designer Assistance is again available. Run Connection Automation on
/axi_dma/S_AXI_LITE and click OK in the resulting dialog box.

24. Connect the acl k and ar eset n ports of the RealFFT hierarchical block to nets
processing_system7_0 pin FCLK_CLKO and rst_processing_system7_0_100M pin
peripheral_aresetn respectively.

25.To complete the design, run Validate Design. When validation completes successfully,
the block diagram should look like Figure 10-42.

Step 5: Implementing the System
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Figure 10-42: Zyng Diagram with Internal Connections

Before proceeding with the system design, you must generate implementation sources and
create an HDL wrapper as the top-level module for synthesis and implementation.

1. Return to the Project Manager view by clicking Project Manager in the Flow Navigator.

2. In the Sources browser in the main workspace pane, a Block Diagram object called
Zynq_ Real FFT appears at the top of the Design Sources tree view. Right-click this
object and select Generate Output Products.
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3. In the resulting dialog box, click OK to start the process of generating the necessary
source files.

4. Right-click the Zynq_Real FFT object again, select Create HDL Wrapper, and click OK
to exit the resulting dialog box.

The top-level of the Design Sources tree becomes the Zynq_ Real FFT _wr apper. v file.
You are now ready to synthesize, implement, and generate an FPGA programming bitstream
for the design.

5. Click Generate Bitstream to initiate the remainder of the flow.

6. In the dialog that appears after bitstream generation has completed, select Open
Implemented Design and click OK.

Step 6: Setup SDK and Test the ZYNQ System

You are now ready to export the design to Xilinx SDK. In SDK, you create software to run on
a ZC702 board (if available). A driver for the HLS block was generated during HLS export of
the Vivado IP Catalog package and must be made available in SDK for the PS7 software to
communicate with the block.

1. From the Vivado File menu select Export > Export Hardware for SDK.

Note: Both the IPI Block Design and the Implemented Design must be open in the Vivado
workspace for this step to complete successfully.

2. Inthe Export Hardware for SDK dialog box, ensure that the Include Bitstream option is
checked, and click OK.

3. From the Vivado File menu, select Launch SDK.
4. Click OK to launch SDK.
5. Create a Hell o Wor |l d application (also creates BSP).
a. Select File > New > Application Project.
b. Enter the project name Zynq_Real FFT_Test .
c. Click Next.
d. Select Hello World (if it is not the default).
e. Click Finish.
6. Power up the ZC702 board and program the FPGA.

Ensure the board has all the connections to allow you to download the bitstream on the
FPGA device. Refer to the documentation that accompanies the ZC702 development
board.

7. Click XilinxTools > Program FPGA. The Done LED (DS3) goes on.
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8. Set up a Terminal in the tab at bottom of workspace:
a. Click the Connect icon.
b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected (generally not COM1
or COM3). On Windows, if you are not sure, open the Device Manager and identify
the port with the Silicon Labs driver under Ports (COM & LPT).

d. Change the Baud Rate to 115200.
e. Click OK to exit Terminal Settings dialog box.
f. Check that terminal is connected by message in tab title bar.
9. Right-click application project Zynq_Desi gn_Test in the Explorer pane.
a. Select Run As > Launch on Hardware.
10. Switch to the Terminal tab and confirm that Hel | o Wor | d was received.

11. This project uses the C math library (I i bm), so you must adjust the build settings to link
to it.

a. Right-clickthezynqg_real fft_test projectinthe Project Explorer pane and select
C/C+ Build Settings (Figure 10-43).
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Figure 10-43: Specify C/C++ Build Settings
b. Add the ARM gcc linker libraries.

i. Inthe Tool Settings tab, select ‘ARM gcc linker’ > Libraries.

ii. Click the Add icon.
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Figure 10-44: C/C++ Build Settings
c. Enter min the text field in the Enter Value dialog box and click OK.
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Figure 10-45: Library Setting

d. Click OK to exit the Properties for the zynq_real fft _t est dialog box.

Step 7: Modify software to communicate with HLS block

The completely modified source file is available in the ar m_code directory of the tutorial
file set. The modifications are discussed in detail below.
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1.
2.

5.

Open the hel | owor | d. ¢ source file.
Several BSP (and standard C) header files must be included:

#include <stdlib.h> // Std C functions, e.g. exit()
#include <math.h> // libm header: sqgrt(), cos(), etc
#include "xparameters.h" // System parameter definitions
#include "xaxidma.h" // Device driver API for AXI DMA

Define the (real data) transform length of the FFT:
#define REAL FFT LEN 1024

Define a custom complex data type with 16-bit real and imaginary members:

typedef struct ({
short re;
short im;

} complex16;

Declare helper functions before the definition of mai n(); they will be defined later.

Note: The init_ dma () function wraps up all run-once, initialization AXI DMA driver API calls and
checks that hardware initialization is successful before returning or exiting on an error condition.
The generate waveform() function fills an array with a simple, periodic waveform to be used as
input stimulus for the RealFFT accelerator.

High-Level Synthesis

int init_dma (XAxiDma *axiDma) ;
void generate waveform(short *signal buf, int num samples) ;

Modify mai n() to generate and send input data to the RealFFT accelerator and receive
the spectral data from it via the AXI DMA engine. Sections of particular importance will
be discussed in detail.

// Program entry point
int main()

{

a. Declare an XAxiDma instance to use as a handle to the AXI DMA hardware:

// Declare a XAxiDma object instance
XAxiDma axiDma;

b. Declare variable for local data storage:

// Local variables

int i, J;

int status;

static short realdata[4*REAL FFT LEN] ;

volatile static complexl6 realspectrum[REAL FFT LEN/2];

¢. Run platform and DMA initialization functions:

// Initialize the platform

init _platform() ;

Print (M-mmmmm oo e \n\r") ;
print ("- RealFFT PL accelerator test program -\n\r");
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// Initialize the (simple) DMA engine

status = init dma (&axiDma) ;

if (status != XST SUCCESS) {
exit (-1);

!

d. Generate a stimulus waveform:

// Generate a waveform to be input to FFT
for (1 = 0; 1 < 4; 1i++)
generate_waveform(realdata + i1 * REAL FFT LEN, REAL FFT LEN) ;

e. Before making the DMA transfer request, the buffer containing the data must be
flushed from the processor’s data cache. Without this step, the DMA might pull stale
data from the DRAM.

// *IMPORTANT* - flush contents of 'realdata' from data cache to memory
// before DMA. Otherwise DMA is likely to get stale or uninitialized data
Xil DCacheFlushRange ( (unsigned)realdata, 4 * REAL FFT LEN * sizeof (short));

f. Request DMA transfer from PS to PL. Enough data to fill the front-end block and the
FFT processing pipelines must be sent in order for spectral data to be ready when
the PL to PS transfer is requested. Therefore, four data sets are sent before the first
output set is requested:

// DMA enough data to push out first result data set completely
status = XAxiDma_ SimpleTransfer (&axiDma, (u32)realdata,
4 * REAL FFT LEN * sizeof (short), XAXIDMA DMA TO_DEVICE) ;

// Do multiple DMA xfers from the RealFFT core's output stream and

// display data for bins with significant energy. After the first frame,
// there should only be energy in bins around the frequencies specified
// in the generate waveform() function - currently bins 191~193 only
for (1 = 0; 1 < 8; 1i++) {

g. Request DMA transfer of a frame of FFT spectral data from PL to PS then poll for
completion of the transfer before proceeding.

// Setup DMA from PL to PS memory using
// AXI DMA's 'simple' transfer mode
status = XAxiDma SimpleTransfer (&axiDma, (u32)realspectrum,
REAL FFT LEN / 2 * sizeof (complex16), XAXIDMA DEVICE TO DMA) ;
// Poll the AXI DMA core
do {
status = XAxiDma Busy (&axiDma, XAXIDMA DEVICE_TO DMA) ;
} while(status) ;

h. Before attempting to use the spectral data, the processor’'s data cache copy of the
buffer must be invalidated to avoid use of stale data.

// Data cache must be invalidated for 'realspectrum' buffer after DMA
Xil DCacheInvalidateRange ( (unsigned)realspectrum,
REAL FFT LEN / 2 * sizeof (complex16)) ;

i.  Push another set of stimulus data to the PL in order to start the accelerator
processing the next frame:
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// DMA another frame of data to PL
if (!XAxiDma_ Busy (&axiDma, XAXIDMA DMA TO DEVICE))
status = XAxiDma SimpleTransfer (&axiDma, (u32)realdata,
REAL_FFT LEN * sizeof (short), XAXIDMA DMA TO DEVICE) ;
printf ("\n\rFrame #%d received:\n\r") ;

j. Do something to verify that the accelerator is functioning. In this case, the spectral
data is scanned for bins that contain significant energy. The expectation is to detect
only energy in bins around the single tone (192) generated by the
gener at e_wavef or m() function.

// Detect energy in spectral data above a set threshold
for (j = 0; j < REAL FFT LEN / 2; j++) {
// Convert the fixed point (s.15) values into floating point values
float real = (float)realspectrum[j].re / 32767.0f;
float imag = (float)realspectrum[j].im / 32767.0f;
float mag = sqgrtf(real * real + imag * imag);
if (mag > 0.00390625f) {
printf ("Energy detected in bin %3d - ",3j);
printf ("{%8.5f, %8.5f}; mag = %8.5f\n\r", real, imag, mag);
}
}
printf ("End of frame.\n\r");
I}Drintf("***************\n\r");
printf ("* End of test *\n\r");
printf("***************\n\r\n\r");
return 0;

}

7. Define the helper function that generates the waveform data sets. This version simply
fills a buffer with a single tone with 192 cycles per num _sanpl es data window with
values in a S.15 fixed point format.

void generate waveform(short *signal buf, int num samples)
{
const float cycles per win = 192.0f;
const float phase = 0.0f;
const float ampl = 0.9f;
int 1i;
for (i = 0; i < num samples; i++) {
float sample = ampl *
cosf((i *» 2 * M PI * cycles per win / (float)num samples) + phase);
signal buf[i] = (short) (32767.0f * sample) ;

8. Define a routine to set up the and initialize the AXI DMA engine, wrapping all driver API
calls that only need to be run once at startup.

int init dma (XAxiDma *axiDmaPtr) {
XAxiDma Config *CfgPtr;
int status;
// Get pointer to DMA configuration
CfgPtr = XAxiDma_LookupConfig (XPAR AXIDMA 0_DEVICE_ID) ;
if (1CEgPtr) {
print ("Error looking for AXI DMA config\n\r");
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return XST FAILURE;
}
// Initialize the DMA handle
status = XAxiDma CfgInitialize (axiDmaPtr, C£gPtr) ;
if (status != XST SUCCESS) {
print ("Error initializing DMA\n\r") ;
return XST FAILURE;
}
//check for scatter gather mode - this example must have simple mode only
if (XAxiDma_ HasSg (axiDmaPtr)) {
print ("Error DMA configured in SG mode\n\r") ;
return XST FAILURE;
}
//disable the interrupts
XAxiDma IntrDisable (axiDmaPtr, XAXIDMA IRQ ALL MASK,XAXIDMA DEVICE TO DMA) ;
XAxiDma IntrDisable (axiDmaPtr, XAXIDMA IRQ ALL MASK,XAXIDMA DMA TO DEVICE) ;

return XST SUCCESS;

9. Save the modified source file. As soon as you save the file, SDK automatically attempts
to re-build the application executable. If the build fails, fix any outstanding issues.

10. Run the new application on the hardware and verify that it works as expected. Ensure
that the FPGA is programmed and a terminal session is connected to the UART. Then
Launch on Hardware, as done for the previous Hello World application code.

Conclusion

In this tutorial, you learned:

+ How to create Vivado HLS IP using a Tcl script.
 How to import an HLS design as IP into IP Integrator.

+ How to connect HLS IP to a Zynq AP SoC using AXI4-Lite interfaces and AXI4-Stream
interfaces.

« How to configure HLS IP with AXI4-Lite in software.

+ How to control DMAs using AXI4-Stream in software.
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Chapter 11

Using HLS IP in System Generator for DSP

¥

High-Level Synthesis

Overview

The RTL created by High-Level Synthesis can be packaged as IP and used inside System
Generator for DSP (Vivado). This tutorial shows how this process is performed and
demonstrates how the design can be used inside System Generator for DSP.

This tutorial consists of a single lab exercise.

Lab 1 Description

Generates a design using Vivado HLS and package the design for use with System Generator
for DSP. Then include the HLS IP into a System Generator for DSP design and execute an RTL
simulation.

Tutorial Design Description

You can download the tutorial design file from the Xilinx Website. See the information in
Locating the Tutorial Design Files.

This tutorial uses the design files in the tutorial directory Vi vado_HLS_Tut ori al \
Usi ng_I P_with_SysGen.

The sample design is a FIR filter that uses streaming interfaces modeled with the High-Level
Synthesis hls::stream class. The design is fully pipelined at the function level. The
optimization directives are embedded into the C code as pragmas.

Lab 1: Package HLS IP for System Generator

This lab exercise integrates the High-Level Synthesis IP into System Generator for DSP.

IMPORTANT: The figures and commands in this tutorial assume the tutorial data directory
Vivado_HLS Tutorial is unzipped and placed in the location C:\Vivado_HLS_Tutorial.
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If the tutorial data directory is unzipped to a different location, or on Linux systems, adjust the few
pathnames referenced, to the location you have chosen to place the Vivado_HLS Tutorial directory.

Step 1: Create a Vivado HLS IP Block

Create two HLS blocks for the Vivado IP Catalog using the provided Tcl script. The script
runs HLS C-synthesis, runs RTL co-simulation, and package the IP for the two HLS designs
(hl's_real 2xfft and hl s_xfft2real).

1. Open the Vivado HLS Command Prompt.

- On Windows, go to Start > All Programs > Xilinx Design Tools > Vivado 2016.3
> Vivado HLS > Vivado HLS 2016.3 Command Prompt.

o On Linux, open a new shell.

Vivado 2016.3
o Add Design Toolks or Devices 2016.3
e Manage Xilinx Licenses
$5 uninstan 20163
W Vivado 20063 Tel Shel

d Wivado 200163

System Generator

Vivado HLS

B Vivado HLS 20163 Command Promp

« | Vivadao HLS 20163 -
4  Back

Figure 11-1: Vivado HLS Command Prompt

2. Using the command prompt window, change the directory to
Vivado_HLS Tutorial\Using IP_with_SysGen\labl,

3. Type vivado hls -f run hls.tcl to create the HLS IP.

m Vivado HLS 20132 Command Prompt == [i.h'l

C:wUivado_HLS _Tutorialiecd Using_IP_with_3SysGen

C:wUivado_HLS _TutorialUsing_IP_with_SuysGenicd labl

C:\Wivade HLS Tutsrial‘\Using_IP_with_SysGen'labl>uviuvava_hls -f run_hls. tel

Figure 11-2: Create the HLS Design

A key aspect of the Tcl script used to create this IP is the command export design -
format sysgen. This command creates an IP package for System Generator. When the
script completes there is a Vivado HLS project directoriesfi r _prj, which contains the HLS
IP, including the IP package for use in a System Generator for DSP design.
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The remainder of this tutorial exercise shows how to integrate the Vivado HLS IP block into

a System Generator design.

Step 2: Open the System Generator Project

1. Open System Generator for DSP.
o On Windows use the desktop icon.

On Linux, open a new shell and type sysgen.

o

Figure 11-3. System Generator Icon

2. When Matlab invokes, click the Open toolbar button. As shown in Figure 11-4.

rT_

LA - |_| i = (g Pna Fes i ar 2 Hew Variakble .1(‘ FAnalyre Cude
Wew MNew OS] LCompare lmpot  Sae o oo versRe T o Reashaiime
Srgt v | ow Data  Wiorkspace - Clear Workspace = | Cienr Comman

i 1T Open.. Clil=

Figure 11-4: Open the System Generator Design

3. Navigate to the tutorial directory
Vivado_HLS Tutorial\Using_|P_with_SysGen\labl and select the file

fir_sysgen. sl x, as shown in Figure 11-5.
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L. fir_prj 9/2/2015 1:23 PM File folder
. Documents
) fircpp 3/29/2013 838 AM  C++ Source
4. Music
) firh 7/6/2012 218 PM C/C++ Head
~. Pictures
) " fir_sysgen.six 3/11/2015 1215 PM  Simulink Mo
% Videos -
] fir_test.cpp 7/6/2012 2:23 PM C++ Source
3. Vivado_HLS
‘& Computer
& 0SDisk (C) =
% duncanm (\\wcocl2) ()
< duncanm (\\xsj-smbj) (¥:) [
— gdrive (\\ppdeng) (£:)
> 4| I} | P
File name: fir_sysgen.six h lAII MATLAR files (*.rpt*tmf; vl
[ Open H ‘ Cancel ‘

Figure 11-5: Select File fir_sysgen.slx

When System Generator invokes, all blocks and ports except the HLS IP are already
instantiated in the design.

4. Right-click in the canvas and select Xilinx BlockAdd, as shown in Figure 11-6.
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Figure 11-6: Adding a New Block
5. Type hl s in the Add Block field.
6. Select Vivado HLS.

Add block | his
Vivado HLS

Figure 11-7: Selecting a Vivado HLS IP Block
7. Double-click the Vivado HLS block to open the Vivado HLS dialog box.

8. Navigate tothefir_prj project and click Choose to select the sol uti onl folder.

f IMPORTANT: System Generator for DSP uses the location of the solution folder to identify the IP.

9. Click OK to load the IP block, as shown in Figure 11-8.
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Figure 11-8: Selecting the FIR IP Block

The FIRIP block is instantiated into the design.

10. Connect the design I/O ports to the ports on the FIR IP block, as shown in Figure 11-9.
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Figure 11-9: Design with All Connections

11. Ensure the simulation stop time says 300.
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12. Click the Run button on the toolbar to execute simulation.

13. Double-click the Scope block to view the simulation waveforms.

Conclusion

In this tutorial, you learned:

« How to create Vivado HLS IP using a Tcl script.

« How to import an HLS design as IP into System Generator for DSP.
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Appendix A

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

Documentation Navigator and Design Hubs

Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support
resources, which you can filter and search to find information. To open the Xilinx
Documentation Navigator (DocNav):

« From the Vivado IDE, select Help > Documentation and Tutorials.
+ On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

« At the Linux command prompt, enter: docnav

Xilinx Design Hubs provide links to documentation organized by design tasks and other
topics, which you can use to learn key concepts and address frequently asked questions. To
access the Design Hubs:

« In the Xilinx Documentation Navigator, click the Design Hubs View tab.

« On the Xilinx website, see the Design Hubs page.
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Training Resources

Xilinx provides a variety of training courses and QuickTake videos to help you learn more
about the concepts presented in this document. Use these links to explore related training
resources:

|~

C-based Design: High-Level Synthesis with the Vivado HLS Tool Training Course

C-based HLS Coding for Hardware Designers Training Course

C-based HLS Coding for Software Designers Training Course

> w N

Vivado Design Suite QuickTake Video Tutorials

Vivado Design Suite QuickTake Video Tutorials: Vivado High-Level Synthesis

Vivado Design Suite QuickTake Video: Getting Started with High-Level Synthesis

Vivado Design Suite QuickTake Video: Verifying your Vivado HLS Design

Vivado Design Suite QuickTake Video: Creating Different Types of Projects

W o N o U

Vivado Design Suite QuickTake Video: Designing with Vivado IP Integrator

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials") is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support
terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any
application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications,
please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.
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AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS

FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON
PRODUCT LIABILITY.

© Copyright 2012-2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynqg, and other designated

brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of
their respective owners.
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